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Toad for Data Analysts

Toad for Data Analysts is a query and reporting tool with extensive
capabilities. Easy enough to be used by someone who’s new to data-
bases, yet powerful enough to be used by many different types of
database professionals. Toad for Data Analysts is designed with broad
usability in mind. In this section we’ll talk about how to get started
with the tool, some of the basic concepts and the general workflow.

Toad Family

Toad for Data Analysts is a member of the Toad product family at
Quest Software. The product family started with Toad for Oracle in
the late 1990’s and has grown into a family of products that cover
Oracle, SQL Server, DB2, MySQL, Sybase and many other databases
and is used by well over 1 million people worldwide. Each product in
the Toad family is devoted to providing users with powerful, user-
friendly tools for working with a variety of databases. Toad for Data
Analysts, introduced in 2007, is the newest member of the Toad fam-
ily and distinguishes itself as a tool for querying and reporting on just
about any database. Devoted to meeting the users’ needs and built on
top of the proven Toad platform, Toad for Data Analysts is rapidly
becoming the tool of choice for many data professionals.

Getting Started

One of the best ways to get started with Toad for Data Analysts is to
watch a video demo. You can find a complete demo at http://
www.quest.com/toad-for-data-analysts/. The video covers the basic
concepts of the tool, general workflow and more.

Workflow

Toad for Data Analysts is built on the premise that nearly every re-
porting project goes through a form of the following steps at some
point: Understand, Query, Report and Automate. There will be times
when you omit one of these steps, but they loosely represent the gen-
eral flow of a standard reporting project.

Toad for Data Analysts

Understand

This first step is often overlooked, yet it may be the most important
step in the process of your project. Many times, people will connect to
a data source and just start creating queries blindly. While it may feel
more productive to “dive right in,” it’s a false sense of accomplishment.
The best queries begin with a clear understanding of the data source
you’re connected to. This is because if you understand the data, ob-
jects and their relationship to each other (if such relationships exist!),
then you can build informed queries that are effective and more opti-
mized than you could without this understanding. Therefore, Toad for
Data Analysts supports two methods of understanding: the ER Dia-
grammer and the Database Explorer. The ER Diagrammer gives you a
high-level, visua/representation of an object and those objects which
may be related to it; the Database Explorer gives you a more in-depth
and detailed view into the object so you can see column information,
the data itself, relationships and more.

Query

This is the heart of Toad for Data Analysts and probably the most time-
consuming part of your project. Once you have a clear understanding
of the data source you’ll be querying from, you can begin creating your
query. Toad for Data Analysts once again supports two methods for
doing this: the Query Builder and the SQL Editor. The Query Builder will
do just that—using a visual interface, it builds the query for you.
Whether you’re new to databases and unfamiliar with the SQL lan-
guage or a seasoned veteran, the Query Builder will save you time. And
regardless of the database you connect to, the Query Builder is the
same, meaning that you don’t have to remember all of those little nu-
ances of how the SQL language differs between database platforms.

For the “coders” out there (you know who you are!), you’ll be happy to
know that the SQL Editor in Toad for Data Analysts is the same power-
ful SQL Editor that’s found in the rest of the Toad family of products. So
regardless of your skill-level—or level of motivation—you’ll have all the
tools you need to create your queries easily and quickly.

The Basics



Report

The third step in the process is reporting. Naturally, once you get the
information you want with your query, 9 times out of 10 you’ll want
to share that information. So whether it’s sharing a statistic in an
email or creating a beautiful multi-page PDF, you’re in the “Report”
stage of the process. Again, Toad for Data Analysts supports several
methods of reporting: One-Click Export to Microsoft Excel, pivot ta-
bles, charts and Toad Reports — Toad’s own banded report designer.

The One-Click Export feature takes whatever you have in the data
grid, whether it’s a query result or the data grid in the Database Ex-
plorer, and exports it to a specific Microsoft Excel format in a single
click. A handy time-saver, the One-Click Export can even automate the
creation of refreshable Microsoft Excel documents.

Pivot grids, charts and banded reports are designed with the Toad

Reports interface and can be saved to a variety of formats. You can
also take a shortcut and create a quick pivot table and chart right in
the results grid of a Query Builder or SQL Editor window.

Automate

The last piece of this process is automation. With your query written
and your report complete, save time and automate the process. Many
times we find ourselves doing the same things over and over... Toad
for Data Analysts goes beyond standard query and reporting tools to
reduce this redundancy. Using an intuitive, task-oriented timeline ap-
proach, Toad for Data Analysts will take all of those mindless, repeti-
tive tasks and do them for you. You can create entire workflows that
encompass connecting, importing/exporting, executing scripts, run-
ning queries, building reports and distributing those reports—you can
even add in conditional logic! With a solid automation workflow built,
schedule it to run on any schedule. Now your reporting tasks will take
care of themselves, automatically.

Toad for Data Analysts

Going Beyond the Basics

Toad for Data Analysts doesn’t stop here. Packed with more tools for
comparing data, synchronizing databases, connecting to FTP servers,
importing/exporting data and more, Toad for Data Analysts will help
you get the job done. We’'ll cover these advanced features later in
this guide.

The Basics



Getting Started—First Time

Getting Started

To begin, you will need to install Toad for Data Analysts if you or your
administrator have not done this. Details on installation are available
in Appendix A.

When you first open Toad for Data Analysts, you are presented with
the Quick Guide. This screen is designed to help first-time users get
started, though it can be used as a time-saver even if you’ve been
using Toad for Data Analysts for a long time.
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The Quick Guide layout follows a typical end-to-end reporting proc-
ess, beginning with making a connection and moving all the way
through publishing and automation. The

[ = ick Guide
best way to use the Quick Guide is to use | et
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it as a launch pad. When you open Toad
for Data Analysts, click on the activity
that best suits your needs and jump
straight to that tool.

(— Select an entry point: ——

1. Understand | 2. Query 3. Report
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Excel Report

Create an Excel report
from a query result set

®
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Notice that for the steps of Understand,
Query and Report you are given two op-

g ER Diagrammer Query Builder
Create an ER. diagram tul Build a visual guery to
f P B identify relationships get specific data
tions. This is to accommodate different

. . ) Connect to Publish / Email
preferences. For instance, if you’re more Datasources z. Report
comfortable writing SQL queries by hand, 9“
you may prefer to use the SQL Editor to Database Explorer SQL Editor Toad Report

Browse through objects.
to understand content

Write a text query to
get specific data

Create a Toad report
from a query result set

build your query as opposed to the Query

Builder. -

4. Automate

The Quick Guide also has links to video
tutorials, to help first-time users get
started quickly and easily. In addition to
these, there are video links to other tools
in the “What Can | Do” sidebar. Take a
few minutes to watch one of these vid-
eos—you may be surprised!

Tutorials:
28 Quick Start

Schedule a query or | 38 Connecting to DB
report to run later

g
&
o

Automate
Create a script to
automate data

Do not show on start up
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Workflow

Toad for Data Analysts has been designed to
assist the basic workflow of Understand the
database design, Query the database, Report on
the data, and Automate database tasks. To
demonstrate the process let’s walk through the
workflow.

1. Understand

ER Diagrammer
Create an ER diagram to
identify relationships

|
The first step is to understand. From the Quick

Guide window you can select the ER Diagram-
mer. Here you can quickly discover object relationships by dragging a
table from the Object Explorer.
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When you are done viewing the database relationships, the “Send to
Query” button on the bottom right of the Wizard Bar sends those ta-
bles or views to the Query Builder.
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The Query builder provides an easy, graphical
way to build a query. Select your columns, add
filter criteria and you are ready to execute and
review your results.

2. Query

When you are satisfied with the results of the
data, you are ready to export into a report for-
mat for general distribution.

Query Builder
Build a visual query to
get =pecific data
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Clicking on the “Send to Report” button on the bottom right of the
Wizard Bar sends the data to reporting.
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3. Report

For simple, fast reports that everyone can
read, use Microsoft Excel for report distri-
bution. The wizard will automatically ex-
port your result set into Microsoft Excel.
Format and add any data to your Microsoft
Excel report in the Toad for Data Analysts
Report window.

Excel Report
Create an Excel report
from a query result zet

When you are satisfied with your report, the “Automate” button on
the bottom right of the Wizard Bar will set up your work for automa-
tion.

# Toad far Data Analysts - [Spreadsheet C\Dacuments and Settings\dpeabiodyll ocal Settings\pplicatian Data\uest Software\Toad for ... = 01 2%
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4. Automate Many reports are run daily, weekly, or

monthly. The steps taken to produce these
reports can be automated and scheduled to
occur at a desired interval.

Automate
Create a script to When sending to the Automation window
automate data using the workflow, it automatically loads

the connection, SQL query, Microsoft Excel
report path and adds the report to an email for distribution. One
more click on the “Schedule” button and you can make this part of
your reoccurring automated tasks, freeing up time and resources.
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Workflow Exercise

Purpose - To demonstrate the common workflow for Toad for Data
Analysts.

Note: This exercise assumes you have already installed and entered a
license key. Please refer to Appendix A for installation details.

Exercise Steps:

1)
2)

3)

4)

Start Toad for Data Analysts from the shortcut or Start Menu.

When the Quick Guide appears, click on the ER Diagrammer,
under Step 1, Understand.

You will be prompted to connect. Toad is bundled with a sample
database. This connection will be selected. Click “Connect” to
continue.

The Navigation Manager (docked window on the left) and the ER
Diagrammer will open. Click on the CUSTOMER table on the left
and drag onto the ER Diagram window. Observe the database
relationship and columns.

Click the “Send to Query” wizard button. This sends the two
tables to the Query Builder. Select a column or two. Notice that
when a column is selected a corresponding criteria column is
added to the lower panel.

To run the query, click the “Run Query” button from the bottom
Wizard Bar. When satisfied with the results, save the file and
press “Send to Report”.

Your data is now displayed in the Microsoft Excel Report win-
dow. Change any column formatting or add a title. Save and
click on the “Automate” button on the bottom right. (Note: You
may be asked to save the Query Builder or Microsoft Excel files if
you did not do this in the prior steps.

Toad for Data Analysts

8)

9)

10

-~

Double click on the Email activ-
ity. This is the very last item in
the Automation designer. Enter
your To, From and Server ad-
dress. (This is for SMTP mail.)
Click “Test” to run the script.
You will be prompted to give the
script a name and save. Enter a
name or use the default. An out-
put window will open and dis-
plays the progress.

To schedule, click on the button
on the bottom right. A task
scheduling window will display.
Press the “Set Password” button and enter your password. Click
on the schedule tab and change the settings to run 2 minutes
from now. Click ok.

Go to the top of your application and click on the large “4) Auto-
mation” button. Notice that when you do this the automation
window appears. Documents are associated to one of the 4 steps
and by default will only show when that group is requested. Click
on the other buttons and observe the windows that show for
each of the steps. When you are working on a large project, this
organization of windows can be very handy.

11) Check your email to see if you received the automated report.

Workflow—Exercise



Configuration Wizard

Once you have used Toad for Data Analysts a few times, you may
want to tweak the configuration a little, to better suit your prefer-
ences. The Configuration Wizard will walk you through some of the
larger tweaks while the Options will allow you to fine-tune your ex-
perience. You can find the Configuration Wizard under TOOLS > Con-
figuration Wizard.

CETeEE =

Layout and Settings h
Select your preferred layout and configuration settings.

Toad can emulatethe layout and settings of other products. Keyboard shortcuts and tool window
layouts are configured automatically by choosing ane of the options below.

Choose "Custom"if you preferto have greater control aver thelayout.

() Toad for Data Analysts
() Toad for Orade

() M5 Query Analyzer

() M5 Management Studio

(2 5QL Navigator

() Toad for SQL Server, DB2, MySQL

A = — —

Layout and Settings

The first screen will let you pick one of several preconfigured layouts.
For instance, if you’ve used Toad for Oracle in the past and prefer the
layout (workflow) of that tool, you can simply select it here and you’re
done. However, if you prefer to customize the layout, choose
“Custom” and click next.

On the following screen you will be presented with several choices to
configure the look and feel of the windows and grids. Here you can
change colors, contrast and more. The Configuration Wizard window
will update with your changes to give you a glimpse of what each style
really looks like.

Toad for Data Analysts

The next screen in the wizard is where you can choose a default style
for your Database Explorer and Object Explorer. The default is to di-
vide objects by their type and display them on separate tabs. If you
prefer a tree-list or stacked tabs, this is where you can change that.

After the next screen, where you can choose to use the Quick Guide

or not, you’ll be presented with a series of options to control the visi-
bility of your document windows. Lets review each one:

A =

Group Documents 4
Organize windows by workflow groups. 2ll windows are associated with a group and only windows
in that group are shown. To view other open windows, navigate to that document group.

-
@ Configuration Wizard

# Toad Project Watson - [ER Diagram]
Ele Edt ERDiogrammer Create Vew [ools Advanced Wndow  fnternal

1> Understand | (2> Query (3 Report 4 Automate

i Use document groups

[¥] Hide windows per Group e ! i 5 e Diacrarmer B, Databace Brovcer 18- Query Buider [3

© . thoworm |

Hide windows per connection

Only documents for the selected group are 5
shown. -]

Cancel

Group Documents

This is a global setting which determines whether or not those Under-
stand, Query, Report, Automate buttons are used or visible. When this
is checked, and when the “Hide windows per group” option is also
checked, then ER Diagrammer and Database Explorer document win-
dows will be grouped together with all other windows hidden. The
same goes for the other types: Query Builder and SQL Editor docu-
ment windows will be grouped under Query, Microsoft Excel and Toad
Reports will be grouped under Report and the automation workflows
grouped under Automate. The wizard image will update to show you
an example.

Configuration Wizard



Regardless of what option you choose there, the default is still set to
hide all of the document windows not associated with the current
database connection. However, if you want to turn off connection
hiding, uncheck the “Hide windows per connection” checkbox.

T ==

Group Documents
Organizewindows by workflow groups. All windows are associated with a group and only windows

in that group are shown. To view other open windows, navigate to that document group.
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Above is how things would look if everything was unchecked. Notice
how the Understand, Query, Report and Automate buttons are miss-
ing? Notice how there’s an Oracle document open as well as a MySQL
document and that the Microsoft Excel report is no longer hidden?

Tip: The hands on exercise
at the end of this chapter
familiarizes you with the
configuration options and is
well worth the time.

Toad for Data Analysts
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Configuration Wizard

Group Document Defaults

This screen will help you set up the default actions for the grouping
buttons. (You will not see this screen if you chose not to use the
document groups in the previous screen.) For example, clicking on
the Understand button will open a new ER Diagrammer document,
by default. If you prefer to use the Database Explorer instead, this is
where you can change that.

The Query and Report options are a little more important because
your choice here not only applies to the document grouping buttons,
but also to the Wizard Bar (discussed on the next page). For instance,
when you’re using the ER Diagrammer and you want to begin your
query with those tables, you can click “Send to Query” on the bottom
of the screen. This action will open the Query Builder with these ta-
bles, by default. So this Configuration Wizard screen is important
because it allows you to change this default to the SQL Editor in-
stead. The same applies to the Report option as well.

,
{2 Configuration Wizan‘

B WY -

Group Document Defaults
Each document group has a default window that is opened when the group is selected. Select the

default window to associate with the document group.

Understand

(@) ER. Diagram

(7 Database Explorer

Query
(@ Query Builder

() 5L Editor

Report

@ Excel

(7) Toad Report =iy it e

Cancel

Configuration Wizard



Configuration Wizard

Connection Documents
This screen will allow you to specify which (if any) documents you

Wizard Bar want opened by default when you create a new connection. This can
The Wizard Bar is located at the bottom of many document windows be a nice timesaver if you're frequently doing the same thing each
and is designed as a suggestive aid with links to things you may want time you connect.
to do next. It’s a dynamic bar as V\{eII, since it changes Wlth‘ context. As ) Coniguration W_ =
you can see below, when viewed in the SQL Editor, the Wizard Bar is - =
. . . . . Connection Documents
conflgured Wlth !InkS fOI’ Sendmg the .reSUIts toa report’ addmg the Select which documents to automatically open when connections are opened. ﬁ
query to the Project Manager, executing the query, opening a file and

even a link to a video tutorial. This screen gives you the option to turn

it off (on by default). [ open a new Database Explorer

Wizard bar
TheWizard bardisplays atthe bottom of most windows. Frequently used actions forthat window ;
are displayed as tool buttons. The lasttool button sends the data to the next document group. [Copen a new Query Builder

Use wizard bar

Result Sets | Seapt Output | Explain Plan | Connsction Output | Compleatty Chieck:
et 1 [x]

Drag a column header here to group WMMI

Additional Settings

@ [ a4 »|[w]m]+ -]~ i : Record 0 of 8 This last screen will let you specify whether or not you want to auto-
Bxecuted: Duratian: matically add all saved files (ER Diagrams, queries, reports, automa-
r _ tion workflows, etc) and any query you execute to the Project Man-
l B Tutorial (& Open SQL [ Run SQL P! Run Script <3 Add to Project c}SendtoReponl ! ) va Yy !

ager. This can be useful when building a new project template for

other team members. Regardless of your choice here, you can still add

] things to the Project Manager through the various “Add to Project
Manager” tool buttons.

< Back ]l Next = J[ Cancel

And that’s it! Once you’ve decided on these options, click
“Finish.” (It's recommended to restart Toad for Data Analysts after
making such sweeping changes.)
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Configuration Options

- Options

| Grid

[ [ Explorer
Editor

I [ Environment
| General
| Interface

| Confirmations
Quick Search
| Desktops
| Keyboard
| Extensions
| Network Share
| Connection Manager
| One Click Export
| Passwords

Database

7 [ Version Control
[ Data Compare
i [ Job Manager

Toad for Data Analysts is very customizable; there’s an option for just
about everything. You can access the options by going to TOOLS >
Options. In the Options window you’ll see everything from advanced
database features to controlling the Toad “croak” sound at startup!
So, what to do with all of the options? Search! Every option in Toad
for Data Analysts is indexed and easily found with the search field as
seen below.

————————————————

Envi

Action to perform on startup:

Nothing | b | |

Startup location:

[¥] Croak on startup [ Hide startup logo [] show connection dialog on startup

[] Allow multiple copies of Toad for Data Analysts Beta to [ show connection info on document tabs
[#] Check for updates on startup [] 5ubmit anonymous usage statistics
[#] import legacy connections on startup

History Lists

File history size: 10

Background Process Notifications
Notify when process runs forat least: ‘120 =1 seconds
[¥] croak when finished

[7] Show taskbar notification popup

Document Recovery

\5 2| minutes

[¥] save document files for automatic recovery every

[ I sd‘j]

[ ok [ cancal | [ apply ]

When you search the options and have a set of search hits, clicking on
them will switch the Options window to the page that option is found
on and highlight it for you, to make things easy.

Useful Options
The following tables list many of the most useful options to consider,
and their location.

Toad for Data Analysts

Environment

General

“Allow multiple copies of Toad for Data Analysts
to load” will let you have two or more Toad’s
open at the same time. Useful for comparing
things side-by-side.

General

“Save document files for recovery every [n] min-
utes” - Configure this to a frequency that you're
comfortable with.

Grid

“Edit cell on single click” - This may be unnatural
for some people. You can turn this off if you
don’t edit data as often.

Grid

“Automatically submit row changes as they oc-
cur” - if you make a lot of updates to cell data,
you may want to turn this off.

Grid

“Move cell focus with ENTER key” - for some
people, this may be unnatural.

Grid

“Show data as Read-Only” is a nice way to set
the grid to read-only by default. This can be eas-
ily changed later by clicking a button on the grid.

Grid

Formats—here’s where you can set number,
date, time and other formats.

Network
Share

Toad uses a common directory for sharing things
across a network. Use this setting to change the
default and enable one-click sharing with team
members.

Explorer

Objects

If you usually work with only one or two object
types, you can choose to hide other types here.

Editor

General

Use this to change fonts, encoding and more.

Tools

“SQL Recall: Number of statements to display” If
you want to keep a long history of executed que-
ries, set this to a large number.
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Editor

Formatter

General formatting of your SQL scripts can
be configured here.

Application
Code

If you’re an application developer, often
writing SQL to use in your VB, Java, C# (etc)
code, use this to automatically format your
SQL for use in the application code.

Database

General

“Number of rows to initially fetch in data
tab” - when working with very large tables,
this setting will prevent you from needlessly
bringing too many records across the net-
work. You can always scroll to the end of the
set and Toad will fetch the next set.

Timeout

When troubleshooting connections to data-
bases over slow connections, the timeout
threshold values may need to be length-
ened.

Query
Builder

On some databases, you may need to enable
the use of fully qualified names in queries in
order to make them run.

Cache

“Object Annotation Cache” - this feature
stores user annotations such as notes on
tables or ER Diagrams, column lookup tables
and hidden column setting between sessions
of Toad. These annotations can be stored
locally for reuse later or shared with other
Toad users on the network.

Version Control

General

Use this area to set up and configure Version
Control

Data Compare

(Script set-
tings)

Fine-tune the scripts produced by Data Com-
pare & Sync

Toad for Data Analysts

Getting Additional Help

Toad for Data Analysts is designed with the intent to be intuitive;
unfortunately, there’s no way to anticipate everyone’s impression
ahead of time. So, in addition to the tutorial videos and the inte-
grated HELP system, you can visit ToadWorld.com and the Toad for
Data Analysts community page, http://tda.inside.quest.com. With
forums, blogs and even more videos, these online resources offer
helpful tips & tricks for getting more out of Toad for Data Analysts.
And, if you ever forget where to find us online, just look for the “User
Forum” item in the HELP menu.

Support Bundles

If you do happen to come across something that isn’t covered in the
help or in one of the online resources, you should create a Support
Bundle and contact Quest Support. Our friendly and well-trained
support staff are eager to help you!

To create a Support Bundle, navigate to the HELP menu and click on
“Support Bundle.” This will create a ZIP file with all of the important
information about your environment that we need to help trouble-
shoot your problem.

Beta Program

Are you eager to stay ahead of the game and be on the cutting edge
of development changes in Toad for Data Analysts? Join the beta
program! It’s free and open to anyone. We work very closely with
our beta users to understand how we can improve Toad for Data
Analysts to better meet their needs. To join, visit
www.ToadWorld.com and look for the downloads section. And don’t
worry... you can install the beta alongside your regular installation;
you can have your cake and eat it too!

Configuration Options



Configuration Exercise

Purpose - To demonstrate how to configure Toad for Data Analysts.

Exercise Steps:

1)

2)

3)

4)

5)

6)

7)

8)

Start Toad for Data Analysts. If the Quick Guide is displayed,
close the window by clicking the X. Using the Tools menu, open
the Configuration Wizard. The Custom option should be pre-
selected. Press “Next.”

Change the skin and grid style until you find something you like.
The wizard window will show what the change will look like. Just
for fun, try Pumpkin, Summer 2008, or Valentine. When you
have found the skin you like, click “Next.”

Click on each database explorer style and select the one that you
like the best. Click “Next.”

Uncheck the Quick Guide (you can always put this back later).
Click “Next.”

On the Group Documents page, uncheck the “Use document
groups.” Observe how this changes the application look and feel.
Click the other options to see how they affect things. Reselect all
options and press “Next.” (Try this default configuration for
now.)

Change the group document defaults. This shows what type of
window is opened by default when clicking on the document
group buttons at the top of the application or from the Wizard
Bar next button. Make a selection for each category and click
“Next.”

Deselect the wizard bar and see how the wizard bar disappears.
Reselect to use the Wizard Bar and press “Next.”

Choose a default option of what window to open after connect-
ing. Click “Next,” followed by “Finish.”

Toad for Data Analysts
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9)

10)

11)

12)

Open the Options window by using the Tools menu or clicking
the dropdown on the configuration tool button.

View the options on the first page. Select the “Show connection
dialog on startup.” Click on the grid tab. View the available op-
tions. On the Date/Time Format tab on the right, use the drop-
down to choose a date time format preference.

Find the search box at the bottom of the window. Enter “filter”
and press “Search.” This will search all of the options looking for
matches. The matches will display below the search area. Dou-
ble click on the match “Prompt to filter list after.” This will load
the page containing the option. Change the value from 2500 to
1000. This option configures a prompt to be displayed when
more than a 1000 database objects are being displayed in the
Object Explorer. For very large databases this filter is very impor-
tant. (How to use filters is covered in the Database Explorer
Chapter.)

Click “OK” and restart application. Now you’re ready for the next
chapter. Don't forget to come back and experiment with the
many options available.

Configuration—Exercises



Connecting

Just about everything you do in Toad for Data Analysts will require a
connection to a database. Toad is bundled with a Microsoft Access
sample database and can be connected with no further input. Just
click the “Connect” button. Additional sample files for use with this
database are available from the Project Manager.

il | &5 | Group:
| Mame. | Connect on startup. | [ access |
‘ Arcess
i Toad Sample Database
Database file: iD:\ngram Files\Quest SoftwarelT C:ll
D File: |DiiPragram FilesiQuest SoftwareiT = |
User: Y= |
Pzt e |
Hame:
|Toad Sample Database [E=1)
[v] Save password | Conmect on startup
[~ Shaw this dislog on startup | Connect | Saye Unda
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Connecting - Various Databases

To define a new connection click on the “Create new connection”
tool button. You can now choose the database type. Microsoft Ac-
cess, Microsoft Excel, DB2, MySQL, Oracle, SQL Server, and Sybase
ASE have enhanced querying capabilities and are listed for explicit
connection. To connect to all other database types, choose the
ODBC connection type. This connection type requires an ODBC 3.0
compliant driver. Refer to the database manufacturer for driver and
install media.

& Create New Connection

’ | & 15 | crop:
[ Hame.
=] Access |
~&
Excel = ...
MySQL m Files\Quest SoftwaredT |- |
A odhe e
2 Orade am FilesiQuest Software!T ==
= f e —
&) sybase ASE I—
B
bl
onnect an starkup
[ show this dislog on startup | Cancal | Save Unda

Toad for Data Analysts End User Training Connecting



Connecting - Oracle

Toad can connect to Oracle using an Oracle client or Direct Connec-
tion. Direct Connection uses TCP/IP and does not require any addi-
tional files. Simply input the server name or IP address, user id, user
password and Oracle System ID (SID).

The connection info will be stored in the applications data file direc-
tory. Connections are stored in the connections.xml file and can be
found using the “Application Data Directory” link in the About box.

To always connect to this database when starting the application,
select “Save password” and “Connect On Startup” options. (Note:
Passwords are saved encrypted.)

k‘j#' Create New Connection

Group:

& Oracle =
Server: irvz00542

User: DEE

Password: .ee

Cannect as: Default e
Schema: «default> o[22

Oracle Clisnt  Direct
S Debi0g

Part: 1521 (£

Explain plan table: <default>

famne:
IRY¥Z00542;Deb10g (DEE)

v| Save password

Connect Save Cancel

Toad for Data Analysts

# | Create New Connection

Group:

User:

kame:

O Oracle -

Datsbase name:

Password: e
Cannect ast Default e

Schema: QUEST_STAGE | |man

Oracle Client  Direct

Current home:

Explain plan table:

DEE10G,PROD, QUEST.CORP (DEB)

v| Save password

Using the Oracle client to connect is similar to Direct Connect. From
the database name dropdown, select the database you want to con-
nect to. This list is populated from the current Oracle client
TNSnames file. Enter your user name and password to connect using
the defaults.

To change to another client, select from the available clients listed in
the dropdown next to the current home label. Toad for Data Analysts
also supports LDAP and ONAMES servers. To configure, edit the
SQLnet.ora file to include these types in your directory path. The
connect descriptors will be added to the available connections.

NAMES.DIRECTORY_PATH= (LDAP, TNSNAMES, EZCONNECT)

Adding new names to your TNSnames
file can be done through the TNSnames
e editor button or Oracle’s Net Configu-
bee ration Assistant which can be launched
from the ellipsis button [...] on right
side of the database name.

When connecting, the current schema
is your logon. Often your work is done
in a different schema. You can specify
this schema in the Schema edit box
and when connecting Toad will alter
the schema automatically. When doing
this, all other windows will have this as
the current schema.

OraClient10g_homez v
TNSNames Edikor...

SQLNET Editar...

«defaul>

Connect on startup

Each connection is given an alias name

Connect Save Cancel
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(Name box at bottom). You may cus-
tomize this to further distinguish each
connection you defined.

Connecting—Oracle



Connecting - Other Databases

Each specified database type has a customized connection window
to gather the required input for that database.

When requesting a DB2 connection, Toad will detect any other DB2
clients on the PC and will ask if you would like the defined connec-
tions (cataloged nodes) to be copied to your Toad DB2 client. Alter-
natively, you can launch the DB2 Client Configuration Wizard from
the tool button on the right of the Database Alias control.

1f & DBZ Client is installed on this system, you can select a client in this dialog
to aukomatically transfer the catalog profile ko Toad.

1f you want to import a remote or exported profile, dlick Cancel and use the
Client Configuration Wizard in the Connections window,

DB Client: DEFEUTEJ'DBZQSZDDMS A

Microsoft Excel and Microsoft Access
files can be connected to by specify-
ing the file path.

Microsoft Excel files can be connected
to and treated as a database. To
query the file and display the file con-
tents as table data, you will need to
define Named Regions in the file.

To do this, open the Microsoft Excel
file and select the data you want rep-
resented as a table. From the Insert
menu, chose Name > Define action to
give it a unique name. Do this for each
set of data. (Defining named regions
may vary between versions of Excel.)

Toad for Data Analysts

Connecting with ODBC

For all other database con-
nections , use the ODBC con-
nection type. After download-
ing and installing the ODBC
driver from the manufacturer,
you will need to define the
connection using the ODBC
Data Source Administrator.
Launch this utility from the
right tool button next to the
Data source name (shown
below) or from the adminis-
trative services of your control

Cancel ) pane l.
( Create’New Connection 1 { Create New Connection W

Group! Group!

58] Excel [v] ) odbe lv]
General |advanced

Use data source name

Dat, B

File name: WeeklyReport, xis| [ ata source name: - |DB2_SAMPLE IV]B

Enable import mode = db2admin
Password: R
Database: | [v]@
E Information
ConnectionString

ConnectionString
A ODBC connection string, Will override any duplicated
dialog properties. Example: Namel=Yaluel;Name2=Yal..

Mame: Hame:

‘WeeklyReport xs DEZ_SAMPLE {dbZadmin)

[ Conmect on startup [ 5ave password
l Connect: l [ Save ] [ Cancel ] I Cannect I [ Save ] [ Cancel
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(—-"" UDBE Data'Source Administrator: ) 1

User DSN | System DSN | File DS | Drivers | Trasing | Connsction Pooiing | About |

User Data Sources:

| Driver ‘ Add...
Driver do Microsoft Excel[”.<ls] 4
IEM DB2 ODBC DRIVER - DB2COPYT BRemove
23 Microgzoft dBase Driver [*.dbf)]
Excel Filex Micrasaft Excel Driver [%.xls) Configure. .

IrvineSybase Adaptive Server Enterprise [TDA)
M5 Access Database Microsoft Access Driver [“mdb)

% An ODBC User data source stores information sbout how to connect to
6 the indicated data provider. & User data source is only wisible to you,
- and can only be used on the current machine.

o]

Cancel Help

Fill in the user id and password to connect.
Advanced parameters can be provided by

manually entering the connect string. This
will override the defaults.

Connecting - Other Databases



Connection Management

Once you have defined and connected to a database, the connection
can be managed in the Connection Manager tool window. The con-
nection aliases are grouped by database type. Currently opened con-
nections display a green connection icon next to them.

The application points to and uses only one connection at a time. The
currently open connection that has focus is highlighted and is used
globally in the application. This means that any new windows will
open with this connection.

a ¥ e B EE BEBEE
[=] |49 Access
ik Toad Sample Database
= [ cez
ik DZ0aE (koad)
A MOVIES_9 (dbZadmin)
= T MysOL
ﬁf dpeabody@wnsny, peabodysi, com (peabodysi_c...
= & Oracle
2k DEB10G.PROD,QUEST WCORP (QIUEST_STAGE),. ..
Ak 0102vE44, ALY206960 (QUOTES), QUOTES

s DEB10G.PROD.QUEST.CORP (DEB), DEB

= =5 S0L Server

s iDEB1I:IG.I:'RClD.QLIEST.COF'\F‘ (DEE), DEE
#F  Cracle database
Server version 10,2,0,1 (DBA)

Connected since 6112009 &:04:05 PM
% 0 aof 1 connection in pool ackive
To change the focused connection, double-click on the preferred
connection or right click and choose “Set as current.” If this connec-
tion is not connected, it will automatically connect and then become

the application’s focused connection. (Note: If you have not selected
to save your password you will be prompted at this time.)

Toad for Data Analysts
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Further organization of

connections can be done My i

by creating custom 2] Access
groups. [T pEz
= T MysaL

The tree can be expanded

or collapsed for easy use. =& Cracle

Yo BHEE B EE

;}f dpesbody@wny, peabodysi,com {peabodysi_c...

Note: If a database type
does not have any con-
nections defined, it will

= | Monthly Report Connections
@ DEB10G.PROD.QUEST.CORP (DEE), DEB
~F DEB10G,PROD,QUEST.CORP (QUEST_STA...
[= [ Test Databases
<k 0102Ye44A, ALY206960 (QIUQTES), QUOTES

not be displayed. In this
example there are no SQL
Server, Sybase, Microsoft
Excel or ODBC connec-
tions.

Importing/Exporting Connections

Toad can share connections by exporting or importing the connec-
tion definitions. To do so, select the “Export Connections” button
and save the connections to a XML file. Use this file as a collaborative
resource; each Toad for Data Analysts user can import the connec-

tions through the import connections feature.

Irnport connections from an =ML file.

Export connections to an XML file.

Tip: To prevent others from
using passwords on shared
connection files, use the
Master Password option.
See Options > Environment
> Passwords

Connection Management




Connecting Exercise

Purpose - To demonstrate how to connect to the Toad Sample da-
tabase and an Oracle database.

Scenario - Define connections for most the commonly used data-
bases.

Exercise Steps:

1) Toad Sample Connection - Start Toad. If the Quick Start Guide
displays, click on the “Connect To Data Sources” button. (If
you did the prior exercise, the Connection window will dis-
play.) The Toad Sample database should be focused. Press
“connect.” Choose what window you would like to open after
connection or “OK” to continue.

2) Click on the Navigation Manager window to confirm the con-
nection is open. Observe the tables in the database through
the Object Explorer. Columns are displayed at the bottom as
you click from table to table.

3) Oracle Connection using Client - From the Navigation Manager,
click on “Create New connection” button or use the File| New
| Connection menu. Choose Oracle as the connection type. If
you have an Oracle client installed, this tab will have focus in
the middle of the window. If the Direct Connect tab has focus,
follow the instructions in the next step. From the database
name dropdown, choose a connection. Enter user name, pass-
word. Check the “Save password’” option (if desired) and
press “Connect.”

4) Oracle Connection Direct - To connect with Direct Connect,
you will need to know the server and SID. Enter server, user-
name, password, SID and press “Connect.”

5) Click on the Navigation Manager to confirm the connection is
open. Notice the tables listed are the tables owned by the

Toad for Data Analysts
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6)

7)

8)

9)

10)

login.

Right click on the connection and choose “Properties.” In the
schema box, enter another schema (IE: Scott). Press
“Reconnect.” Observe that the connection string now contains
the new schema and the objects in the Object Explorer are tables
owned by this schema. This is a way to define a connection using
your logon while pointing to a different schema.

Changing Current Connection - In the Navigation Manager, double
-click on the Toad Sample connection. The application is now us-
ing this connection. Select the Oracle connection, right-click and
choose the “Set as Current.” This also sets the current connection
for the application.

Connect to Excel - To connect to a Microsoft Excel file, the data
needs to be defined as a named region. To do this, open up an
Microsoft Excel file outside of Toad. Highlight the data you want
represented as a table. From the Insert menu, choose Name |
Define. Give the data a name. Save and close.

Click the New Connection button and select Microsoft Excel con-
nection type. Navigate to the Microsoft Excel file using the ellipsis
button [...]. When the filename is set, press “Connect.” In the
Object Explorer, confirm the named data now displays as a table.

ODBC Connection - Note: To connect to a specific type of data-
base, you will need to install the ODBC driver from the database
provider. Press “New Connection” and choose ODBC type. If you
have a predefined ODBC connection, choose this from the list. If
not, press on the “Open ODBC Data Source Administrator” icon
next to the dropdown. Click “Add” and define a Microsoft Text
connection. Close the window and choose the ODBC connection
you just defined. Click on “Connect.”

Connecting—Exercises



Navigation Manager

Mavigation Manager

The default configuration for Toad for Data
[ Analysts includes the Navigation Manager.

e I W B
.:, ACcess

#F Toad Sample Database
|=/ & Cracle

§%; DEE10G.PROD.QUEST.CORP (DEB), ...

This tool window contains your connections,
displays objects for browsing and organizes
your SQL projects.

The top part of this tool window is the Con-

nection Manager, as discussed in the last sec-

HR. Iil 1 i |v.I

It N'é |v_l

Tables | Wiews | Triggers | Users | Procedurs 4 | ®
[ |

tion. Below it is the Object Explorer. When
connected to a database the objects are
viewed by that user id and are organized by
object type. (IE: Table, View, Triggers, etc)

Rl =

e
RIES

DEPARTMEMTS

EMPLOVEES

J0EL

JOBS

JOB_HISTORY

LOCATIONS

MANAGERS

[C) QUEST_TEMP_EXPLAIN

REGICNS

SALES

TEST1

Tabbed The object display type can be

Tabbed Multline organized graphically by tabs,

Dropdawn tabs wrapped onto multiple
' lines, dropdown list, flat tree
Treelist . .
or tree list. Change the object
Shows Icons

display type by dropping down
the options for this explorer
button as shown.

Showe Toolbar

Extra Columns

For tables and views, the columns are dis-

Colurmn Datakype Canmenk

% COUNTRY_ID | CHARLZ) Primary
COUNTRY_M,., WARCHARZ(40) Country name
REGIOMN_ID MUMEER. Reqgion ID fo...

played at the bottom of the object explorer.
Extra columns are available for additional
information and vary between database
types. For Oracle, the extra column informa-
tion can include the table type, such as stan-

@ AutoCommit - é t% .

dard, 10T, temporary, or nested object and
last analyzed date.

Toad for Data Analysts
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Navigating - Navigation Manager

For each database object type there are several editors
available: Create, Alter, Delete and Edit Privileges. The
Create Table editors have an advance button that ex-
pands the editor into all of the available options for that
table type. By default these are not shown and the most
common options of columns and comments are dis-

T Commert

P S S ———

Simple Editor

e, Wl

&
o

b

i

o]

Create Table. ..
Create Like. ..
Alter Table...
Drop Table
Copy Table, ..
Rename Table. ..
Create Index...
Edit Privileges. ..
Truncate Table
Create Synorym
Edit Duplicate Data
Motes...
Remove Maokes
Send To
Generate S0L
Refresh Item

Options

Advanced Editor

Right-clicking on the Object Ex-
plorer displays all of the available
actions for that database type.

Navigation Manager



Depending on the size of the database you are connected to, finding Clicking on the funnel icon will bring up the filter editor. The first tab

a specific object may be difficult. Most production databases have offers all of the available options for that database type. The filter is
thousands of objects which make it tedious to manually scroll applied only to that connection, schema and object type and is re-
through a list to locate the tables or views needed for a query. To tained between sessions.
make this task easier, the Object Explorer offers filtering.
L] el
|| Mamed fiters Unnamed ] x|
When first loading an object type, you may be prompted to create a Properties |53t | Prview
lame: |
filter. The application options contai i . e
pp. p : tain a filter threshold Wher.l the Advanced
number of objects exceed this value, you are prompted to build a Fil o e
Invert Selection
filter. This option can be changed on the Explorer | General tab. iiter ETE
Logging : Glob (* wildcard)
=l Layout Regular Expression
Buffer Paol Mot Hul
Cluster Name [
= Cluster Owner
Toad'for Data Analysts x| 10T Hame
Tok Type Any
\y The list you have chosen to display is more than 100, Do vou wish to define a filker for it? ?ﬁfjiﬂnad x:;
e i
Tablespace Name
i & Misc
= Match all True i
|| Do not prompt me again Cancel | = RSRERRS fo]
= oK Cancel Cear | @)

Advanced filters can be created by selecting the SQL tab. To construct

Filtering can be done three ways. The simplest filtering is to freehand a custom filter, select “Enable custom SQL” and enter your WHERE
type a filter string in the edit box located below the schema name in clause criteria. The preview tab allows you to see the results before
the Object Explorer. The filter is appended as a WHERE clause filter leaving the editor. Once you are satisfied with your filter, enter a
and the database re-queried. name and save. If you set a named filter, you can apply or remove the
Obiect Explorer | Praject Manager filter by clicking the dropdown beside the filter icon.
o o ) .
& Named Filter
. . il | et T e B
Slmple Fllter .-:::_E 3 [j) - Named filters | I o) X
Properties. SO |Preview
% [w| Enable custom Sl | Nal‘nEd Filters
E_ r_e LOUER (tebs.table_name) in ('ads_fax', 'ads_fax_log'))
7] ADS_Fax_LOoG b <Mone =
g sl I a —
m 23 v
oK Cancel Clear 3 Startlng Wlth bt
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Navigation Exercise

Purpose - To demonstrate how to configure the Navigation Manager
for connections most commonly use.

Scenario - Your business has over 100 databases, however you do
most of your work on 3 test databases and 1 production server. These
servers have thousands of tables. You usually only use 30 tables.

Exercise Steps:

1) Organizing Connections - In the Navigation Manager click on a
connection or connection type. Right-click and choose ““Create
Group.” Name it “Test.” Create a second group name
“Production.” Drag existing connections into one of these groups.

2) Set Object Explorer View - Double-click on the connection you
want to have focus. In the Object Explorer, click on the options
for the explorer. Observe how the display changes when choos-
ing tabbed multi-line, dropdown, tree list, and flat tree. Choose
the view you feel most comfortable with.

3) Filter tables - Double-click on the Toad Sample database. In the
filter edit box type “ORDER” and press enter. This is requesting an
exact match. Since there are no tables named ORDER, none are
displayed. Add an asterisk to the end -> ‘ORDER*’ and press en-
ter. Now there are two tables showing that start with the name
“Order.” Add an asterisk to the front and you will now see all ta-
bles that contain the word “ORDER.”

4) Name Filters - Double-click on another connection type, such as
Oracle. Click on the filter funnel icon. This will bring up the filter
editor. Type in afilter in the search condition. Click on the SQL
tab and check “Enable custom SQL.” Edit the WHERE condition.

Toad for Data Analysts

For example

LOWER(tabs.table_name) LIKE “dept%”
or LOWER(tabs.table name) LIKE “"emp%*

Enter a name for the filter and press “save.” The filter will now be
applied. Clear the filter by choosing “None” by the dropdown next to
the filter or “Clear” on the filter editor.

5) Create Table - Using the connection of your choice, open the
Create Table editor by doing one of the following: right-click on
tables and choose “Create Table,” press the Create Table icon on
the Object Explorer toolbar or File | New | Table.

6) Enter a name for the table. Rename the default column and
choose data type and nullable selection. Press the “Add” button
for more columns. If using an Oracle connection, press the
“Advanced” option and explore the advanced settings. When
done, press the “Show Script” tab to view creation script. Press
“Execute” to create the table. It will now show in the Object Ex-
plorer. Note: If you do not see the table and it was successfully
created, remove any filters you may have or check to see if it
was created under a different schema.

7) Delete Table - Select the table just created. Press “Delete” or use
the right-click menu. The “Drop Object” editor will display. Mul-
tiple objects can be dropped at once. Options applicable to the
type will be displayed, such as “cascade.” Set drop options, view
the script and execute. The tables will be dropped and the Ob-
ject Explorer updated.

Navigation—Exercises



Project Manager

The third and final piece of the Navigation Manager is the Project
Manager. Located behind the Object Explorer tab, the Project Man-
ager is a convenient place to store files, queries, To-Do lists, connec-
tions, FTP connections, URLs and other things that you might need
for a particular reporting project.

tion Manager

T T

g e | F
E |_] Access
#& Toad Sample Database
— | Oracle
P DEE10G. PRO

Object Explarer | Project Manager

Sample Project ~ @
= a Diagrams
“;n AddressPerRegion.ter
i) Quest_Stage_Schema.ter
= a Queries
‘Ej AddressesForsmithandEvans, tsm
ITin OrdersGreaterthan10000ollars.tsm
|_.-"J COrdersGreaterthani000bollars.sgl
|__-"J selectedwarehouses,sql
= a Reports
&) addressPerRegion.xls
B InventoryCountByWarehouse, xls
| CuskomerList, bdr
| ItemsPertareHouse, kdr
m] CustomerOrders.bdr
&[] To-Do List - Weekly

You can have many saved pro-
jects within Toad. Just click on
the project name to quickly

switch to another saved project.
To create a new project, click on

the A button at the top of
the Project Manager window.

Double-clicking on any file will
load that file into the proper
window.

Many parts of the program
have tool buttons to save/add
that windows content to the

project manager. Look for these on the wizard bar or toolbars.

&.

"Add the current page ko the Praject Manager

Toad for Data Analysts

The following project types can be added to your project.

New Folder

Directory

Existing File
FTP Connection

URL

Database
Connection

To-Do List

To-Do Item
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Adding a new folder to the project is useful for group-
ing similar or related objects. It’s a logical folder, so it
has no affect on any files or directories on your com-
puter.

This action will let you add a physical directory from
your computer (or on the network) to the project.
When you open it, you are presented with a Windows
Explorer-type interface

This action will add a file of any type to the project
Add a saved FTP connection to the project

URLs can point to intranet as well as internet sites. You
can also use it to save a link to a network location.

Use this action to associate a saved connection for
quick access

Similar to a folder, but used for grouping To-Do items

Each To-Do item is a separate task. You can open these
to add notes as well as due dates. The To-Do item will
turn red when the due date has passed. Just check the
checkbox to indicate that it’s complete.

Tip: Projects are a great

way to organize all of the
resources for a given report
to then distribute to a team
or to new team members.

Project Manager



Project Manager Exercise

Purpose - To demonstrate how to create and build a project.

Scenario - You are starting a new program task that will take awhile
to build and you want to stay organized.

Exercise Steps:

1)

2)

3)

4)

5)

6)

7)

8)

9)

Click on the Project Manager tab. (It's the second tab in the mid-
dle of the Navigation Manager, on the left of the application.)
Using the Sample project that is bundled with Toad, double-click
on one of the files under the Query folder. Notice how it opens
into a window for use. Close that window.

Click on the folder icon on the tool bar of the Project Manager
(just under the tab). This will create a new project and ask you to
enter the name. Enter any name and click “OK.”

Right-click and add two new folders. Name one “Websites” and
the other “To-Do.”

Open up a web browser from the standard toolbar. If the stan-
dard tool bar is visible but you do not see the web browser, drag
a toolbar to a new row so it expands the size. If you do not see
the standard toolbar, click on the Tools document group (all the
way to the right of the application, near top corner).

The web browser opens by default to the Toad for Data Analysts
communities page. Add this web link to your project by using the
“Add to Project Manager” button on web browser toolbar.

Change the web address by entering a new address in the web
bar. Click the green GO button to load page. Add this to your
project. Close web browser.

Go back to your project and double-click on one of the URLs.
This will load the page into a web browser.

To organize the two newly added URLs, drag the URLs under the

Toad for Data Analysts
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10)

11)

12)

folder name “Websites”.

Click on the To-Do folder to give it focus. Right-click and add a To
-Do item. Double-click on the item and enter task details and
due date. When that day arrives, the node will turn red. When
you are done with that task, check mark it and it will draw a line
through the item.

Add any files you like to the Project Manager, such as *.SQL or
* XLS. Use the right click menu and choose “Add Existing File.”
Once added, double-click to open in appropriate viewer.

You can also add connections and database objects. Click on the
Object Explorer (next to Project Manager tab). Select a table.
Right-click and use the “Send To Project Manager.” Go back to
Project Manager and double click on the newly added table. This
will open an Object Detail window at the bottom of your applica-
tion. This is a docking window and can be dragged and docked
anywhere.

Project Manager—Exercises



Understand - Database Diagrams

Before writing any queries, you need to understand how the data is

100% ¥

s

Understand - Diagrams

By

organized. The ER Diagram window helps you to easily identify rela-
tionships between tables via foreign key relationships. Understanding

the columns and their relationships will help you determine what col-
umns you need and the natural join predicates that are available

through primary and foreign keys.

Creating an ER diagram ...

@ Discover entity data relationships by dragging tables or views
from the Object Explorer on the left onto this drawineg surface

® Add your own relationships by selecting a
column and dragging to the column to be
Joined

L -

Add notes by clicking an object and using the
“Right-click" menu

Save ER diagrams and use as a collaborative e zsce et o . Lo Lok CROooremmr Creste  Pew, Todks wodow 10 || sesrch Googe Bl
purm - = e e (1 Unde 2 Query  3)Report & Mutomate Tools
. e e -y 5 el | 3 g 2] © v mo ot oo o ] g TR bR oeranaer. 7 catabess Ecakrer 1% Query ke 7 Gdker ) webeomsee g
D i iy BB ol 1By
) meiant an o AR (vt o S e | cabx
St RN Y T CETSr— ]
'!f‘.’:'.‘-'?.'.‘.‘. e = |2 acoess I, DEPARTMENT_ID L oo o EMPMOYEE_TD
= Efmaceidan  ® ¥ Toad Sample Datsbase DERARTMENT _NAME L START_DATL
=0 Crade | d MANAGER._ID END_DATE
; AT IO o
= DUPagRTMENT 1D
N.llnliull!l‘ Praect Managns i Raferanced chjacts 2
" LA A ] DEPARTHENTS (DEPRRTMENT 1D
i Rederonced chjects ul | EMPLOYEES, (EMPLCYEE _IDY)
T el Tl ) o | EMPLOYEES {EMPLCYEE_ID) 71 30855 (308_I0)
. . . . . fr LR -
Open an ER Diagram window by clicking on the ER Diagram tool but- ,ﬂ;f'ﬂ“ e 3;‘;-
ton, tools menu or right-click Send To > ER Diagram action from the ii‘.ﬂ;ﬁm , J |,
Object Explorer. Add tables by dragging or double-clicking from the =5 ey i susey
Eman Max_SALARY
Object Explorer. If the table has a foreign key on one of it’s columns J: oo
. . . . . 7] MarssGERS e |
the dependant table will be shown. The foreign key relationship will st o o o ——
= 3 s
i i i E———— 7 3065 (308 _ID)
be drawn with a line between the associated columns. e | B SO »
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Toad for Data Analysts

The toolbar offers several features to organize the display. The first
tool button auto-arranges the tables and the second auto-sizes them.

Depending on how many tables you have, arranging and sizing may
be needed for best viewing. Zooming in and out is controlled by the
dropdown. The toolbar above shows 100%. The spin edit, next to this,
designates the reference depth. The higher the number, the more

tables may be drawn. To view details of a specific table, select the
table and press F4 or the toolbar icon that looks like an eye.

e Toumd Tor Dt FR Diageaisn]
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The ER Diagram window can be annotated and used as a collaborative
resource. Depending on what you want your diagram to focus on,
there are many features that can be used.

_/ E ER Diagram

COUNTRIES

S

REGIONS

% Wiewer Table APPS.ADS_ADLRE

SPECIALTY

IH ADS_ADLRX (hidden calumns)

LOCATIONS

“Z ER Diagram

For relationships only, all details can be
minimized on the right-click menu. For
additional column details, maximize the
tables and choose “Show column details.”

Some tables have so many columns it is
difficult to understand them. Many of the
columns do not provide useful query data
and can be hidden using the Column Man-
ager.

Displaying only the most significant infor-
mation makes it easier for you and your
colleagues to pick up and use.

=x]

AD_WR
AD_TRX
RANK_TRX
QUINTILE_TRX
AD_NPS
RANK_NPS
QUINTILE_WPS
SULFOMYLUREAS_NPS
ALPHA_GLUCOSIDASE_fiPS
ALL_OTHER_NPS
T2D_MPS
ACTOS_HPS
AVANDIA_NPS
ACTOS_SHARE
AVANDIA_SHARE
SWITCH_CL_TO_SUE
SWITCH
SWITCH

| ADS_ADLRX
SwrtcH. LASTHNAME

# Hidden Column Manager

‘hidden calumns)

Table: ADI_ADLRX

Availabls

LASTNAME
FIRSTMAME
ADDRESS
Iy
STATE

1P
UMP_ID

SE3

20| FIRSTNAME
RELPe|  ADDRESS
reL_ped  CITY
HUM_Pq  STATE
CHURM)  EIP
mmoyay  UMPID
T20_
T20_LAl

LRE_QU
- Referencedobects

Many tables have
columns with the
same names which
have data that
would be useful to
join. Use the Look-
Up table utility to
find tables with
similar column
names.

Selected

SPECIALTY

AD_HRA

AD_TRX

RANK_TRX

QUINTILE_TRX

AD_WPS

RANK_NPS

QUINTILE_WPS
SULFONYLUREAS_NPS
ALPHA_GLUCOSIDASE_NP
ALL_OTHER_NFS
TZD_WPS

ACTOS_NPS
AVANDIA_NPS
ACTOS_SHARE
AVANDIA_SHARE
SWITCH_CL_TO_SULFONY

oK Cancel

x|

(o]

% Tuterial 5 Open Diagram  £3 Add to Project ) Send to Query
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The ER Diagram window is best used for graphically displaying the
joins for a query. The joins that are not from foreign key relation-
ships can be manually drawn and are shown has dotted lines as
shown below.

*dbx

“& ER Diagram ” "3 ER Diagram HR_TST.ter*
L] NES)
“, REGION_ID

REGICN_NAME

B ES
= <, COUNTRY_ID

oo COUNTRY_HAME

co|  REGION_ID

Referenced objects x|
[ SALES (REGION)

[ 'inaLES
Name
<, SALE_ID
&= REGION
SALESPERSON

Refersnced objects x|
[ REGIONS (REGION_ID)

=]
Datatype | Mot Null  Comment
MUMBER
WARCHA ..
WARCHA ..

SALE_DATE DATE
SALE_AMT MUMBE

jects x|

oK Cancel 2

# Tutorial [ Qpen Diagram 53 Add to Project (D Send to Query

Additional annotation can be added as notes to any table or to the
ER Diagram file. When table notes are present, a yellow note icon is
used on the table name. These notes are saved in a annotation cache
and will appear in other parts of the product such as the Database
Explorer and Query Builder. The annotation cache can also be shared
as a collaborative resource by storing it on a shared network drive.
To share this file, set the network path under Database | Cache in
the options window.

When your ER Diagram is complete, save the file and add to the Pro-
ject Manager. You can easily reopen this file by double-clicking from

the Project Manager. To use the file as the join predicates of a query,
press the “Send To Query” button on the Wizard Bar.

Understand—Database Diagrams



ER Diagram Exercises

Exercise 1
Purpose - To demonstrate how to build a collaborative ER Diagram.

Scenario - Several daily and weekly reports are generated regarding
customer sales. Build an ER Diagram that can be used as a template
for these queries.

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking on the
connection string in the Navigation Manager.

2) Click on the ER Diagrammer from the standard toolbar. Select
the contact table and drag to the diagram surface.

3) Right-click and deselect “Show Dependencies.”

4) The orders.shipping_address_id and orders.billing_address_id
foreign key relations are not needed in most queries. Right-click
and choose notes. Enter information for the users to remove
these joins when building a query.

5) Itis against company policy to display sex and home phone num-
ber in reports. Right-click on these columns in the CONTACT ta-
ble and select “Hide Columns.”

6) Right-click on the CONTACT table and choose “Manage hidden
columns.” Select birth date and add to right side. This will hide
this column also.

7) Click “Add to Project” from the Wizard Bar at the bottom of the
window. Provide a name for the ER Diagram file.

8) Close the window. Click on the Project Manager. Locate the ER
Diagram you just added. Double-click to reload.

Toad for Data Analysts
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Exercise 2
Purpose - To demonstrate how to manage large ER Diagrams.

Scenario - New employees to your group need to learn the tables
used in reporting. To start them off, build a single diagram that
shows all tables and the database relationships.

Exercise Steps:

1) Connect to an Oracle database that has the HR schema.

2) Goto Tools | Options | Database | Diagramming. Make the fol-
lowing changes: Default table height 500, maximum number of
tables 10, and maximum reference depth 5. Click “OK” to apply.

3) Set the schema to HR. Select the countries table. Right-click and
Send to ER Diagrammer. A warning will be displayed that says
you are exceeding your table limit. Select “No” to not limit.

4) There are too many tables and the size of the tables are too
large. Click on the Auto Resize and Auto Arrange tool buttons.
Better, but the tables still do not fit on the diagram.

5) Change the zoom percent by using the drop down on the tool-
bar. Auto arrange tables after zoom. Do this until you can fit all
tables on the diagram.

6) Change the reference depth from 5 to 0 and press enter. This
controls the depth of references. At 0 there are no dependen-
cies. Change to 1 and 3. Auto arrange tables when needed.

7) Determine the reference depth that best suites your needs.

8) Notice that Employees.job_id and Job_History.job_id might be
an important join. Manually draw a join by selecting one of these
columns and dragging to the other.

9) You'd like to know more about the Job_history table. Right-click
and “Show Column Details.” This is not enough information.
Click on Object Details to load full details.

Database Diagram— Exercises



Understand - Database Explorer

The Database Explorer is made up of two primary pieces: the Object
Explorer (part of the Navigation Manager) and the Viewer window
(below). This section will focus on the Viewer window. (The Object
Explorer is covered in another section.)

Understand - Database Explorer

This gives you an important high-level understanding of the table.

The Data tab is where you're likely to spend most of your time. This
“browser” interface allows you to visually inspect the data in your
table without writing any queries. Depending on your database cre-

Viewer Table QUEST_STAGE.ADDRESS | dentials (and

Columns | Data | Statistics | Indexes | Relationships | Constraints | Synonyms | Grants ‘ Saript Whether or not yOu

hd

Drag a column header here to group by that column

installed Toad in
Read-Only mode) you

5 Towd for B THIEST =
Fic Edit Viow Took Window Hep [ semencoone (]
[T Understand | 2> Query 2 Report 5 Automale: Toals
= 3 . 2 [O Rt fte) Dt [-1, - “HERDaganma 5 Dabdu Eplores 2, Query Bualdes [P pdles £ Aglomation (3) Yieb Browacs =
angmlﬂu:gr _-ﬂ.!:_. & Viewes Table QUEST_STAGEADDRESS -qvu_r?
S| Z2| R B BT o | pata | statstcs | indewes | Relstonshes | Constrants | Syronyms | Grants | soet ]
BT - g
i rooniocahos: (uest... Tkl Laal Al v o B2 15918 M 3
¥ g
e e 2
20 orate
) XE (Quest_Stage) - [ ety Py Ry edabie (DHEd Gt Anavaed
o S Server 1ADRESS D | INTEGR | B MR
; eif [ I:;ﬁ\l‘u.wmnu... 1 2 = 3 = —
3 ADDRESS_LPE 2 VARCHARZ(0D) 7] MAT0
4y VARCHAR2{30) ] 27mar-09
5 LIATE VAL AT = 2 HATE
& CLAMNTHY VARHLI () ] LIHAT-TE
7 POSTALCODE | VARCIMA2(10) ] 27-MAT-03
8 nEcion = [ci] 27 Mar o

Record 1of8

B Tutorial 3 Add to Project 2 Send to Query
& ¥E (Qhoest_Stage) - Direct =

The Viewer has several tabs across the top which change slightly, de-
pending on the database you’re connected to and the object type that
you have in focus in the Object Explorer to the left. For now, we’ll just
focus on how it works with the Oracle platform. (The table object type
represents most of the tabs available for other types as well.)

Tables

The Columns tab gives you an overview of the table’s columns, dis-
playing information such as column names, data types, whether or
not a column is a primary key, whether it can contain NULL values,
defaults, comments and the date when it was last analyzed.
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4, ADDRESS_ID *  ADDRESS * ADDRESS_LINE_2  CITY * can modify records
» 1189|7358 Reconfigured Avenue | Maurice Fernandez | Fisher .
1113|3742 Good Avenue Jake Ardena Hepler here' Insert' u pdate
1745|9476 Spurns Turnpike \iera Seven Hoehne an d d e Iete Ca pa b | I I-
565/ 11811 Orthopedic Drive Yuri Barden Stanton tieS are made easy‘
1516|6225 Yardsticks Lane Varden Wilson Mutrioso
1571 1072 Denotes Sireet Giles Mazza E Warren

You can use the viewer window to easily group or filter columns.
When you need to sort through lots of records quickly, this can be a
quick way to get the
information you’re
looking for. To filter
your results quickly,
click on the filter icon

Viewer Table QUES....ORDERSUM_TEMP |

Columns | Data | Statistics | Indexes | Relationships | Constraints | Synonyms | Grants | Script |

e

ITEM_NAME * /

ORDER_ID = =

in the column header. (Contom) |BUSINESS_PHONE ~ QUANTITY  OrderTotal  EMALL ¢
1201 (Blanks) [(507) 507-8198 1 439.81|Rebecca
1192 (Non blanks) 633) 376-6843 L] 439,81 | Welby.M
To group columns 744108 (632) 943-3340 3 439,81 Sylvia. 5t
righ%—clicrli on a CO|-’ 1002J (376) 511-8687 9 439,81 | Waylanc
993111 - [(492) 831-3790 7 439.81|Yolanda.
umn and choose = |

“Group By This Col-
umn.” You can also
view summary infor-
mation for individual
columns such as max,
sum, average of a

column and more by |
N o . TTEM_NAME *: Tugulusai Faciles (Count=592
right-clicking. = s Faciles !

TTEM_NAME *: Triceratops Horridus (Count=574)

Max=10 |Sum=36564.02

ITEM_MAME *: Triceratops Prorsus (Count=611)

Max=10 | Sum=21104...

TTEM_NAME *: Triceratops Sulcatus (Count=592)

Max=10 | Sum=21803...

is (Count=646)

ITEM_NAME *: Troodon

Max=10 | Sum=87856

Right-click to add column totals,
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58 Viewer Table QUEST_STAGEITEM |

Columns \ Data | Statistics | Indexes | Relationships | Constraints | Synonyms | Grants | 5cript|

Drag a column header here to group by that column

Use the Indexes tab to understand what indexes (if any) exist for

your table.

The Relationships tab is an excellent way to gain an understanding of

the tables you may

Owner Index Name Index Type
» =] QUEST_STAGE PK_ITEM NORMAL
IndexDataRelation |
©, INDEX_NAME Column Name Position
» PK_ITEM [TEM_ID
T =1
-

Index Name: 5YS_IL0000014036C0000455

Index Type: LOB

Uniqueness: UNIQUE

Status: VALID

Table: QUEST_STAGE.ITEM

Table Type: TABELE

Tablespace: QUEST_DEMO_DATA

Viewer Table QUEST_STAGE.ITEM |

need to include in a

Columns | Data | Statistics | Indexes | Relationships | Constraints | Synonyms | Grants | Saript |

query. This tab will
give you a visual ER
Diagrammer view of
the tables and their
relationships. See the
ER Diagrammer sec-
tion for more detail
on this feature.

The Script tab shows
you the script that
was used to create

the table. If you want
to create a similar

table, you can open this script in the SQL Editor, make your modifica-
tions and execute it. It also gives you deeper understanding of the

table’s design.

B8 wox [rf|Leve [ 1]

~ ITEM

G|, ITEM_ID
ITEM_NAME
RETAIL_PRICE
ITEM_PICTURE
ITEM_DESCRIFTION

| WAREHOUSE_ITEM

oo, ITEM_ID
, WAREHOUSE_ID
CURRENT_QUANTITY

Toad for Data Analysts

Tip: To reduce the load on
the network and your PC,
apply a threshold to the
Database Explorer to limit
the rows retrieved. Navi-
gate to Database: General

Editing Data

Understand - Database Explorer

To view all of the records in the table, right-
click and select “Read All Rows.” If you want
to avoid retrieving millions of the records for
large tables, you can try “Row Count” instead
to see how many records will be returned. If
you have too many records, use a filter to
reduce the total number of records in use.

Tip: There’s an option to

When it comes time to edit the data in the Data- change the default from

base Explorer, you can edit the grid in place by

single-click to a double-

clicking on the cell. You can also right-click on the click. Navigate to Environ-
grid and select Show > Card View to see one record ment: Grid

at a time.

Tip: There’s an option to
change the default so that
all changes are executed in
a batch. Navigate to Envi-
ronment: Grid

When editing the data in a cell, your changes
are saved when you exit the cell or when you
hit “Enter.” These changes cannot be undone.
Most cells will be simple edit fields. However,
columns with DATE data types will show a
pop-up calendar, LOB data types will have a

LOB editor and so on. This make it easier to manipulate the data in your

table.

If you’re concerned about making changes to a ——
. o Read Only
table accidentally, you can set it in read-only L

mode. Click on the green circle at the bottom of Define... Open

the grid to toggle the grid status.

To insert a new record into the table, use the plus (+) button. B
Likewise, to delete a single row from the table, use the minus (-)

button.

.1 Toacceptor reject changes that you’ve made to the grid, use the
a8
green checkmark or the red X.
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Database Explorer Exercise

Purpose - To demonstrate how to use the Database Explorer.

Scenario - You need to build a query listing customers and want to
know more about the table before writing the query.

Note: This exercise uses the Toad Sample database. This connection
does not have the relationship and script tabs. The tabs available can
differ depending on the type of connection.

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking on con-
nection node in the Navigation Manager.

2) Double click or right click “View Details” on the contact table.

3) View the column data.

4) Click on the Indexes, Primary Keys and Foreign Keys tab. Observe
the index data.

5) Click on the Data tab. Find the row where the last name is
“Acton.” Do this by clicking the filter cone on the “Last_Name”
column header. When you select “Acton” you will only see this
row.

6) Use the column filter again and choose “All” to clear the filter.

7) Click on the column header. It will sort the rows by alternating
ascending and descending order.

8) Click on the filter cone in the top left. This brings up a custom
filter builder. Builder a filter such as “CONTACT_ID > 2000”. The
filter string will display at the bottom on the grid. Click the
checkbox to remove the filter.

9) Click on a row in the middle. Notice the row number change in
the bottom right. Right click and choose “Row Count.” This gives
you the total rows in the table.

10) Right click in the white space near the bottom of the grid in the

Toad for Data Analysts

11)

12)

13)

14)

15)

“SEX” column. Choose “Count.” This gives you the total count
showing values in the grid. Using the column filter, choose to
display only “F” values. Notice how the count total is now up-
dated.

Using the column filter, choose all to display all rows. Click on
the “SEX” column and drag to the grey row above the grid that
says “Drag a column header here to group by that column.” All
the rows are now grouped by the value of the “SEX” column.
Each group can be expanded to view the row data.

Right click on the grid anywhere and choose “Card View.” Scroll
through some records. Click on the customize button and use
the column filter. Set this to “Address_id = 100”. Notice how the
card view is filtered but not the grid view.

Go back to the grid view. Select a row in the First_Name column
and edit the value. Press “Enter” to update the row. Go to the
Birth_Date column and use the date picker to change the date.
Each data type will have an appropriate editor. (NOTE: If you are
using Oracle or a database that does not have Auto Commit
turned on, you will need to press Commit at the left hand bot-
tom of the window.)

Go to Tools | Options | Database | General tab. The very first
option is “Number of rows to initially fetch in data tab.” Change
this to 50 and click “OK.”

Go back to the data grid and refresh the grid by pressing F5. No-
tice the right hand corner now says 1 of 50 (scroll for more). The
option you set controls the number of rows fetched when the
data tab is displayed. Click on the scroll bar and hold down to
retrieve more. Right-click on the grid and choose “Read All
Rows” to retrieve all table rows. This feature can be especially
handy for viewing tables with many rows.

Database Explorer—Exercise



Query - Query Builder

The Query Builder enables you to create a query without writing or
editing SQL statements. Even if you are familiar with SQL, the graphi-
cal interface makes it easier to create relationships and visualize the

query.

Building a Visual Query ... o
® Build a query by dragging tables or views from the Object Explorer -
onto this drawing surface. Select columns and run the query
@ Add your own relationships by selecting 3 column and dragging
to the column to be joined

@ Add nobes by clicking an object and wsing the “Right-click” menu
Save Querles and use as a collaborative resource

Query Builder

When adding tables to the Query Builder, foreign key relationships

are drawn automatically. Join additional columns by selecting a col-
umn in a table and dragging it to a column in another table. A con-
nector line displays between the two objects to visually represent
the relationship.

Add columns to the query using one of the following methods:

... Select the checkbox beside each column to include in the query.

... Select (Add All Columns)to include all columns, using each col-
umn name, in the query.

... Select *(Wildcard)to add all columns to the query using a
SELECT * statement. If selected, an asterisk displays for the Field

name in the Criteria tab.
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Column Criteria

Only fetch unique
records

Select this checkbox to eliminate duplicate records from query results.

When a column is added to

Table

Displays the name of the table associated with this column.

the query, a column criteria is

Database

Displays the name of the database associated with this column.

added to the bottom pane of
the Query Builder. Each col-
umn can have any of the fol-
lowing attributes:

Aggregate Function

Select one of the following functions to calculate column values: Count, Count (Distinct),
Max, Min..

Note: If you add a GROUP BY clause, you must specify an aggregate function for any remain-
ing columns.

| 0nly Febch unique records;

Where Condition

Select operators, expressions, or a date range to include in the WHERE condition. Currently,
you can have a maximum of two WHERE conditions joined by an OR condition. For more
information, see Set Where Conditions.

Field DEPARTMENT _MAR
CEPARTMEMNTS

Database HR.
Aggregate Funckion
Where Condition ="'Accounting’
CQr
Group By
Having Candition
| Mone
Sark (2] Ascending
| Descending
Yisibile >
Field alias
Table Alias DEPARTMEMTS

Or Select the operators and expressions to add to the OR condition. For more information, see
Add OR Conditions.
Group By Select the column you want to add the GROUP BY clause to and click +. You can add a new

GROUP BY clause to any remaining columns to group them in sequence. Any remaining col-
umns that do not have a GROUP BY clause must include an aggregate function.

Having Condition

Select the operators, aggregate, and expressions to include in the HAVING condition. This
option is disabled unless you have set a GROUP BY clause.

Sort Select an option to add this column to the ORDER BY clause and specify a sort direction.

Visible Select this checkbox to return this column in query results. This is useful if you need to in-
clude a column in the selection criteria, but do not need to display it in the query results.

Field Alias Enter a name to use as an alias for the column name in the query results. This is useful if
you have an ID or vague column name and want to easily identify that column in the query
results.

Table Alias Enter a name to use as an alias for the table name in the query results. For example, if there

are multiple employee tables that you need to join for the query, you can rename the tables
to permanent, contract, etc. to easily identify them.

Note: If you selected A// Columns for a table or created a column using the Edit Calculated
Fields window, you cannot modify the table alias.

Toad for Data Analysts
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Where Condition Editor

Query Builder Where Condition Editor

The formula tab helps you build expressions. Doubleclick on any
function, operator or field to set an expression on the selected col-

umn.

Open the Where Condition Editor by selecting the “Where Condi-
tion” row and press the ellipsis button [...] on the column you wish to

define the where condition.

A filter can be defined by constant, another column or bind variable.

Formulas

Selecting the column type will provide a list of available columns
from the query. Selecting the constant type allows you to manually

enter a value or the dropdown will
query the database and provide a list
of distinct values.

Field DEPARTMENT_NAME |
Table DERPARTMENTS
Dakabase HR.

Aggregate Function

ondition

= "Accounting'

A bind variable can be used by enter-
ing the bind symbol and bind name.

IE: :a_bind

At run time, a bind variable window
will prompt you for the value. The
use of bind variables prevents redun-
dant parsing of the SQL statement by

& where Condition

Field: "DEPARTMEMTS","DEPARTMENT _MAME"

Fomrn | Formula

|DEPARTMENTS‘DEPF\RTMENT_ID || MANAGERS EMPLOYEE_ID <> 100

 Columns and Calculated Fields

t§ ] DEPARTMENTS, DEPARTMENT _ID

BFILEMAME($Diractoryd, $Filenamed) el

DEPARTMENTS. LOCATION_ID

Operators DEPARTMENTS, MANAGER_ID

¢ > 1= IS MANAGERS, COMMISSION_PCT

+ 01 = ) 0m MANAGERS. DEPARTMENT_ID
MAMACERS Eraa

= Where Condition

Field: "DEPARTMENTS", "DEPARTMEMNT _MAME"

DEPARTMENTS. DEFARTMEMNT _MAME [ERiRIS SN -y g ity 1)

MAMAGERS, EMPLOYEE _ID

MAMAGERS. HIRE_DATE
MANAGERS, J0E_ID
MAMAGERSLAST_NAME
MAMAGERS MANAGER _ID
MAMAGERS, PHOME _MUMEER

i)

Dates

| Remove | | (o4 | | Caneel |
Formulal
Walue 1 Type
|1,|— (1 Calumn
() Constark |1||
Accounting o~ .
Adrministration 3 iJConstant Filters
Benefits :
. Enter alue or binc
Caonstruckion
Contracking v:l
| [ ] Case insensitive ("a" ="A")
[ Subguery. .. | | PRemave ul’s Cancel J

Figld: "MANAGERS","HIRE_DATE"

Fam | Fomula | Date Rangs

|Last 15 days

Date Range Yalues

the database and should be consid-

ered if the SQL
statement is exe-
cuted frequently.

[\ Mame

& Bind Variables

Direction | Walue

If the columnis a
date, a Date Range
tab is added. Select
by clicking on the

[ Type

desired date range.

oK Cancel L@J
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Query Builder Query Execution

Query Execution

Execution time and messages are listed in the Messages tab. The
right-click menu on this tab offers several grouping and customiza-

Once you have built your query, you can execute it in a variety of tion features.

ways: by pressing the “Run Query” button on the bottom Wizard Bar,

pressing the “Execute SQL” toolbar button, F9 or right-click Execute —

action on the table pane. ] L sort ascendng
ey 5 [ (o) [DEB106 FROD.QUEST CORF (DE... [ i il‘ Sort DESEEI‘ldiI‘lg

Position

Line

The result set will be displayed in a separate tab. Each time you exe-
cute the script and get a new result set it is stored in a separate sub-
tab. Asyou build and change your query the results may change and

Statement Clzar Sorking
| SELECT DEPARTMENTS.DEPARTMENT _MAME, DEPARTMENTS MANAGER IOy,

Exerutiont... | 6/16/2003 4:13:35 PH Commit on STD 142 Al .
[Exenutiont.. 6/16/2009 4:16:24 P SELECT DEPARTMENT! il ‘== Graup By This Column

these changes can be viewed. g Statemnt  GIIETZ009 4:16:24 P 00000000 Query OX 1 i
|77 SELECT DEPARTMENTS.DERPARTMENT_MAME, DERARTMENTS MANAGER D, E Group By Box
. — | | Executiont... 6/16/2009 4:16:24 PM Cammit on SID 142
ot Sl inr Lata sualeats o [very Buldar Unodeds: | Executiont... 8/16/2009 4:33:48 PM SELECT DEPARTMENT:
Eile Edt QueryBuilder Create View Tools iindow Help \-@.Seamh Google =) | m‘ﬁtatament 6/16/2009 4:33:46 PM  0:00:00.000  Query CK 1 0 |
= = = — i | = BestFit
T z 3 (& I 1
1>Understand (2> Query (3~ Report (4> Automate Tools [ Diagram | query | Resuts |
Bl S i %7 |© DEB10G.PROD.QUEST.CORP (DEB)... || | i"EER Disgrammer 57 Datahase Explorsr .= Quary Builder |27 Editor | | *zTutor’\aI = Open Query % Run Query &1 Add 1o Project |
2222 EllEeRRs e G DU R R | @isendioRencri| ,12? Clear Filker
Navigation Manager v AR uery Builder Untitled3* >4 b x ! B
P I R i Resulk Sets | Messages | Explain Plan|
=[] Access Sebl Set2 Set 3| Setd| Sets i imi i
D,M,adsam,,.mam ligeil) > 2 |geialisit)isein) B The Explain Plan tab shows the optimizer execution plan. Advanced
[5/O Orads | | DEPARTMENT_NAME*  MANAGER ID | LAST NAME* | . . .
IR DEB 1 0G.PROD.QUEST.CORP (.. )W SQL users can use the explaln plan to manually tune their queries.
| Execdtive 100 Kachhar
[ | |Executive 100 De Haan | — - - -
Object Explorer | Project Manager | |l 103 Funad =% Query Builder Untltle.d3 ] - 4 koM
HR A AR |Finance 108 Greenberg || Result Sets | Messages | Explain Flan |
_ [l Purchasing 114 Raphaely _ || Explain Plan 1 |
E e e T |
& e ] o = il Gpen in Editor. Query cost [relative to the batch): 100002
T s Mz P me ||| Shieping 121 Friop P || |SELECT DEPARTMENTS DEPARTMENT_NAME. DEPARTMENTS MANAGER_ID. MANA
e ~|l||.|shinping 121 Kaufing alobal Where Clause... < 0 | Bl
[£} COUNTRIES | |Shipping 121 Wollman Global Having Clause. ., |
| |Shipping 121 Mourgos Croate Yiew,.. 4 . 1 [ﬁl
Sales 145 Russel T:; ’
|- Wisualize Query
| |sales 145 Partners :
|| Sales 145 Errazuriz MESTED LOOPS TABLE ACCESS @ FULL
|5ales 145 Cambrault HR.MANAGERS
sl Save
)l sotes 145 Zlotkey
<A | marketing 201 Hartstein | Copy
| Golumn | Datatype | Comment |~ | || Aezeunting 2 Higgins | Print
;;| @ || MM A+ = v X Record 1 of 18 3 o . 2
FIRST_NAME WARCHA... —— — Explain E 1: = 1
LAST_MAME WARCHA... Diagram | Query | Results | T - ol .t
| e =7 1w Plan As Data Table . .
ot S L ||| B Tutorial 5 Open Guery | 2 Run Query l'jAdd to Project ) Send 1o Report | EEE&?MSJTIQIM INDE: -Dggl_}_QIUDE EE»“N
- Preferences i . 10
autoConmt - @ &, _ | As M5 Graphic Plan [i]
nex As Plain Language Plan | [i]

As Graphic Plan
As Tree Plan

Animate Plan Steps
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Reverse Engineering

The Query Builder allows you to enter a SELECT statement in the
Query tab and reverse engineer it into a visual representation on the
Diagram tab.

Simply type or paste a SELECT statement into the editor on the Query
tab and click on the “Visualize SQL Statement” button to draw a dia-
gram of the objects and relations in the SQL.

B FUEBEBE b MeBOE-v-[2e ew)

“& Query Builder Untitledz* visualize the SQL statement in the Query tahL1 i

SELECT EMF.ENALME, ENF.JOE, BONUS .SAL,l DEFT.DMLHE =
FRON i SCOTT.EMP EMP
INNER JOIN

SCOTT.BONUS EBONIS
oM (EMP.ENAME = BONUS.ENAME] )
IMNNER JOIN
SCOTT.DEPT DEPT
COM (EMF.DEFTHO = DEPT.DEFTNO)
WHERE ( (EMF.ENAME = 'ALLENL']) OR (ENF.ENANE = 'HILLER'))
CRDER BY EMP.ENAME AGC

+| ~|ab
Query | Diagram | Results

B Tutorial 5 Open Query 25 Run Query <2 Add to Project @ Send to Reponrt

Existing SQL files can be opened in the SQL Editor and sent to the
Query Builder to be converted visually. This is an easy way to port
SQL into a common format to be used as a collaborative resource.

Cul L Y [
35 I @ w SIS = o)
mtsauenyiAuildenlintitiedy /l‘% Editor Mailinglist.s Send editor contents to the Query Builder {(Ctrl+D)

= JELECT Title, FIR3T, LL3T, Comp - - B B

[
E. FROM MailingList

& v Show MNavigatar

& v|  Show Script Resulks

z i
5 v|  Show Group Execute

m

ﬁ Read Only

=

s J‘ . I'gf: Send To Query Builder I N
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Some SQL syntax cannot be visually represented when reversed engi-
neered. When this occurs, a Global Where Clause object is used to
contain the logic of the clause. The Global Where Clause can be ed-
ited by double clicking on the object or clicking the Global Where or
Global Having buttons on the toolbar.

B BFEESEXb MEBEBR-OU-[H@@ .

.8 Query Builder Untitled2* 4Pk Xx
== ] == 7] =[] ~
(dd All Columnz) (dd All Columins) | (dd Al Solumins)
* fildeard) * (ildeard) | * (ldcard)
ENANE EMPNO 5 | DEPTND
ok ENAME =EMNAVE 4 ENAVE | 4
£ £ | Loc
oM MR

........... HIREDATE | pertHoOZDERPTMD
sAL |

coMM

DERTMNO |
Global Where Clause ]

[{EMP ENAME = "ALLENI) O, (EMP ENAME = MILLER)]

< >
e er e e

uery | Diagram | Resuls

e Tutorial = Open Query &5 Run Guery <8 Add to Project 0 Send to Report

Errors in the SELECT statement will be flagged in the editor and
added to the Output window.

Modeling Query X

é} The query cannot be modeled. You can execute the query withaut modeling it or correct the flagged problems to
continue.

DDn not prompt me again

Note: By default the Query Builder uses ANSI joins. Sending a non-
ANSI join query to the Query Builder will put the WHERE condition
into the Global Where Clause. If you change the join type to non-
ANSI join, make a change, and press the “Visualize query” action it
will build the query.

Query Builder



Advanced Query Builder Features Calculated Columns

Using calculated columns allows you to add extra columns to the
query that can contain anything from a simple calculations of two
columns to a complex case statement.

Freehand SQL Editing

SQL can be edited by hand in the Query tab. Simply type directly into
the Query tab editor. When complete, press the “Visualize” button to L f 3§ o0 e = T - ~ oY
update the Diagram tab. Use code completion to select from a list of i ji} gag t.i '% i 2 1[@ ' @ = Ij = N @
tables, columns, views or other objects without having to manually
enter the object's name in the editor. For example, you can enter the
first few characters of the column name and then press ENTER to
automatically

Clicking the Calculated Fields button opens the Calculated Fields dia-
log. This allows you to create a column alias and assign it to a table
object in the diagram. Simple calculations can be typed into the
“Field definition” edit box but for more complex calculations, the

.=, Query Builder Untitledz* " ., Query Builder Untitled3*

colmplete the o o coramaapy T COUMTRY_HAME down arrow can be selected to bring up a
column name. THNER JOIN formula editor with the same features as
HR.REGICNS REGIONS
OM [COUMTRIES.REGICH_ID - REGIONS.RESICM_ID) M field name found in the Where Condition d|a|og
WHERE Region +
(] COUNTRIES. COUNTRY_ID

EIFCOUNTR AME
[]] COUNTRIES, REGIGN_ID

Defined fields Press Insert key to accept . .
1 Theformula editor allows you to build an

e expression by selecting database specific
5 COUNTRIES REGIONID = REGIONS REGION 1D functions, operators, and columns and other

calculated fields from the current query.

Field definition

Note: Editing SQL by hand usually generates a Global Where Clause.

To add complex expressions to the where clause, use the drop-down Attach to toble Selecting the down arrow on the edit box

editor in the Where Condition editor. This is the best way to use mul- brings up a SQL editor with syntax highlight-

tiple AND conditions. == ing for complex expressions such as case
statements.

& Where Condition

Figld: "REGIONS"."REGION_NAME"

CASE country WHERM 'S' THEN ‘Americas’ WHEM 'AFghanistan’ THEM 'Asia’ WHEN ‘Albania’ THEM 'Asia’ WH[

Fomm | Formula |

| WHEM '7T3' THEW 'Americas' Fi
>

WHENM 'ifghanistan' THEN 'Aisia' Edlt calculated
REGICHS.REGION_WAME <> 'Europe’ = WHEN 'Llbania' THEN 'Asia’'
AND REGIONS.REGION_NAME <> 'Asia’ M I H I WHEN 'INGOLL' THEMN 'LAfrica! fields through
AND REGIONS.REGICH NAME <> 'Americas’ u tlp e WHEN '&nguilla' THEN 'lwericas'

WHEN 'intigus (barbuda)' THEN 'Americas’ the calculated
AN Ds VHEM 'irgentina' THEN ' hmericas' . .

WHEM 'latvia' THEN 'Europe’ fields dialog ac-

WHEM 'Cambodia' THEN 'Asia'

cessible from the

ELS.E 'Jon' 't care' [v]
d toolbar.
!
= | Save & Cancel oK Cancel
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Subqueries

Building a Subquery

Subquery, Inner query or Nested query is a query within a query. A
subquery is usually added in the WHERE clause of the SQL statement.
To add a subquery in the Query Builder, open the WHERE Condition
editor for the column used with the subquery. Choose the operator

type and select “Subquery.”

Navigation

content on the right.
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Query Builder Advanced Features

When a subquery is present, a navigation tool window appears on
the left side of the Query Builder. The main query and all sub queries
are listed in a tree view. Clicking on a node of the tree will display its

The subquery button brings up the subquery editor. This is best de-

scribed as a Query Builder within a Query Builder. Everything you
would normally do in a Query Builder can be done here to build the
subquery. Add tables from the object palette, join, filter or calculate
columns. You can execute the subquery to confirm the results.

Note: A subquery can be used for a column value. In this case use the
calculated columns editor and insert the subquery in the field defini-

tion editor.

Toad for Data Analysts

All subqueries are repre-
sented as Global Where
clauses in the diagram.
Double clicking on the
Global Where clause also
loads the content of that
subquery.
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Query Builder Advanced Features

Query Types Statement Operators

Statement operators can be used to combine two or more select
statements. The Statement operators that are available for the cur-
rent connection type are available from the toolbar or subquery navi-
gation manager.

The Query Builder builds many types of statements. Choose from
Select, Insert, Update, Delete, Create Table as Statement and View.
These types are available from the toolbar.

The Insert, Update and Delete statements use bind variables to ob-
tain the values at execution time. Enter your values into the bind 5 m

. ) . ]
variable window. You may need to change the data type of the bind ! =l -
to match the column data type. The Create Table and Create View L) Add Union
statements will prompt you for the name of the new database ob- 2y add Union ol
ject.
] 5 m ™1 Add Intersect
—  Add Minus
ﬂ Select Skatement
Insert Staterment
All statements combined with a statement operator must have the
IJpdate Statement .
same number of columns. These statements are displayed as sub-
Delete Statement queries and can be accessed through the subquery navigation man-
E Create Table As Statement ager.
B Create Yiew
¥/ Toad for' Data Analysts - [Query Builder Untitleds™] lL=1c3]
: & i Fle Edt OQueryBuider Yiew Took ‘Window Help |G| search Google =
“F‘\Ie E‘d\‘t guar.y Euilde: V\ew" Tnn}s Window  Help = ||| search Google a (I Understand | 2> Query | [3>Report (4 Automate Lols
‘ lj/ Understand | (2> Query 30 Report [& Automate cpE 1 k‘:# FEBEBS }Dn% [N S 5 AR N 5|+ Query Buider [ Edtor 4 Automation il
o = = e, o = - iz o 1 .. Query Builder Untitled5* +d b x|
lift % 13 85 e B ESI U (@ 3|+ ueryBuider [ Edtor 4] Automat i = I = ol
", Query Builder Unitleds* > 4bx (B4 3 || =/ query ‘ {add all Columns) g
o INSERT INTO HR.COUNTRIES [COUNTRY ID) = g =L vildcardy 5
3 VALUES (:COUNTRY_ID) ; Il & 23 ™ Intersect (= Add Subquery ARTMENT_ID 2
éw‘. g FH = Minus ) Add Union é
g '€ Bind Variables 5 é ) Add Union Al i
% | tame | Type Direction ‘ | a = ™ Add Intersect L
) E ] [ = 5 —  Add Minus
22' g Q0 hange Set Operator
b-3 =
%\ ] X Removs
:Z‘ E Increase Indent |
6% ok 7 pe— I -@ Decrease Indent
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Query Builder Tool Bar

RN 5 M. NN W e -, W T

The Query Builder toolbar has the following tool buttons:

Execute Statement - Press this tool button to execute the query.
You can also execute the statement using F9, the Run Query but-
ton on the Wizard Bar or from the right click menu.

Cancel Execution - During the time a SQL is executing, you can
cancel the query by clicking on this tool button. Canceling a query
can also be done from the Background Processes window.

Send to Editor - Use this button to send the current SQL in the
Query Builder to a SQL editor.

Arrange Tables - Auto arranged table to best fit in the Diagram.

Resize Tables - This button sizes the table to display the visible
columns. When working with many tables with many columns,
use the column manager in the ER Diagram to hide unnecessary
columns and then arrange and resize tables to best fit the tables
in the diagram.

Add Subquery - Adds subquery and opens subquery editor.

Calculated Fields - Use Calculated Fields to create a new column
that uses one or more fields and performs mathematical opera-
tions. The tool button brings up access to all existing calculated
fields for editing, deleting, or adding.

View Object - The Object Details window will display the details
for the currently focused table. The details window is equivalent
to the right hand side tabs in the Object Viewer.

Toad for Data Analysts
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==l TTO

100%s

slh

0w g &

L

~ | Zoom - Choose the zoom percentage.

Explain Plan - Generate an explain plan for the SQL Statement.
The explain plan is displayed in a tab of the results tab and
shows the steps the database will take to execute the query.

Options - The Query Builder has options such as adding table
name to each column, list order of table columns, and highlight
coloring.

Statement Types - Choose your statement type of Select, In-
sert, Update, Delete, Create Table As, or Create view.

Statement Operators - Combine statements using statement
operators.

Join Type - The Query Builder uses ANSI joins by default. When
you are connected to Oracle you have the option to use Ora-
cle’s join syntax.

Where Clause Editor - When you send SQL to the Query Builder
from the editor, all where conditions are contained in a Global
Where Clause object. This editor edits its content.

Having Clause Editor - Equivalent to the Global Where Clause
editor only applicable to having clauses.

Visualize Query - You can manually edit your SQL in the Query

tab. Push this tool button to update the changes in the Diagram
tab.

Query Builder



Collaboration

The Query Builder window contents can be saved to disk from the File
menu. The files have a *.TSM extension and retain the connection and
qguery information. In Toad for Data Analysts version 2.5 and above,
you have the option to also save the results.

Network Share - Establish a network share location. Set this path in
Toad for Data Analysts and save your SQL related files to this loca-
tion. See Options > Environment > Network Share.

ﬁ_ Double-clicking on the Query Builder file icon or opening
3 : ) . .
= from the File menu or Wizard Bar will load the data into a
new Query Builder so you can pick up from where you last left off. Version Control - Use version control to protect and back up your
SQL files. Version control is integrated into Toad. See Version Control
section for details.
Project Manager
Sample Project - 'v
= 0B Organization of all your Toad for Data
=) lagrams . . .
fﬂidwesspemegm,mr Analysts files can be done through using ER Diagrams - Build a library of tables that are most commonly used
ey Quest_Stage_Schema.ter .« . . . .
= - act i ; together. Add joins and annotation to describe how your environ-
afg‘a:géreSSeSFDrSmit?‘vW’\dEvar’\s.tsrﬂ a prOJeCt In the ProJeCt Manager tab' g J . y
] GrderserecterthaniooCalrs... See the Project Manger section for de- ment works with these tables. These diagrams can be used to edu-
E OrdersGreaterthan1000Dallars, sql . . . . .
selectedwarehuusessq tails. cate new users and is a vital reference in working with tables. You
e e et 3 can send these diagrams to the query builder and the tables and re-
@_] AddressPerRegion.xls . o
) InventoryCountyWarehause i Files can also be checked in and out of lations can be used as templates for new queries.
or] CustomerList kdr
ItemsPer'darsH: ko 1 H .
&-:_’J::::;of;::t;f g the following version control systems:
AT Terfo Lt -weekly Microsoft Visual SourceSafe, CVS, Sub-
version, Microsoft TFS. Query Builder - Query Builder files can be used for executing results

and used to build reports. The Query Builder results can be used to
build the following report types: Microsoft Excel, Toad Data Reports,
Toad Charts, and Toad Pivot Grids.

Much can be said regarding the use of shared resources. Working
together as a joint intellectual effort saves time and money. Toad for
Data Analysts recommends the following to enhance your groups
SQL collaboration.

Automation - Recurring reports can be scheduled to be executed,
exported, and emailed to recipients.
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Heterogeneous Queries

You can add tables and views from multiple databases to create a
qguery that combines the generated results. To build a heterogeneous
query, add a table to the Query Builder. Double-click on another con-
nection, giving it focus. Add a table from this connection. When you
have two or more tables from different data sources, the Query
Builder will display a “Heterogeneous Query” watermark.

Fle Edt  QueryBuidsr View Took Window Help

1Understand (2> Query (3> Report [ Automate Tools
= [f 43 2 > 100% ~| B E] R~ o = Pl il |7 Edtor i
Navigation Manager vax .. Query Builder Untitled1™ >4 b x|
e b it I Al ] o]
3 COUNTRIES |

=/ Oracle
4" DEB10G (DEE), HR:

Object Explorer  Project Manager

D:\Program Files\Quest Softwarel [« || 7+

Table

285

(., sesrch Gaogle a

* pyifdcard)

REGION_ID

(add Al Columns)

|
I

i

[Py |

A
Query | Database

il

Name.

] ADDRESS

(] comract

(] cusToMER:

] DELETED_ORDER_ITEMS
| DELETED_ORDERS

] mmem

(7] oRDER_ITEM

(7] ORDERS

Te

Database

Only Fetch Lrique records

EGICH_MAME

D:\Program Fil..

Top row count:

REGION_ID = REGIOH_ID

{ixdd &l Columns)
* (widcard)
COUNTRY_ID

‘:/_COUNTRV NAME

LIE 5

Sassad014 pUNo.CIEg

Aggregate Function

‘Where Condition

O |

(] WAREHOUSE
[ ] WAREHOUSE _ITEM

Group By

Having Condtion

| sart

T ——

Cronnection Mana. .| 8 Mavigation Mana. ..

@ AutoCommit >

) None:
) Ascending

Diagran | Guery | Results

B Tutorial

~iNone
() Aisending

(= Open Query = Run Query <) Add to Project () Send to Report

7] Toad Sample Database ~

Consideration/
Limitation

Description

Access database used
for building heteroge-
neous queries

The Query Builder uses the Microsoft Access data-
base installed with Toad. Do not uninstall this data-
base if you need to run heterogeneous queries.

Performance concerns

A heterogeneous query may take longer to execute
then a query against a single database because result
sets from each database are retrieved and combined
to generate a single result set. Also, ODBC data re-
trieval is slower than using a native database client.

ODBC driver support
for native database
provider connections

You can select a specific driver to use for heterogene-
ous queries when connected to a native Oracle,

SQL Server, MySQL, or Sybase database provider in
Tools | Options | Database | NativeDatabaseProvider.
This is a global change that affects all connections
that use this provider. To specify an ODBC driver for a
single connection, right-click the connection in the
Navigation Manager window and select Properties.
Select the Advanced tab to choose a driver.

Supported join types

You can only create inner and cross joins

Subqueries are not
supported

You cannot create a heterogeneous subquery.

DB2 client connections
are not supported

You cannot create a heterogeneous query from a
native DB2 client connection. Instead, connect to the
DB2 database using an ODBC connection, and then
create the query.

Multiple Excel connec-
tions are not sup-
ported

You cannot create a heterogeneous query between
two or more Excel connections.

When working with heterogeneous que-

ries, you can determine the connection
associated with each table or view by plac-
ing the cursor over the table name in the
Diagram pane. (See picture to the right.)

Toad for Data Analysts

© COUNTRIES
(add All Columns)
* (Wildcard)
COUNTRY_ID
| COUNTRY_MNAME
W REGICH_ID

ME3

HR.COUNTRIES

Combining Access and
Excel queries is not
supported

You cannot create a heterogeneous query between a
Microsoft Access and Microsoft Excel connection.

oesyResult sets cannot be

Connection: DEB10G
g

edited

You cannot edit result sets.
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Query Builder Exercises

Exercise 1

Purpose - To demonstrate how to build a query with an aggregate
function, group by and field alias.

Scenario - You need a report that produces the quantity of items on
hand for each warehouse.

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking the
Navigation Manager.

2) Select tables WAREHOUSE and WAREHOUSE_ITEM, right-click
and click “Send to Query Builder.”

3) Select warehouse_name and current_quantity columns.

4) Select the aggregate function of Sum on the current_quantity
column.

5) Add a Field Alias name of "Total Quantity" to current_quantity
column.

6) Click the Group By cell on the warehouse_name column.

7) Click “Run Query” on the Wizard Bar.

Exercise 2

Purpose - To demonstrate how to build a query with a calculated
field and date range.

Scenario - You need a report that lists the retail totals for each order
in the last quarter.

Toad for Data Analysts
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Note: To change the dates in the sample database orders table exe-
cute this or a similar query in the editor. Change the number of days
(1095) to adjust the number of days to update. The exercise filters on
current quarter. If you do not have any orders with dates in the cur-
rent quarter, you will not get any rows returned.

UPDATE ORDERS
SET ORDER_DATE = order_date + 1095;

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking in the
Navigation Manager.

2) Click on Tools | Query Builder to open a new Query Builder. Add
tables orders, order_item and item by dragging them onto the
diagram from the Object Explorer. Joins are automatically
drawn.

3) Choose Order_id and Order_date columns from ORDERS table.

3) Add WHERE condition on Order_date to show dates for the cur-
rnet quarter. Do this by clicking on where condition cell of or-
der_date. In editor, select Current Quarter on the Date Range
tab. Execute and determine that you have row data.

4) Add calculated column that sums the order_item.quantity *
item.retail_price. Click on Calculated Fields editor on toolbar.
Enter new field name and click the plus sign. Click the drop
down button for field definition. Enter sum
(ORDER_ITEM.QUANTITY * ITEM.RETAIL_PRICE). Click “OK” and
select a table from the “Attach to table” dropdown.

5) Click the Group By cell for order_id (1) and Order_date(2).

6) Click “Run Query” on the Wizard Bar.

Query Builder—Exercises



Exercise 3

Purpose - To demonstrate how to build a subquery and use bind vari-
ables.

Scenario - You need a report that lists the customers whose con-
tacts are in a specific region specified by the user.

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking in the
navigation manager.

2) Open a new Query Builder by clicking on “(2) Query” button at
the top of the application.

3) Add the CUSTOMER table to the Query Builder. Select Cus-
tomer_id and Customer_name.

4) Click on the WHERE condition for customer_id. Select the IN
operator and press “Subquery.”

5) Add CONTACT and ADDRESS table. The join is automatic.

6) Check the region_id and customer_id column. Click on the

WHERE condition for the region_id column. Add = 1 to condition.

7) Deselect the visible property and run the query.

8) What if you don’t remember what region 1 is? Select the re-
gion_id column in the diagram. Right-click and choose look-up
table. Press “Yes” and “Apply Lookup Value.” Now go back to
the WHERE condition for region_id and use the dropdown. Now
the text value representation of the regions is listed. Choose a
different region and execute.

9) For a user to enter a value, change the query to use a bind vari-
able. Do this by invoking the where condition editor for re-
gion_id and replace your constant with :a (colon is the symbol
for bind followed by a bind name). Execute the query. Enter
avalue when prompted.

Toad for Data Analysts
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Exercise 4 (Note: This example uses the SCOTT schema of Oracle.)
Purpose - To demonstrate reverse engineering SQL.

Scenario - You have SQL that you use often and would like to convert
to Query Builder files.

Exercise Steps:

1) Connect to an Oracle database (9i or above)

2) Open aSQL editor and type in this query:

select * from DEPT, EMP
where dept.DEPTNO = emp.DEPTNO
and DEPT.DEPTNO = 10

3) Execute the query to confirm it is a valid SQL. If you get an error,
check your syntax or change the schema in the editor to SCOTT
by choosing SCOTT from the dropdown toolbar. Also, check your
connection. To switch connections in the editor, click the down
arrow at the bottom right of your application. Select the connec-
tion you want. This changes the connection to the editor and the
global connection.

4) Press the “Send to Query Builder” button. Run the query.

5) Notice that the query has no joins and all WHERE conditions are
in the Global Where Clause. This is how a query looks when
there has been difficulty reverse engineering it. It still can be
stored and used in the Query Builder, but the visual aspects are
not complete.

6) Click on the ANSI SQL tool button. This changes the join prefer-
ence to non-ANSI. Go to the Query tab and type a space. Press
the “Visualize Query” button. (The space triggers a change which
enables this button.)

7) Go back to the diagram and note that the joins and where condi-
tion are now visually drawn.

8) Save the query file. Note: The ANSI SQL button will retain your
last setting. Toggle on and off as needed. This is only available on
Oracle connections.

Query Builder—Exercises



Exercise 5

Purpose - To demonstrate how to build a heterogeneous query.

Scenario - New managers are assigned to each region. Their names
are only available in a Microsoft Excel spreadsheet. You need a re-
port that lists regions and their new managers.

Exercise Steps:

1)

2)

3)

4)

5)

Create a new Microsoft Excel worksheet with the following data.

REGION_ID MANAGER_ID

1 200
2 201
3 203
4 204

In Microsoft Excel, create a named region. (Click on ‘Region_ID’
Cell, hold Ctrl key, and click on last Manager ID). Create a named
region from the Insert | Named | Define menu action. Name the
table NewManager. Save and close Microsoft Excel file.

Connect to the Microsoft Excel file. Click on “New Connection”
and choose the Excel type. Navigate to the file just created. View
the NewManager table in the Object Explorer. If you do not see
it, recheck step 2.

Open a Query Builder and add the NewManager table to the
diagram.

Connect to Oracle and select the HR schema. Add the REGIONS
and EMPLOYEES table. Notice the background of the Query
Builder now displays the watermark ‘Heterogeneous Query’.
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6) Add joins by dragging NewManager.region_id to re-
gions.region_id and employees.employee_id to newman-
ager.manager_id.

7) Select the following columns to display: Regions.reigons_id,
regions.region_name, Employee.First_name, Em-
ployee.Last_name

8) Execute query.

Note: Heterogeneous queries are performed by using ODBC con-
nections to each database. If there are any connection failures, de-
bug by testing a ODBC connection to each source.
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Query: SQL Editor

The SQL Editor gives you full control over your queries. Whether you
start with a blank page or open a saved query, you have full control
over the query (or queries!) that get executed. This section will intro-
duce you to all of the features and show you how to get the most out

Navigation

The SQL Editor supports both a single statement
as well as scripts, or groups of statements. Often
when a scripts gets long, it can be hard to find
certain places in the code. This is where the Navi-

Tip: A statement is de-
fined as a distinct, com-
plete unit of SQL code.
Multiple statements may

of the SQL Editor. gator can be useful. Double-click to jump to that be grouped together to
statgment. Hold your mouse over a statement to 5. 5 scripr as Jong as
Layout see its contents. they’re separated by a
The SQL Editor is split into two main sections: the edit pane (upper) 73 editor untitieds* | delimiter. On the Oracle
and the results pane (lower). The edit pane has two tabs that are Navigator v & X ITEM. ITEM_ID, platform, this is a semi-

o

DELETED CRDER ITEMS.QUANTITY,
ITEM.RETAIL PRICE
FROM ((((QUEST_STAGE.DELETED CRDERS DEL
INNER JOIN QUEST STAGE.DELETEL
CN (DELETED ORDERS.CRDER ID =
INNER JOIN QUEST STAGE.CONTACT

colon while SQL Server
uses the word GO.

docked to the left: the Navigator and Group Execute. The results
pane has four tabs: Result Sets, Messages, Explain Plan and Pivot &
Chart. These together make up what we call the SQL Editor.

= Select 181!

= H M EEONTRCT COMTRCT Th = DELETE
-, Select SELECT CONTACT.CONTACT_ID, RDERS OF

g _— - = Select  CONTACT.LAST_NAME, L
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Fodc INNER. JOIN QUEST _STAGE.CONTACT CONTACT
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= T 3L Server -3 4

£ RIVI0S 5%, prod.oued. "
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When building a query, the
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When working with long scripts, whether it’s a single statement or
many, you can use regions to set up collapsible sections of code. This

will help you organize the SQL into logical parts and aid in navigation.

A region is recognized as a comment to the database, so you don’t
need to worry about breaking your query by using them.

To create a region, you need to define a beginning and an ending. To
begin a region, type --region; to end a region, type --endregion.
Any text that follows your region tags will be treated as a comment
by the database and will become the “name” of your region. You can
also nest regions within one another.

——region This is a test
SELECT COMTACT.CONTACT_ID,
COMTACT .LAST NAME,
COMTACT .FIRST_ NAME,
LDDRESS.S5TATE,
ADDRESS.COUNTRY,
CRDERS.ORDER_ID,
ITEM.ITEM ID,
DELETED ORDER_ITEMS.QUANTITY,
10 ITEM.RETRIL_PRICE

R T T S O

o

WHERE (ARDDRESS.COUNTIRY = 'U3'"):

——endregion

S

LS

You may also note in the image above that there are line numbers in
the editor. This is a configurable option (EDITOR > General).

Readable code is easier to understand and maintain. The editor also
supports customizable formatting to help you keep your code read-
able. To format your code, use the button on your toolbar or right-
click in the editor window.

If you regularly skip between places in your code, you can use book-
marks to help you navigate quickly. To set a bookmark, use
CTRL+SHIFT_[number] where you use a number between 0 an 9. To
move to a bookmark, use CTRL+[number]. These are also available
from the right-click menu.

Toad for Data Analysts

Editor Untited1* /[ Editor Untitled2*

Coding Shortcuts 1 select - fxom |

Lo TADDRESS
Code completion is a feature of j'ADDRESS_ARCHNE
the editor which pops up a list of ] CHAR TEST
items to choose from as you = CONTACT
, . ] COURSES_TBL
type. As you’re typing your SQL , ] CUSTOMER

] DELETED_ORDER_ITEMS
] DELETED_ORDERS

] HR_MAMAGERS

] HR_MAMAGERS_OLD

it will suggest table/view names,
column names and other rele-
vant objects. Instead of typing

m|»

these out, pick one from the list.

If you find yourself typing the same thing over and over, Code Snip-
pets will be an invaluable shortcut. Code Snippets are small code tem-
plates that you can insert into your code to save time. Once you in-
sert one, you can use the TAB key to move between the fields that
need to be filled out. There are many pre-configured Code Snippets
that come with Toad for Data Analysts, but you can add your own.
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1; s=elect |Insert Snippet: Analytic Functions >

To insert a snippet, right-
click on the editor surface

j and navigate to Snippets >

2 nile Insert snippet... You'll be

j ::iint_rank_analyti( || presented with a list of snip-

2 percent_rank_analytic2 pet categories to choose
from. In the example to the

2 max2 -

2 percentile_cont2
= percentile_disc2

2 rank_analytic -| left, I've chosen Analytic
Functions.
ditor Untitled1* _é Editor Untitled2*
1 select MEDIAN (Bhg) OVER(guery partition clause)

Once you select your snippet, it gets inserted into the code and the
first field required is selected. Simply begin typing and use the TAB
key to jump to the next field.

Each snippet includes a small description, which is very helpful when
trying to insert various functions which you may be unfamiliar with.
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To create a new snippet, open the Code Snippet window by navigat-

ing to VIEW > Code Snippets. This will open a new docked window on
the side of your editor. You'll notice that the snippets are all arranged
by database platform and then by cate-

To finish things up, click on the Test tab at the top of the window.
This will place the snippet into a mini-editor for you to try out. You
can TAB between the parameters and type over them to fill things in.
You can also see how your tool tips are

@ Snippet Properties: Table.snippet

ory, so you'll need to determine the
gory y Design | Test

=x5

being used. If you're satisfied, click “OK”

best location for your new snippet.

. . . . 1: CREATE TAELE $namef AS
Once you figure this out, right-click on YW coble definitionSh
that location and choose “New Snip-
pet.” Name your new snippet and
you’ll be presented with the editor.

To begin, type the structure of the
statement you want to become a snip-

Pl

Properties | Parameters

and you're done.

To use your new snippet, select it from

the right-click menu like any other snip-
pet. If you need to make any changes to
it, right-click on it and select Properties.

We've discussed “expansion” type snip-

pet. In this example, I've defined the Ttle:

shorteut: pets, but there’s also a “surrounds”

two parameters (aka “fields”) by sur- [Table

| [rabe ‘ type which let you literally surround a

rounding them with $ symbols.

Description:

highlighted

e i W W g W O iy
»

Inserts a CREATE TABLE stub staten|

With your statement complete, fill in
the properties of the snippet. The de-

Fl

Parameters

of 2

e » [ ]l

scription is important because it pops Author:

up as a tool-tip when you're selecting |Quest softuare

the snippet and can help you recall

Identifier: Default value:

‘table_deﬁniﬁon | |tab|e_deﬁnih'on |

what the snippet actually does. The

help URL can be any website or intra-
net site that would be helpful to refer-

ence when you’re in need of a little aid.

Next, switch to the Parameters tab. This is where you make
your parameters official. Start by clicking on the green “+”
symbol to create the first parameter. Type in the identifier,

which should be the name that you’re already using in the editor. The
default value should be relevant to the user because this is what they
will see. Lastly, give the parameter a tool tip to help when you’re ac-
tually using the snippet. Repeat the process for the other parameter.

Toad for Data Analysts

Help URL:

|ht1:p:..".."'A"A"N.orafaq.com,."wikifSQL| Tooltip:
Insert your column information here -
Editable
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block of code
with that snip-
pet. For in-
stance, Toad for
Data Analysts
comes with a
surround type
for commenting
out a block of
code.

To create this
type of snippet,
follow the same

steps but change the Snippet Type to “SurroundsWith.” Use a pa-
rameter of Sselected$ to denote the selected code to be surrounded.
Then anything before or after your SselectedS parameter will be in-
serted into your code when you use the Surround With snippet.
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Last, but not least, is the Add Application Code feature. This feature
will take the contents of your editor and format it to be used within
your application code. For instance, if you’re building a Java applica-
tion and the query you’ve just written will be used in it, the Add Ap-
plication Code feature will format the SQL into code usable in Java.

Execution

There are several different methods to execute queries in Toad for
Data Analysts: a single statement, as a script, the selected text and in
an external application. Lets begin with a look at the toolbar.

To configure the feature, open the Toad for Data Analysts options
window and navigate to EDITOR > Application Code. You can select
between C#, C++, Delphi, Java, Perl and VB.

Toad for Data Analysts
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£ Editor Untitled2* d4b | ‘ . | E
: ; UEST_STAGE -
1 SELECT CONTACT.CONTACT_ID, EF @ ]ID @ Q - Q
2 CCONTACT.LAST NAME,
3 CCNTACT.FIRST_ NAME,
4 LDDRESS.S5TATE,
5 ADDRESS . COUNTRY,
& ORDERS .ORDER_ID, ; - 1) Execute as a script (F5
7 ITEM.ITEM ID, = Editor Untitled2* L . i (d ).” d hing in the edi
: DELETED_ORDER_ITEMS.Q § 1 St:;;iﬂisLCZNTAET commace 1D ey This execution method will send everything in the editor
3 ITEM.RETAIL PRICE z : ) CONTACT . LAST HATES ,',_,,\rtnf?_ to the database, beginning at the top. If there are multi-
10 FROM UEST STAGE.DELET = ) = ! . . .
o L (qum_:om —— 4 " CONTACT.FIRST NAME,"-"\r\n"+ ple statements in the editor, each will be executed and
12 ON (DELETED ORDER & 0. ﬁgﬁggiﬁ;ﬁm'frt:\;_ the result of each will be displayed on a separate tab in
13 éﬂnfioggigrggizigi g 7 " ORDERS . ORDER_ID,""\r\n" the Result Sets tab.
- < : = 8 " ITEM.ITEM ID,"+"\r\n"+ .
15 INNER JOTN QUEST ST S B DRLETED OEDER TTEMS. GEUANTITY, +*\r\n®+ 2) Execute selection or current statement (F9)
16 OH_{ORDIERS.. CONTACT 10 " ITEM.RETAIL PRICE"-"\r\n"- With this method you can select a block of SQL code and
11 " FROM ((((QUEST_STAGE.DELETED ORDERS DELETED ORDERS' . P . .
- . THHFR JGTH GURST STACE.DELETED OBDER ITFM: only execute that piece. This is useful in many cases;
13 " ON (DELETED ORDERS.ORDER ID = DELETED OrRDI for example, when you want to execute and verify the
14 " INNER JOIN QUEST STAGE.CONTACT CONTACT"+"\1 _ . .
i . ON (CONTACT.CONTACT ID — DELETED ORDERS.COl results of a sub-select. Using this method, you can also
1a " INNER JOIN QUEST STAGE.ORDERS ORDERS"-+"‘r\n'

execute the statement located next to your cursor.

3) Execute from cursor

Slightly different from the previous method, this method will not
stop at the end of the current statement, but continue to the end of
the script.

4) Execute in an external application

This will open your SQL code in another application for execution. It’s
useful for scripts with command line instructions (like SQL*Plus).

5) Current schema/user

This is set to the currently connected user, by default. Choose an-
other schema/user to set as current. When the SQL is executed, non
schema referenced objects will try to resolve to this schema first.

6) Cancel

If your query is running too long, use this button to cancel.

SQL Editor



Group Execute (Advanced)

In certain cases, it can be useful to execute your query against more
than one database. This is not to be confused with creating a hetero-
geneous query for joining the results from multiple databases
(covered elsewhere in this document). Group Execute will open two
or more connections to the same database platform and execute
your SQL code against each connection at the same time. For in-
stance, you can use this to run a query against a production Oracle
instance and a test Oracle instance at the same time and then com-
pare the results.

The Group Execute window is docked on the left of the SQL Editor
window underneath the Navigator window, by default. Once open,
you can select a connection platform and see a list with all of your
saved connections for that group. Simply select the two (or more)
connections you want it to execute your SQL against and execute as a
script or as a single statement.

Once the query finishes, the results will display in the standard Result
Sets tab. Selecting another connection in the Group Execute window

will switch to the /m

results from that (7] Enable Group Exeaute 1i SELECT CONTACT.CO
connection. - 2 CONTACT.LA
O Orade = 3 CONTACT . FI
. X Connection Status 4 LDDRESS.ST
Keep in mind 5 O] orade 5 LDDRESS.CO
that USing fu”y - [#] ¥E (Quest_Stage)... Success —'5 ORDERS . ORD
i G [v] XE (DAMIEL), Que... Success I ITEM.ITEM
qualified names 2 DELETED OR
for the objects in 2 ITEM.RETAI
10 FROM ( (((QUEST

your query may 11 INNER
be necessary 12 ON (DE
h ti 13 INNER J
when connecting 12 on (com
with dissimilar 15 INNER JO
credentials. 18 ON {ORDE
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SQL Recall

Before we move on to talking about result sets, you should know
about SQL Recall. This feature of Toad for Data Analysts keeps a run-
ning history of all SQL that has been executed. By default, Toad for
Data Analysts will keep track of the last 100 SQL statements, though
this is a configurable option. Look for it in the Options window under

EDITOR > Tools.
SQL Recall

Each SQL statement that F | X |E -

you execute, regardless of

your execution method, Exeasted | Named |

will be represented here. SQL Text Connection
Additionally, the connec- »
tion that it was executed

against is also displayed, to

help you find your SQL.

SELECT mo AS "Month”,

SELECT Address_Table, ADDRESS_IC| test excel
SELECT ADDRESS.ADDRESS_ID

In cases where you’re hav-

SELECT CONTACT.CONTACT_ID, {E {Quest Stage) - L
XE (DAMIEL) - Direct
delete from LEADS where mo ='2... | XE {(DANIEL) - Direct

.Toad Sample Database
SELECT count (case_id), count {subc:| XE {(DAMIEL) - Direct

. . SELECT stage, XE {DANIEL) - Direct
ing trouble finding a par- : P

. . SELECT prod_category AS Product, | XE (DANIEL) - Direct
ticular SQL, consider nam- i I

o SELECT = XE (DAMIEL) - Direct
ing it. Named SQL, the sec- = =

4 tab in the SQL. Recall SELECT = XE (DAMIEL) - Direct

or.n tabin the Q eca SELECT = XE {DAMIEL) - Direct
window, works like Favor- o YE (DANIEL) - Direct

ites in your internet
browser. Right-click on a
SQL statement and select “Move to named.” This will move it over
and give you the option to give it a name. Now that your favorite SQL
is named, double click on it to add it to the current SQL Editor win-
dow. Be careful though; double-clicking it will insert it at your cursor
position. So if you want to insert it into a
script, either set your cursor carefully or
choose “Copy” from the right-click menu.

SELECT mo AS "Manth”,

Tip: SQL Recall is a dock
able window . To display
use the View menu. To
move drag to any dock-
Iing location.

XE (DAMIEL) - Direct

SQL Editor

m.




Results

Working With Results

The result of your queries will be displayed below the editor window
in the Result Sets tab. Each executed statement will have its results
displayed in a separate tab. However, if you execute a script with sev-
eral statements, you will have a single result tab with a navigator win-
dow attached to the left.

Result Sets |Message5 I Explain Plan I Pwot&chart|

Set1|

aalll Orag a column header here to group by that column

2: SELECT * FROM DUAL

|@

CONTACT_ID *  LAST_MAME™  FIRST_MNAME ™  STATE COUNTRY * ORDER_ID*  ITEM_IL
» 2451 | Lindegreen Mola VA us 9838
K 2451 | Lindegreen MNola VA us 9838
2451 | Lindegreen Mola VA us 9838
2451 | Lindegreen Mola VA us 9838
2451 | Lindegreen Mola VA us 9838
2451 | Lindegreen Maola VA us 9838

Kl 2451 | Lindegreen Mola VA us 9838

Right-dick to add column totals.

[ 2

Bl el e e

Record 1 of 361922

From within the results tab there are several options for working with
your data. You can export it, copy it, change it, group it, sort it or just
simply view it.

To edit your data, click on one of the cells. If you changed the default
configuration, you may need to double-click on a cell. As soon as you
exit a cell, your edit will be posted back to the database. Each data
type has its own miniature editor, so that when you’re editing simple
CHAR data, you'll have a text editor but when you have a DATE data
type you'll be presented with a calendar popup. So regardless of the
data type you’re working with, you’re covered.

To export your data, try using the One-Click Export buttons on the
toolbar (also available from the right-click menu). These allow you to
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export your data to several pre-defined formats with a single click,
saving time.

1) Export data to an Excel file
This button will send the contents of
the active Result Sets grid straight to

R RS~
a Microsoft Excel file with three dif-
ferent file type options: XLS, CSV and

&'
HTML. A dialog will appear after the

results are saved with a link to the location of your new file.

2) Export data to an Excel instance

In contrast to the previous button, this button will send the data to
Microsoft Excel and open the document. It’s a bit of a shortcut over
the pervious button if you know that you’re going to work with the
data afterwards. If you click on the downward-pointing arrow to the
right of the button, you’ll have an option to send the data to a spe-
cific cell in an already open Microsoft Excel document. So if you want
to insert your records to cell D:7 of your Microsoft Excel document,
this is the option for you. Just make sure you have that cell selected
before you click the button!

3) Export data to an Excel pivot table

This is a nice shortcut for getting that pivot table started. Note that
you can also choose to create the new pivot table beginning at a cer-
tain cell in your Microsoft Excel document as well.

4) Export data to an Excel linked query

You may find that its more convenient to distribute your data via a
refreshable Microsoft Excel file; unfortunately, it’s not always easy to
set that up in Microsoft Excel. With this button, you can bypass a lot
of that setup and let Toad for Data Analysts configure it for you. Your
query, connection information and the initial data from your query
will be sent to Microsoft Excel. You may notice that you still have the
options to send it to an active cell, or a pivot table as well.

SQL Editor



Copying Data
Copying data from the grid is fairly straightforward, though there are
a few options to consider.

From the right-click menu, you’ll notice there are two options: Copy
Rows and Copy Cells. The standard copy method (supported by the
Windows hotkey CTRL+C) is to Copy Cells. Begin by selecting one or
more cells and then choose Copy Cells form the right-click menu.
Keep in mind that Toad for Data Analysts supports the ability to multi-
select several non-contiguous cells, giving you great flexibility in copy-
ing only the data you’re interested in. To multi-select, hold the CTRL
key while selecting cells.

Similar to Copy Cells, the Copy Rows option will copy the entire row
for a selected cell.

Once you choose one of these options, you'll be presented with this
screen below. These options will give you further control over how
your data is copied. If you always choose the same option, check the
“Do not prompt me again” checkbox to always use that option. You
can reset this dialog later from the Options menu.

Toad for Data Analysts Beta

| — -

|:| Do not prompt me again

How do you wantto format copied grid data?

(@ Mo headers, tab separated text
(71 Indude headers, tab separated text

" Mo headers, insert statement or in dause formatted text
() Include headers, insert statement formatted text
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“Send To” menu Copy Rows
This menu gives you quick links Copy Cells

to get data into one of several 2 print..

Toad for Data Analysts report- -

ing tools. These tools are cov- Export 3
ered elsewhere in this docu- Quick Export »

ment.

Show ¥ | [jh DataReport Designer...

Working with Data
d1 Chart Designer...

The Toad for Data Analysts data
grid is the same grid that’s
found in the Database Explorer
and therefore has all of the
same great features of grouping, sorting and summarization. See the
Database Explorer section for more information on these features.

Compare Te »

Read Lobs | Pivot Grid...

Row Count

Send to Report

Below the Result Sets tab, is the Wizard Bar. The Wizard Bar is a sug-
gestive shortcut toolbar that changes based on context. In the case of
the SQL Editor, it offers options to learn how to use the SQL Editor,
open files, execute files, add the current file to a project and send the
data to a report. This last button will send the data to a Microsoft
Excel file which is opened /inside of Toad for Data Analysts (by de-
fault). This makes quick tasks like saving data to a Microsoft Excel file
for quick distribution via email extremely simple.

Toad Editor Files

When you save your SQL query, you can save it as a simple *.5QL file
or as a more advanced *.TEF file. The Toad Editor File (*.TEF) offers
the ability to save the results of your query with the query itself. As
opposed to a *.SQL file where you merely save the SQL code itself,
the *.TEF file will (optionally) remember the data of previous execu-
tions in addition to the SQL code. This can be useful for comparing
the results of a query over time. Simply open the *.TEF file and exe-
cute it again to see the new results in a new tab, on top of the results
of your last query execution.
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Messages & Explain Plan Tabs

Query - SQL Editor

Results

ug x

These tabs are covered in the Query

| Resuit Sets | Messages | Explain Plan | Pivot & Chart [

Builder section under Query Execution. Tpelfr |7l &

Pivot & Chart Tab =] A

Standard Pivot tables and charts are cov- — ol &

ered extensively in the Data Reports sec- AL $126.00 §407.44) | Drag Items to the Pivot Grid

tion. What’s unique about this tab is that ca $256.00 10433.77 CONTACT_ID

you don’t need to export your data to a ; zz:zz ;:g;:: FIRST_NAME

separate window. Here in the Pivot & - S ol ITEM_ID

Chart tab, you can see the direct results ks _ $753.00 31767.99 LAST_NAME

of your query represented in these forms. K : e

This can be very useful as you analyze - . | e e

data during the process of refining your Ne 5150.00 9308.83 s

query. NY §162.00 7688.04 .

£ +am Sk L AL CA FL GA IL KS KY MI MN NC WY OH PA PR SC TN YA
With all of the data fetched from the database, you can now open the
R Gl (comurye coners il (o Pivot & Chart tab. Creating your pivot and chart is as simple as select-
va___|us 9838 To get the data into the tab, ing items from your Pivot Grid Field List and dragging them onto the
- ":;py Ro:f zzi :simply open it. If your query pivot grid surface. With all of your data arranged in the pivot, the
— Eopy _— P is paused (probably because chart will automatically update. You can switch the chart type to pie,
15 prin. e you changed .the default op- line, bar and more from the dropdown menu.
P FEg tion and applied the thresh-
| Beport g o3 old to the SQL Editor), then
m 5838 you'll need to finish running
| i:’;:’m : 9838 the query, first. To do this,
_| C:Jmpare o, z:i right-click on the data in the
e [ Result Sets tab and click
Read Lobs 4 &9838 “Read all Rows.”
| Row Count &7
| Reed AllRous | .
] ecord 2 of 1000 (scroll for more)
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Editor Exercises

Exercise 1

Purpose - To demonstrate how to use the SQL Editor.

Scenario - You know SQL pretty well and need to build a query and
validate the results quickly.

Exercise Steps:

1)

2)

3)

4)

5)

6)

7)

Connect to the Toad Sample database and open an editor using
the standard bar tool button or from the Tools menu.

Type “Select * from” followed by Ctrl+ Period. This will give you
a list of tables from the current connection. Select the ADDRESS
table.

After selecting the ADDRESS table add an alias name of “a”. Your
SQL should look like this —> “select * from address a”. Replace
the wild card symbol “*” with the alias “a” followed by a period.
This will display all the column values available for the column
list. Choose a.address_id.

Your SQL should look like this —> “select a.address_id from ad-
dress a”. Press F5 and view your result set in the grid.

Add a semi-colon to the end of the SQL statement. On a new line
create a similar SQL statement querying from the contact table.
End the statement with a semi-colon.

Press F9. Notice that you now have a second result set contain-
ing the contact table rows. Press F5. You will now have a single
result tab containing two result sets. Depending on what you are
working on, each execution type will be very useful.

Select the orders table from the Object Explorer. Right click and
choose Generate SQL | to Clipboard | Select statement. Paste
into the editor.
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8)

9)

10)

Format the SQL by pressing the Format SQL tool button or right—
click action.

Click on the editor’s Navigation window. It may be minimized. If
so, find the word Navigator written vertically on the left side of
the editor. (Not the Navigation Manager.) Click on it and it will
expand. To pin it, push the pin icon. There will be a keyword for
each statement listed; for this exercise there will be 3 selects
listed. Double-click on the middle one and notice that it will
move your curser to that statement.

Click the “Add to Project” wizard button at the bottom of the
editor. Enter the name “Sample.” This will save the file and add
to the Project Manager.

SQL Editor—Exercises



Exercise 2

Purpose - To demonstrate how to use some advanced features of the
SQL Editor.

Scenario - You know SQL pretty well and need to build a query and
validate the results quickly.

Exercise Steps:

1)

2)

3)

4)

Connect to the Toad Sample database. Open the sample.sql script
from the last exercise by double clicking on it in the Project Man-
ager.

From the View menu, choose the Code Snippets action. This will
display the code snippet docking window. Expand the SQL (ODBC)
| Generic Templates and double click on the Table snippet. This
will add the Create Table template into the editor.

When you first add the template to the editor, several keywords
are highlighted. Enter the value for the first highlighted keyword.
Using the Tab key will move you to the second keyword and so
on. This makes for rapid building from a template. Pressing F9 will
execute that statement and create the table. To view, you can go
to the Object Explorer. You will need to press F5 to refresh, as
objects made in the editor are not automatically refreshed.

Let’s create a snippet. Click on the “Favorites” snippet folder.
Right click and choose “New Snippet.” Enter the name “Region.”
The snippet editor will open. Type “—region”. Move to a new
line. Right click and choose Snippet Tokens | Selected Token.
Right next to this select the Snippet Tokens | End Token. On a
new line type “—endregion”. Your snippet will look like this.

--region
$selected$send$
-—endregion

Change the snippet type to SurrondsWith. This is located at the

bottom right. Click “OK” to close.

Toad for Data Analysts
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5)

6)

7)

8)

9)

10)

11)

12)

13)

To use the region snippet, highlight a complete SQL statement.
To apply the new snippet you can double-click on it in the
docked window, or right-click and choose Code Snippets | Sur-
rounds With. Using the latter method will bring up a snippet bar
that has the same folder names as the docked window. Double-
click to navigate and select the region snippet.

Notice how the SQL statement is now surrounded by the region
comments. Click on the collapse symbol at the first part of the
comment. This will collapse the SQL providing more space. Click
again to expand.

Open up SQL Recall from the View menu or press F8. Click the
pin to keep the docked window expanded. Place your cursor at
the end of the file. Go to the SQL Recall window and double click
on a statement. This will load this statement into the editor.

Right click on a statement in the SQL Recall window and choose
“Move to Named.” Enter a name for the statement. You can also
add this to the code snippets from the right-click menu.

In the editor type Ctrl+N. This now lists the favorites folder for
this connection type and your named SQL is available for selec-
tion.

SQL parameters can be used in the editor. Either positional or
named are fine. To use a SQL parameter use a “?” for positional
or parameter symbol plus name. Type the following into the
editor:

Select * from region where region_id = ?;

Press F9. A SQL parameter window will show. Enter the value 2
and click “OK.”

Save the file as a Toad Editor File. From the file menu choose
save. Enter a name and change the file type from *.5QL to *TEF.
Click the “Add to Project Manager” button. Close the editor.

Find the file just created in the Project Manager. Double-click to
load. Notice that the result sets have been saved. This is a good
way to save an on going SQL design project.
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Report - Data Reports

After gathering the data from the appropriate data sources, you will

need to transform the data into useful and easily readable formats

for consumers. Toad for Data Analysts provides a variety of report

and deployment formats for your reporting needs. These inc

lude

Microsoft Excel, Toad Data Reports, Toad Pivot Grids and Toad

Charts.
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Microsoft Excel Integration Instance

From any data grid, you can B R PeSe| Select Excel i

export to Microsoft Excel _t@ . @ - . 153 - B exce nstancs elect Excel instance to ex-
por s ] -

Wlth one C“Ck in a Variety Of | _a Excel Instance at active cel port the data to a new Work

sheet of Microsoft Excel.

formats. Use the One-Click One-CIiCk Export

toolbar or right-click on the

p 1 X To export the data to a specific cell or worksheet,
grid you want to export.

first open Microsoft Excel and select a cell. Then

. select the “Excel Instance at active cell” option.
File To export data to file, select the range of data to export

or click any row to export all data. The One-Click file type .
exports the data to an Excel, CSV or Html file and saves P|V0t
under a default name in the default export folder.

The same choices are available for exporting the
data to a Microsoft Excel pivot table.
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Data Reports

The Toad Data Reports designer helps you build label, multi-column,
table, and master-detail reports. From any grid, right-click and
choose “Send to | Data Report Designer.”
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Reports - Data Reports

The Data Report Wizard opens up the designer. Here you can cus-

tomize the report layout.

The designer has three modes: design, preview and html view. Tog-
gle between these modes by clicking on the tabs at the bottom of

the designer.

When you are satisfied with your report you can export it to PDF,
HTML, MHT, *.XLS, *.CSV, text or image formats from the toolbar on
the preview tab. The Toad Data Report can be saved as a *.TDR file.
The stored query in the report is executed each time you open the

report in Toad.
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Data Report Designer

When you enter the designer from the wizard you will have a header,
detail and footer band, column header labels and column data labels.
Click on the preview to see the default design.

To customize the report, the Data Report Designer groups its tools
into four tool windows.

Field List Contains the fields available in the data set which
you can include in the report.

[Toolbox Contains a set of controls to customize the for-
mat and display of the report.

Explorer Contains a list of items currently included in the

report.

Property Grid |Contains the properties that can be modified for
the selected items in the report.

Field List

Field List

The field list tool window contains the
fields from the result set. The Data Report |7 el dataset]
Wizard will ask you what fields you want :
in your report and add a label object for
each field.

{€] ORDER_DATE
{23 TOTAL_PRICE
i--[F] Parameters

You can add a calculated field by right-
clicking on the column in the Field List.

Toad for Data Analysts

Field Formatting

Once you have moved a data column onto the designer, there are
many options to format. To access format options, click on column

label and then click on the arrow.

S R N R
pés pepot]

“ToadDataReport \

51 sepoatesderDand] fone band

+ |Fiodd List -3
= ) dekaSetl
=T Tathed
o] cLsTOMER_HavE |
] IMEMs
(] CRDER_DATE
3] ToTAL_PRICE
7] Paranters

= [H dewsandl
T =T
| NEDER BATE Edt Tt
| ITENS Text o
| TOTAL PRICT T statndng  |detaset] - Tablel CUSTO s
| <o) Frmat String =]
*| = B popfoastent ormberdpmpoel oy one o
| Tussiay, July 21,2609 . s
Farchor Vertical |None = Fol...
Formatting Rues | {Colection) =
| Fait Wickh o
| Can Grow o
=] datasat Can Sheinkc !
Pt
FormatString Editor —TE o799 5m | 2] -

Currency
Special
General

Sample
‘ Tussday, 21 July 2009 17:37 |

Standard Types  Custom

Mfdd ]y a

dddd, dd MMM vy Hiram
dddd, dd MMM vy homm b
dddd, dd MMM vy HHimmiss
vy Hiimm

Fjedd vy Bt
vy Himm

Ffedd vy b

T/ HH: mm:; bt

OF Caneel

Format data using any of the given
formats for date/time, number,
percent, currency or build your own
format string.
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Basic summary functions
such as sum, count, and avg
can be set from the Sum-
mary editor.

. -
(b fiekd:
Table] CUSTOMER_HAE .
5
L “rail>

Sum - 7
fg 9 5
Conrt H F]
I i
Hurdangiun 3
Perceniage T
Has &
. 3l

o op

Bags Beport

o Ganeel
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Explorer

Explorer -
—|[& ToadDatsRepart
% {5 reportHeaderBandl
L A xrLabels
+ E pageHeadersandL
— E detailBand1
/ xrlinel
- A P
- fy xrLabels
- A xrLabelz
Ay wrLabels
- A xrLabel3
- fy xriabel?
- A xrLabeld
Ay wrLabels
[[Z] xrPivotGridt
+ = pageFooterbandl

Use the Explorer window for basic navigation.
It contains a list of all objects in the report.
When clicking on an object, the details are
displayed in the Properties window and the
object receives focus in the designer.

Report Bands

Data reports have sections for header, detail, and page footers.
Placing your objects in these bands, designates where they appear
in the report (i.e.— placing a label in the header band will show at
the top of the report). Additional bands can be added by right-
clicking on a band. Change the height of the bands by dragging in
the margin.

Y T T BT RS ST BRSBTS

= & repotHeaderBand] [one band per report]

" Toad Data Report

Header Band

Detail Band

= l = = B pageFooterBand] [one band per page]

FOOter Band i'.Werl;msﬂay,JulyZZ,ﬂ]l]Q

Move Band
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Properties
Properties -
srLinel Line =
2= 84
Properties define the attributes of Appearance M E

any single object. The properties
tool window shows all properties
for the focused object.

Background Cole 1 Transparent
Biorder Color I ControlText
Border Width 1

Borders Mone

Foreground Colc M ControlText
Often you will want to use the

same settings for many objects.

Formatting Rule: {Collection)

Line Direction  Hotizontal

Instead of setting each object, Lir St‘-;'eh ?olid
. Lirne: Wik
create a style collection. & Pacing 00,00
+| Style Priority  {Style Priority)
+| Styles {Callection)
Behavior -

Anchor vertically Mone
keep Together Yes

+| Scripks {Line Scripts)
Wisible Yes

Naka -

Style Collection

Access the style editor by clicking on the Styles Collections in the
Properties window. Create a style category by pressing the add but-
ton. Define the color, font, border, padding, etc. Predefined catego-
ries for data field, odd and even data fields, caption, page info and
s title can be edited in the styles

o "k i editor. Setting the style for an
:é:m e e | ODject takes less time to de-
o . sign and make changes.

Pagirle. Farsground Color N CoredTent
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Table

Tool Box

The table object can be usedas  |5/| = Ede‘a"ﬁa”m
All items in a data report are a type of control. Available controls are a container for several column ' T A
listed in the toolbox window. To add a control to your report, click on objects. Here you can specify
the control in the toolbox. To place onto the design surface, drag to the row and column sizing.
or click the desired position. Right click to insert row and B

column cells. Add column data THE
To change the attributes for any control, enter values into the prop- by dragging or click-position
erties tool window. The most common input for a control is available from the Field List window. a
from a right arrow at the top of the control.

I R e Chart
I} chart Wizard Enter properties for a Chart

3 xrLabeld2 Label = B | erimerrers
£z} =g
e o ot
- XALabel Tasks Appearance ) | A " —
Edit Text Background Color [ White d

R through the Chart Wizard. Assign
the axis values in the Series Bind-

= bocer Color I ContolTot e ol et ing tab. Choose a data column for
Border Width 1 . J =
BeEnty | x Brders_tie the argument and value proper-
Format String  |40:§#,#.00}F _ Font. L Tahoma, 9.75) L . . . .
Sumery croun, Sum, (054, #.00) o2 Focyou G e Z ties. The Chart will display in the
ormetting Rules (im0 3 .
e e 00 designer. To change values, access
nchor Vertical [Mane = -+ Style Prioric (Style Priority) ] .
Formatting Ruks (callcuan) s icoleimd 2 the Chart designer through the
i Text Alignment Middle Right . .
o s o e & : right arrow at top of object. Al
can stk e - E; ] Y Chart properties are also con-
RN Auto Width Ho . ¢ . . . .
< ord - . 3 e == tained in the properties tool win-
Font
Gets or sets the control's font. dow'

Pivot Grid
To configure a pivot grid, click on the right arrow at the top of the
object. Set the data source from the
top drop down. Run the pivot de-
signer from the bottom link. Use the
designer layout to drag columns to

Label

The label object is the most common object type used for display-
ing text and column data. The Font can be changed in the Proper-
ties grid as well as formatting, color, etc.

P|ctur§ ) . . . i Y row, column, and
The pllcture object can be used to import a graphlc._The default oo ficitas data areas. Format
graphic for the report can be changed to your logo in the Op- i e

- oradd functions in
= the designer field
section.

tions under Database > Diagramming > Reporting.
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Data Report Types

The data report designer helps you design the most common types
of reports, such as multiple column, group summary, and master
detail reports.

Toad for Data Analysts includes samples of each of these report
types. To access, double click on the Toad Sample database connec-
tion. Then from the Project Manager double click on the Customer
List, Items Per Warehouse, or Customer Orders report.

Multi-Column Report

Customer List

e [er— Can S Fleces ol
o e Sy o

[87) 280z 03] 4635441 T 4RI

42y s 1067 s fem1)

Atdem Conard s [r—— Feason  Evn

A multi-column report can be built by using a table object to hold the
values for one entry. The number of columns, direction, etc. is set in
the detail band. Access this from the right arrow in the detail band.
See the Toad Sample Customer List report for example.

(=) B detaiand! B paraipand Tasks

A

|
LA = R .. |
]

R e Sork Figlds (Colection) %
[EMAIL ATDRESS) [Mki-Colmn Made Lse calumn caunt

Multi-Column Direction | First Across, then Down

Column Counk 3 =]
[ SINESS_PHONE]

[ [EISINESS_PHOME] Column Width o =
=] [=) I Baltomargin [ Calumn Spacing 0 &

Formatting Rules | (Collection)

Keep Together
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Reports - Data Report Types

Group Summary Report

To group and sum data per page, first set
the columns you want to group by in the

Wizard. ) . R
Place objects in the

" S msesesieiiena . group or detail e S e wa
e ] band. Add group

— — Items To Order header or footer bands by right clicking on
i REGION NAME] an existing band. See Toad sample report
S8t e —— “Items to Order” for an example.
b _u*‘:::n N |r£um¢ ._-cllHR
- ﬂ T L s Items To Order

] | Coumt{[[TEM_IDjjlems & ©© Tem CENTRAL

= = B pogFcotedind] jorm bared s pagm]

B ort generated by Toad for Data Analysis Bata "

o Wedmesday, July 23, 3007

o
2

CLIRAENT QUANTITY

121

Catios s 1
m Tyrannosawus Batsat r
Tetad: 15

Master Detail Report
A master detail report can be built from a query in the Master Detail
window or any group by query. Set the grouping columns and any

summary functions in the data designer wizard.

sy s
-

[eTr—

o it s b "

S Ay M Man Vo

B S5Fare Customer Orders

Wednesay, July 11, 2003

3 Palans Wy Alisa Vi, CAZIBSE
P 343-T54-0000 Fax 3497540990
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Ko A . - Contact Id: 2
_m.m- Mesbit m (239) F51-9000
. H-Jdm: 211971 m (445) 491-2452
Add detail or group T ===y o T

bands where desired.
Use the label object

o | oveoas | Eeswoecae | swoeasreis |

e s oS

Them T8

. Ttem name. Quantity Price Dhem Tokal
summary editor for = et ; s pam
group and report totals. o Tearei— e
ma Hagakesaurs Parker a 3100 48,00
s Hacrcohalanols Canadensis k] 14200 $1.332.00
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Data Report Exporting and Maintenance

After you have designed your Toad Data Report, you can save it with
a *.TDR extension. The design layout, connection type, and query are
saved in the file. A report can be refreshed on any connection of the
same type. Connection type, not connection details, are stored in the
report file.

Opening the file in Toad for Data Analysts, executes the query and
displays the report in preview mode. From the preview window, you
can print or export to PDF, HTML, MHT, rich text, Microsoft Excel,
*.CSV, text or graphic format. You can also attach an exported report
to an email and send from the same window.

" 4 Repart Previes Customes(ederstdr

N e R [T R 8

QUEST
SOFTWARE"

£ Pelatis Way Akzo Visjo, CAOIESE
P 949-T44- 8000 Fax 349.754.80%)

Wiadmesday, Juby 22, 2000

You may want to edit your report after saving it. To edit an existing
report, open to preview, then press the Design Report tool button.

To change the query, select the “Edit underlying query” tool button.
After editing, you can return to the designer and refresh the report.

B R

Design Report "

d Zo0Query 3 Report |30 Automate

i ia 5] Tioad Sample Dot 2@ T € Dagomer | Database Exprer - Query Bukder | Bt | Aoma
EI & [Teestenbonan o l[07 x| B
" Meport Customertinders.tdr
T e —_— —— — - .
T b = — G repetbienterf e e bared e st E
§ [ iy poreer
Lo
QUEST
E . Customer Orders

o [ Tednrider, T8y T T

1 pagebeacedland] fore band b page]
| = pughissdalled]
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Report Manager

The Reports Manager, available from the
tools menu, is a handy organizer for your
Toad Data and Excel reports. Reports are
organized by connection type. The sam-
ple reports are listed here under ODBC.
A wide variety of reports are bundled
with Toad for general database informa-
tion.

From the right-click menu, create new
folders, add existing reports, edit a re-
port in the designer, or edit the query.

Search for a report from the search bar.
Reports located in the Toad share direc-
tory will be displayed at the bottom. Re-
ports can be easily saved to the Shared
directory from the designer window and
will be accessible to all Toad users.

Project Manager
Reports can be added
to the project manger
and organized by pro-
ject. You can open,
design, or edit the
query from the right

Shinck Explorer, Profest Hanager
Sample rofect =
= & Sawryin Bropect
= S Disgrams:
R
i) Cuest_Stage_Schema. ber
=) Quevies
T35 AuddressesForSmkhAndvan...
{3 Crdersrestenthanl 000, ..
Ly OrdersarestarthanL 00, ..
5 selectedwarehouses. 53
5y g e s
= Repats
LT
) ke oty Warsho...

fi Cusrertot s

E Ihemsheriaretiouss tdr

Reports Manager

Search:

+ [ Reports (DEZ)
+ /[ Reports (My3QL)
— || Reports (ODBC)
] Customer Orders
=h| Custornerlisk
5] Items to order
—|[-7 Reports {Oracle)
+|[_ Cluster Reports
+|[_ Other Reports
=+ || Sequence Reporks
+ | Stored Program Reports
+ [ Synonym Reports
—|[Zr Table Reports
] Indexes
| Mon-indexed Tables
11 Table Comments
j Table Constraints

=+ [ Trigger Reports
+|[_J User-Defined Reports
=+ [ Yiew Reports
+|[ 1 Reports {SOL Server 2000)
+/|[_ Reports {(SQL Server 2005)
(. Shared Toad

Filenarne: Tables Colurmns.tdr

Displays selecked table(s) and
colurmins.
Ordered by Owner, Table Name.,

click menu when a Toad Data Report has focus.

S = .. | Openingareport causes an execution of the query
== 0N the current connection. Make sure you are con-
oo nected to the correct connection before opening a
= Toad report.
anraction Msa...| b Rename
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Chart Reports

Charts are a very effective way to visually represent summarized
data. To design a report with a chart only, right click from any data

grid and “Send To | Chart Designer.”

Poelt Se25 | Mssages | Explsin Plan | Prvot & Chart.
Satl Set2

This will open the Chart

oo s Wizard. The wizard guides
Conry Cefe .
favone @l on. you through the essential
Boot questions to design a
Quich Egpurt »
SondTo b T Tahesowss chart. Advanced users
Show P L ke Report Designes...
o+ R may enFer qata through
Rexitols 1] ot the navigation bar.
e Courk I
| Chart Wizartl Cid
'] chart Wizard
e Chert Typs:
= S Chaoss i dht kype you wark bo e, To ke chark bypes by ek gronape, s the wakses s drop-down
_‘L Chat Leoe e,
Choose from 43 A e -
different styles j e | ]I : ' -
and colors. = = | _]. Z ! -
ol ||
— — — iy i Scknd ] s iors |
L3 chat ;

by | Mg | WD

vary e e chit . acke]

III [." " rllle @@
. . |- ]

L2 Frah, Sl
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Reports - Data Charts

Charts display a series of summarized data. The data used in your
chart is from the grid you right clicked on. At the very minimum, you
need to set the values used for the X and Y axis. Use the Series Bind-
ing tab in the Data section, to set the columns used for argument

and values (X and Y axis).

T) chart Wizard
Comrason m
- [— || YT = s
I g— Lo e P e
TR - » ¢
N~ [
Bl canes  Eemae =
= Mgt -

= pr—————

= ,lt_nm Tam] CLTCMER JORT ]
& =

= Ot Wk e P Pasre

- P

A bt o et

& T

R g —

< s

A chart report is saved
with a *.tdr extension.
When later opened in Toad
it will refresh the data by
executing the original
query and graph the new
data. The report uses the
current connection and
will only execute on the
same type of database
connection. To export the
data in a common format,
such as pdf, use the ex-
port document menu.

o At -

P ] o R | e Y S A e e 5%

When you finish the wiz-
ard it will open the Report
Designer. Here you can
add any additional report
objects and save or ex-
port your report. Add
your report to the Project
Manager, send to the
Toad Network Share loca-
tion or email the report
from the Wizard Bar at
the bottom of the de-
signer.

R T PP —— &
B il il

EREEREEEE

e Tuncnal | Cpen fisped crAdd1o Progeas ) Emal i Shars o) Automats
-
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Reports - Pivot Grids

. . = =
Pivot Grid Reports == 3 Refresh Data
' ! B, Show Field List
Looking at data in several dimensions such as sales by region, sales Seve.ral p|v9t actions are available from Setup Grid...
by sales rep, sales by product category, sales by month, etc. is essen- the right-click menu or toolbar. [] Conditional Styles. .
tial for a data analyst. Pivot grid/tables provide this functionality and — S — il 32 | Edit Underlying Query...
can be used in reports. zidicik Sl T chart
co:gn 3 B Macsment i
| 1:;":.\_99&5
Fskies s Egloniin Pkt Ot i Change the summary
function on a column
zli'mﬂ::!ﬂ mn.- s ::-‘:N“ To build a pivot table, rlght click using the Setup Grid
awn o i L] from any data grid and choose editor
B, Bruce =g 0ATLA . A .
v, U N I [T “Send to | Pivot Grid.” The con-
i, B iy e ‘#.M = 15600.50 A
YT e '::"; T nection type, query, and data Or, set the cell format string
Awron, B ; F m 5114.50 H H . . ‘Sam le |
e b g+ [12 T results will be sent to the pivot from the Setup Grid editor. —
Aarcn, Bruce GedTo b T Leble rowser d d . ‘ 1231 |
Adrn, Brucs £ vl Data Report Degrer... grl eSIgner' o
Abrame, Hilda CompareTo [l Chart Desigrer... . ancardTvees Qg
e eis [ Do You can change the query using | ===,
e L e 'y T the “edit underlying query” 5656, M yypy e
iR bt )] sl Pivot Grid Untitled1* . . y g q y 33332 :: mm :::: ::mm 3
action. Display a chart using e, BV i
|| orop Fiker Fislds Here h h dddd, dd MMMM yyyy himm t
H dddd, dd MMMM yyyy HH:mm:ss
Using the field |i$t, drag the a2l Drap Colurin Fields Here the chart action. m:aa;:::: :::’mtt
| to th | [ aénr'é Fan Pt | Grand Total | Ay Himm
columns 1o the row, co unj’n | o g, 170t Export the pivot grid from the I 5l
and data area. Or use the “Add rint oreview window
To” button and area drop down. Pivnt Grid Feld List printp ’ =
. . . Drag Items to the Pivot Grid
The resulting pivot table will be T
displayed. s Save your pivot as a *.TPG file with or without the data. If the data is
ORDER,_DATE not saved, the query will be executed when you open the file. Re-

TOTAL_PRICE

fresh the data from the right click menu at any time.

| !
Bl Ede DvotGid Yew Took Window tel G Sesreh Gaogle 8
1 Understand 2 Query % Report 4 Automate Tools
Pivot Grid Untitled1* (51D g | TR Diagranmer 5 Dstabacs Bxpkores | ey bubder p Edtor L Ayeormation () et browssr i-| Confiuration = g
Drop Filter Fields Here £ T ool Gt Uittt * | AL 1:
;|| Do Fiter fhds bere 1ypa v W=D g
TOTAL_PRICE ORDER_DATE 0O A 3
! = J | = TOTALPRICE | ORDER_DATE (Month) 0 [ e— I e Bue || S
B abheos, vy || %
| CUSTGME.., O | January | February | March | Grand Total | QTN 1,2 ewasry Februaey. | Maech Grared Tokad | v W s, o 3
] Aaren, e A0, $E0612.50 424,920.29 L3423 | 1 Grand Total -3
| Aaron, Bruce i $16,861 40 $69,612.54 $24,920.29 $111,394.23 e A D oo 4
I Abrams, Hida | $20,871.72 $48,211.22 $29,013.82 $98,096, 76 7 || e, Roy. #7239 $52,781.53 £45,368,49 $115,387.93 0 o s | |
I Alex, Roy | $17,237.91 $52,781.53 $45,368.49 $115,387.93 % furand Tokal #4,971.03 170,605,729 #99, 302 60 F3M,878,50 Janusary Febnaary Marchirand Total
Grand Tokal $54,971.03 $170,605.23 $99,302.60 $324,878.92 @ oo = ) DER10 (CEE), HA.~
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Report Exercises

Exercise 1
Purpose - To demonstrate how to build a Microsoft Excel report.

Scenario - You need a report that shows how many address there
are for each region and the IDs of each region.

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking the
Navigation Manager.

2) Multi-select tables REGION and ADDRESS, right-click and choose
“Send to Query Builder.”

3) Select region.region_name and address.address_id columns.
This query will list the address_ids and region they are in.

4) Execute the query. Click the Excel Pivot Table tool button or right
-click and choose Quick Export > Excel Instance Pivot Table. (For
the right-click you need to have focus on the result set.) This will
open a new instance of Microsoft Excel, send the data to Micro-
soft Excel and open the Pivot Table Field List.

5) Dragthe region_name to the row area. Drag the address_id to
the data area. Close the field list. This will display the total num-
ber of addresses per region.

6) We now want to add a list of region IDs and names to the report.
Click on cell D4.

7) Go back to Toad and remove the ADDRESS table and run the
query. Export the result set to the active cell by using the “Excel
Instance at active cell” tool button or right-click menu item.

8) This gives you a report built from two result sets.
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Exercise 2

Purpose - To demonstrate how to build a Toad Data Report with
grouping bands and styles.

Scenario - You need a report that lists the order quantity totals for
contact numbers 2 and 3.

Exercise Steps:

1) Connect to the Toad Sample database by double-clicking the
Navigation Manager.

2) Select tables CONTACT, ORDERS and ORDER_ITEM. Right-click
and choose “Send to Query Builder.” Select columns Or-
ders.Order_id, Orders.order_date, Contact.Contact_id, Con-
tact.last_name, Order_item.ltem_id, Order_item.Quantity.

3) Locate the contact_id column in the bottom part of the query
builder and add the WHERE condition “IN (2,3)”. (Note: Do this
by invoking the WHERE condition editor.) Choose the IN opera-
tor and manually type ‘2,3’. (The parentheses will be added by
the program.) Run the query and review the results.

4) From the Results tab, right-click and click “Send To Data Report
Designer.” In the Data Report Wizard add all of the columns to
the report.

5) Add the following grouping levels: (ltem_id and Quantity will be
the detail columns.)

CONTACT_ID, LAST_NAME
ORDER_ID, ORDER_DATE

6) Check to sum the quantity column. Click through to the end. This
will open up Report Designer.

Cont’d
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7) Now we want to define some styles for our report. Click on any
data field, then go to the properties window. Scroll down until
you see the Styles Property. Click on the collection to invoke the
editor.

8) To add a new style, click on the green plus sign at the top left.
Enter the name “Contact” in the name property on the right. In
the Background Color, use the drop-down custom tab and
choose Orange. In the Font property, enter Font Style Italic and
type in Tahoma for the font.

9) Add the following three styles;

Name:  Orders
Background Color: SteelBlue
Font: Tahoma, Bold

Name: ItemsEven
Background Color: Transparent
Border Color: 175,190,216

Name: ItemsOdd
Background Color: 239,243,250
Border Color: 175,190,216

10) Now we want to assign these styles to the fields. Set contact_id
and last_name to the Contact style. To do this expand the Styles
property. Click on the Style property and select Contact. Set
order_id and order_date to the Order Style.

11) To set the detail band columns to alternate row color, set the
Evan Style property to ItemsEven and the Odd Style property to
the ItemsOdd style. Do this for columns item_id and quantity.

12) Change the date format by clicking on the right arrow of or-
der_date. Click on format string to bring up the editor and se-
lect DateTime. Click the format of your choice.

13) Click on preview to view the report.

14) Continue to add objects to your report or set alignment and for-
matting properties until your have the design you want.

Toad for Data Analysts
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Exercise 3
Purpose - To demonstrate how to build a Toad Chart from a dataset.

Scenario - You need a graph report showing how many orders there
are per region.

Exercise Steps:
1) Connect to the Toad Sample database by double-clicking the
Navigation Manager.

2) Multi-select tables REGION, ORDERS and ADDRESS, right-click
and click “Send to Query Builder.” Select columns region_id and
order_id.

3) Remove the shipping_address_id and address_id join. This is a
database reference that is not needed for the query. Select the
aggregate function of sum to the ORDERS column to give you the
total of ORDERS. Click the Group By row for the region name.
Run the query.

4) If the result looks correct, right-click and choose “Send To |
Chart Designer.” This will open up the Chart Wizard.

5) Choose bar chart type. Click through to the Data section. Select
the Series Binding tab on this page. Choose Region_name for
the argument. Select Express01 for the value. This is your total
of ORDERS for each region. Click “Finish.”

6) This will put you in the Report Designer. Change any property
here or add objects. Press “Preview” to view the report. Select
save on the Preview window to export the report as PDF.

7) Note: If you want to go through the Chart Wizard again, click
back on the designer tab at the bottom of the window. Click on
the chart. On the bottom of the property window you will see a
hyper-link to open the wizard.

8) Click on “Add to Project” to save the report and add to project
manager.
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Exercise 4

Purpose - To demonstrate how to build a Toad Pivot Grid from a
dataset.

Scenario - You need a graph report showing sales totals per region
by year and quarter.

Exercise Steps:

1)

2)

3)

4)

5)

6)

7)

8)

Connect to the Toad Sample database by double-clicking the
Navigation Manager.

Multi-select tables REGION, ADDRESS, ODERS, ORDER_ITEM and
ITEM. Right-click and click “Send to Query Builder.” Select col-
umns region_name and order_date.

Remove the shippind_address_id to address_id reference by
right-click, remove.

Add a calculated column by invoking the calculated fields editor
from the toolbar. Enter the name ‘Sales Total’ into the name
field. Press the field definition dropdown and build this expres-
sion.

ITEM.RETAIL_PRICE * ORDER_ITEM.QUANTITY
Attach this calculated field to a table. Click “OK” to close editor.

Execute query. You should have almost 44,000 rows. Right-click
on the result set and choose “Send To | Pivot Grid.”

Drag the region_name field to the row area. Drag the Or-
der_date field to the column area. Drag the Sales Total to the

Data area. You can also use the “Add To” button on the field list.

Right-click and choose the SetupGrid. Select Order_Date. Click
on the “Group Dates On” dropdown. Select Year and Quarter.

Select Sales Total. Open up the cell format editor. Choose the
Custom tab and select the last format string.
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9) Pivot grid now shows order totals by year and quarter by region.

10) Expand the graph to view the data graph. From the toolbar of
the graph deselect grand totals. (If selected)

11) Right-click and choose “Edit underlying query” to view the query
that generated the data.

12) Right-click to refresh the data by querying the database.

13) Click on “Print” to export the pivot grid in various formats: PDF,
HTML, Microsoft Excel. Save file as *.TPG file for later use.
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Automation

Every business wants to do more with the same (or fewer!) re-

sources. Automation can help you schedule repetitive tasks, leaving

you more time to do other things.

You can schedule long running queries to be run at non-peak data-
base times, or import/export data to ready your data sources before
you arrive each morning. Monthly reports can be generated and

emailed or FTP’d to recipients.

Workflow

From any report window, send the report to the automation de-

signer from the Wizard Bar button.

Customer List

This will automatically create a
script that refreshes the report
and attaches it to an email. Fill
out the email information and

test the script.
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Automation - Basics

Schedule

From the automation designer, send to
the scheduler by clicking the Wizard Bar
button on the bottom right. The sched-
uler sets up the task to be executed by
the Microsoft Windows scheduler.

Enter frequency and logon password.

Task status and management of tasks can be done from the main
Toad Scheduler window. For heavy automation work, install Toad for
Data Analysts on a Microsoft Windows server for automation use
only. When running automation tasks, Toad runs in non-visual mode.
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Automation Designer

Automation - Designer

Script Settings

The Automation designer can be opened from the Tools menu or

Automation document grouping button.

Activities

(3> Automate Script settings contain the name of the script, exception handling,
and logging information.

Script Settings

To build a script, select an activity

& Toad for Data Analysts - [Automation C:\Documents and Settmgshdpeabacly’, My Documentsi Scnipt_1.tas] = from the Toolbox, Enter activity
Ble Edt View Iooks window Help || search Googe &) details in the property window,
Automation activities are available from | [ Understand 2 Query [3Report | &> Automate Tools o double-cick the activity
the tOOIbOX There are three roups: e e || 2] Toad Sample Database ) 5 THERDisgrammer - Query Bulder |7 Edtor [ Automation il on the design surface.
; groups:  |emsios
Data base, File and System activities. 2|4 mutomation, £ Automation CADocument...\Sript_L.tas| v b x (]
Click or drag to add to your script. Al — e =
% Database Activities Toad Automation Script Description Send email - g
F| L patsbsseConnsction D Ensbled  True § H
% ) SelecttoFile | (Name)  Email_1 [ Logglng
[ (39 Execute Script Script Settings Ol? Error..  stopOnError &
g [@  Select to Editor with Results Tﬁn‘:i:ﬁ; Tsucgﬂuiaﬁiarag;?vtwy Em;l:\:irver r:lay.quest.;:i... L H th t f t t
5| B crarven o - OBEING the Steps o your activities
% [ Impert Wiard on the design surface i:s:t:::tltatn None X can be done in basic or Verbose

. « mgw % Bl TosdReport E Ta dpeabody@qu... . _

Edlt Actlvltles — [Z] Toad Pivot Grid =l Cannection_1 cc mOde Set the |eVe| a.nd flle |0ca
‘ ‘ g (ot Ra tion in the script settings. To debug

. - . T — = sz our script use verbose mode. Dur-

Edit an activity by double clicking on ot ody y - tpt tine the log data i
. s L — Inckide Log: one ing script testing the log data is
the activity. This brings up the activity K odeteris Mise - .g P . & g .

- . . . £ Logconment Lo s for displayed in the output window.
editor. Or edit the activity values in the @ i . - )
property tool window on the right. & Find and Replca v Beport files can b'e viewed by click-

£ Sedna T ing on the hyperlink.
R [ __FTEFile a4
L | @
Activily = &,
Desrption Execute Toad report and export as file
Ensbied T B Tutorial < Add to Project | Save Bf Test © Schedule
(Name) Repurt _1 —
o sopOnEiror
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When an exception is thrown during
-- .9 T . .
— automation execution, you can send an
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email to notify you of the issue. If logging
is enabled, the log file will be attached.
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Automation Database Activities

|::.| Export Wizard invokes the Toad Export Wizard. Enter all

_3-1_ A database connection is necessary for any data retrieval. export attributes and save to a Toad Export template

A connection is automatically added when choosing any (*.TXP). When you build an export template, it is added to
of the other database activities and points to the current the Project Manager and appears in the Export activity
connection. Change connections in the activity editor and list. To edit the values, choose “edit selected template”
choose from any you have defined in the Connection Man- from the dropdown.

ager.

* 5

[= Connection_1

iﬁ Select to file takes any *.SQL or Query |—! Import Wizard works the same as the
export activity, building and saving a

Builder file and executes the SQL. The ] |
results are exported to Microsoft Excel, e N sy Toad Import template (*.TIP). The Ex-

CSVor HTML formatand savedina | = |[iS/m—mmm—p a 50L script File port and Import templates can also be
path you designate. Excel options of v — used from the Tools menu to edit or
exporting to named region or cell loca- execute.
tion are available from the File Option

attribute of the activity. File names can

be unique by appending a date suffix.

Validation Any time there is missing input,
a red validation sign will be displayed. The
drop down hint will provide detail on what
data is needed. Enter missing data by double

4 . clicking on the activity. —| Toad Reports can be refreshed (query
L=zz| Execute script executes the contents of b ted inst th iated
a script. If there is a result set, it can be exegu e) agdalns te;iso:lz; E?I_Tv”_
assigned to a script variable and ac- :ec on in exported to L,
cessed in the Loop Dataset activity .RTF or *.MTF formats. If a unique file
name is needed, append a date time

E Toad Pivot Grid activities refresh the pivot grid of an exist-
ing Toad Pivot Grid file (*.TPG) and export as *.PDF, Mi-
crosoft Excel, HTML and *.RTF document types.

% Select to Editor with Results executes the SQL in a saved
Toad Editor File (*.TEF). The result set is saved in the file.
You can choose to delete prior saved results or append
the new result for comparisons.
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Automation File Activities

X

Copy File copies, renames, appends suffix or moves a
file.

Delete File deletes one or more files. Use the file collec-
tion editor by pushing add and then clicking on the File
Name property.

Automation System Activities

W

Run Program executes a run command with arguments
and uses common verbs such as print. Set a cancel value
if you want to cancel the execution after a specific num-
ber of minutes.

Set Variable is used to define and set the value of a vari-
able. Give the variable a name and set it’s value using the
expression builder. Test an expression by pressing the
test button.

==t If Condition - Execute activities conditionally based on the
EL_.‘_') Log Comment adds a comment to the script and log file. —= value of a variable expression. For each condition you can
You can dereference variables by using the ‘# symbol. define unique activities. To use this activity you must de-
(i.e.— The value of variable Month = #Month#) fine a variable in the automation script with the Set Vari-
able activity. Delete or add conditions by right-clicking.
i@ Zip Files by entering collection of files and providing ar- *.l-_'".# While—Execute activities while a variable expression is
chive name. Zip files can be password protected. true. The activity ends when the condition becomes false,
or when it completes the selected number of loops.
o _ ["a  Loop Dataset—Execute activities on each row of a data
%3 Find and Replace text within a file. Variables can be used ] table. The data table must be the result set from an Exe-
for find or replace values. Text files can be used as tem- cute Script activity that occurs previously in the automa-
plates and with find and replace customize items such as tion script. You can reference a column in the data table.
dates and salutations. See exercise for example.
i Parallel - Run two or more activities in parallel. After add-
ﬁ Send Email is the most common form of deployment for ing a parallel activity to the design pane, you can right-
automation. The email activity uses SMTP. Reports gener- click it to add additional branches for parallel activities.
ated in the script are easily found through the attachment . .
Templates Templates - Any activity or connection

editor. You can use a file for body content and attach the
log file.

Copy Manthly Report

activity and child activities can be saved
as a template. This saves the activity de-
tails for use in other scripts. To save as a

EFE FTP your reports with the FTP activity. Upload or

download files from the same activity. template, right click and provide a name. Templates are

added to the template section. Click to add to script.
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Automation Exercises

Exercise 1

Purpose - To demonstrate how to automate and schedule basic tasks.

Scenario - You need a Microsoft Excel report of current regions and
addresses emailed to your manager every week.

Exercise Steps:

1)

2)

3)

4)

5)

6)

Save the following statements to a single file.

Select * from region;

Select * from address;

Open the Automation window by clicking on Automation docu-
ment tool button or using the Tools menu.

Double-click on the Script Settings to invoke the Activity Editor.
Enter your email address in the To and From properties. Enter
your SMTP server address. Change port if not the default. Click
“OK” to close. This will set up the exception email. If you do not
want an exception email, change the Email on Error property to
False and Show Warning to False.

Click on the “Select To File” activity in the toolbox. Double-click
on the activity in the design area to invoke the Activity Editor.
(You can also enter values in the activities property window on
the right.)

Select the dropdown for the SQL Script property. Browse to the
file made in step one and select. Click the dropdown again and
notice that the file, just selected, is in the list. All files added in
the activity are automatically added to your Project Manager
under Queries. All files in that folder are listed for this activity.
Click the file options. The Excel file type is selected by default.
Click the browse button at the end of the filename box to select
a directory. Enter file name. Check the Add/Date suffix and
Choose Date (YYYY-MM-DD) and click “OK.” This finishes all val-
ues needed for Select To File activity.
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7) Double-click on Connection activity (note: all activities that need
a database connection must be a child activity of the connection
it will use). Select the Toad Sample database connection. The
connection activity should select the current connection or last
connection made.

8) Add an email activity by clicking or dragging from the toolbox on
the left.

9) Double-click on the Email activity to invoke the Activity Editor.
Confirm the To, From, and Server values have been entered.
Click on the attachments. Any files that are generated by the
automation script will display on the right. Click “Add” to move
the file to the left side. This will now be added as an email at-
tachment. (Note: The Date format string will be replaced at run
time.) Close the window by clicking the X. Enter your Subject and
body of the email.

10) To test your script, click the “Test” button on the Wizard Bar or
“Test” button on the toolbar. It will ask you to enter a file name
and path.

11) First, the automation script is compiled, then executed. All re-
sults are displayed in the Output window. Failures are flagged
with a red icon. All successful steps display the icon of the activ-
ity used.

12) Review the output. Click on the Microsoft Excel file generated. It
will display the Microsoft Excel file in Toad. Notice that the re-
sults of each SQL statement are in a different worksheet.

13) Double-click on the Script Settings and change the Logging level
to “verbose.” Run the script again. Review the output and see
the additional data added when using verbose logging. This will
be especially helpful when debugging issues.

14) To schedule the automation script to run at a later time, click on
the “Schedule” button on the Wizard Bar.

15) When the Task window displays, enter your password using the
“Set Password” button. On the Schedule tab, choose to run once
two minutes from now. Click “OK.”

16) Check your email for confirmation of execution as well as the
status of the Job Manager window.
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Exercise 2

Purpose - To demonstrate how to use the Toad report, zip and copy
file automation activities.

Scenario - You need to refresh and export the Customer List and
save to network backup drive.

Exercise Steps:

1) Connect to the Toad Sample Database. Open an automation
window by clicking on Automation document tool button or us-
ing the Tools menu.

2) Drag or select the Toad Report activity from the tool box. Dou-
ble click on the activity. Click the Toad Report drop down and
select the CustomerList.tdr. This is a sample Toad Report in-
cluded with the product.

3) Click the Save Report As property. Choose the export type. PDF
is the default. Select the directory and export file name.

4) Add a Zip File activity by dragging or clicking from the toolbox.
Double click on the activity and enter the Archive File directory
and name. Click on the File Collection and choose the file output
from Step 3. It should be displayed in right side of attachment
editor. Enter a password for the Zip File.

5) Add Copy File activity to script. Enter Source File name, destina-
tion folder, copy name and suffix.

6) Save and test the script.

7) Click the link in the output window to open zip file. Click on file
and enter password to open.
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Exercise 3

Purpose - To demonstrate how to use the row count variable and If
activity. (Available in Toad for Data Analysts 2.5 and above)

Scenario - You need to build a report and perform a specific activity
only if there are rows returned from the query and do something
different if there are no rows.

Exercise Steps:

1) Drag or select the Select to File activity. Double click on the data-
base connection and select the Toad Sample database.

2) Double click on the Select to File activity. Enter the variable
name “rc” in the row count property. From the drop down of the
sql script select the AddressesForSmithAndEvens.tsm file. Set
the file options for export.

3) Add an If..Condition activity to the automation script by dragging
or clicking from the Systems Activities section of the toolbox.

4) Double click on the If_Condition_1 child activity. Pushing the
Condition property drop down will bring up the condition editor.
Click the word Variables on the left side. It will display on the
right side all variables that are defined in the script. Double click
on the variable named “rc”. This will add to the condition ex-
pression. Click on the Operators type and double click >. Finish
the expression by typing 0 so the expression reads “rc > 0”. Click
the test button to validate the expression. The expression will
validate to False because the value of rc right now is 0. If an er-
ror occurs it will be displayed in red.

5) Add aLog Comment to the If_Condition_1. Enter this string for
the message. “The condition has evaluated to true. The Value of
rc is #irc#” Note: The # symbols dereference the value of the
variable.

6) Inthe If_Condition_2 activity, add this expression, rc = 0. Note:
Variable names are case sensitive. Add a similar comment activ-
ity. Run and test script logic and variable values.
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Exercise 4

Purpose - To demonstrate how to use variables and the loop dataset
activity. (Available in Toad for Data Analysts 2.5 and above.)

Scenario - You need to build a report containing the addresses for
each region and put in a ZIP file.

Exercise Steps:

1)

2)

3)

4)

5)

6)

7)

Create two SQL files. One for each of the SQL below:

Select * from region;

Select * from address where region_id = :id;
Connect to the Toad Sample database and open an Automation
window by clicking on Automation documents tool button or us-
ing the Tools menu.
We well need a variable to be used with the parameter in the SQL
above. Add a Set Variable activity from the System Activities sec-
tion of the toolbox. Enter the name “id” with value 0. (Note: The
names are case sensitive so check to see the name matches the
parameter name in the SQL above.)
Add an “Execute Script” activity by clicking or dragging from the
toolbox. Enter the path to the script for the first statement above.
Enter a name for the result variable, such as region. This allows us
to use the results from this query as a variable in another activity.
Add a “Loop Dataset” variable from the System Activities section
of the toolbox. Double-click on the drop down for the Data table
property and select the region variable. (or name set in step 4)
Add a Set Variable activity to Loop_row_1 activity. For each row
of the dataset we want to set the value of id to the column value
of region.region_id. To do this, double click on the set variable
activity and enter the name id. Enter the variable value as
“region.region_id”.
Add a “Select to file” activity as a child activity of Loop_row_1. If
it is added to the top of the script, just drag it below the Set Vari-
able activity. The Connection and Select to File activity need to be
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a child activity of Loop_row_1. Enter the path to the second file
created in step 1. Choose your export options. As a nice touch,
have the file name include the name of the region_id to make
the file name unique. To do this choose the directory path and
enter the file name like this —>“region_#id#”. The “#id#’ will be
replaced at runtime with the value of the variable “id”.

—

Script Settings

To build & seript. select an activit
from the Toolbos. Enter activity
details in the property window,
or double-click the activity
on the design suface.
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8) Add an Archive activity as the last child
of loop_row_1. Enter archive name and for
files to zip, choose the file “region_#id#.xls’
from step 7.

9) Save and run the script. In the Output
window click on the archive file and open.
There should be 5 files, each containing the
address for the region number in the file
name.

File Actions Options Help

= =% A -
| §= Y | [ :
-u/ I/"\‘)' I}/ L]
Mew Open Favorites A

e
@_]Region_Z.xls
@_]Region_&xls
@_]Region_‘%.xls
@_]Region_s.xls

<] B
Selected 0 files, Total 5 files, 79 &) (O

Automation—Exercises



Export & Import

»

Import

Importing data to and exporting data from the database is made as
easy as possible with Toad for Data Analysts. There are separate wiz-
ards for each, so we'll go through them separately.

Export Wizard

The Export Wizard is
found under the Tools
menu in the Export sub-
menu. There are three
options here: Export Wiz-
ard, Open Export Tem-
plate and Execute Export
Template.

Open Export Template...
Execute Export Template...

Import and Export Templates are nothing more that a saved copy of
your Import/Export Wizard settings. This way, you can create any
number of templates to cover all of your common import & export
scenarios and execute them one at a time with a single click. If you
regularly import or export the same information using the same set-
tings, this will save you lots of time. In addition to being able to exe-
cute these templates directly from this menu, you can plug them into
Automation to get even greater time-saving benefits.

The first screen gives you six options for export. The first two allow
you to select one or more tables or views, all from the same schema/
user, selected from the Schema dropdown. The Schemas option will
allow you to export a//of the tables or views (or both) for one or
more schemas/users. The Text List option gives you the flexibility to
select specific tables and views from multiple schemas. Using fully
qualified object names ([owner].[object_name]) separated by com-
mas, you can enter a list of objects to export.

The last two options allow you to export the results of a query, either
saved to disk or one that you want to quickly type or paste into the
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window. When your goal is simply to save the result to a Microsoft
Excel or CSV file anyway, the benefit of this method is speed. When
you execute a query in the Query Builder or the SQL Editor, you have
to wait for the results to be loaded into the grid on the screen.

However, it’s much more efficient—and a lot faster—to let Toad for
Data Analysts simply write the results straight to disk. There’s less

memory used as well, so if you have a query that

takes a long time to load or one that returns
millions and millions of records, try exporting
the results directly with the Export Wizard.

With your tables, views or query selected, click

“Next” to move forward.

CRUSTESES L

Select Objects

Select the data objects thatyou wish to export.

Tip: You can use the
Query method to export
your query results in
Automation by saving the
Export Wizard settings to
a template.

sl

Export Category Schema:

|QUE5T_5TAGE

Tables:

[ ADDRESS

[ ADDRESS_ARCHIVE
[ cHAR_TEST

[ conTacT

Views [ courses_TBL

] cusTOMER

|| DELETED_ORDERS
[ DELETED_ORDER _TTEMS
[ HR_MANAGERS

[T HR_MANAGERS_OLD
[ mTEM

[] orDERS

[] ORDERSUM_TEMP
[ ORDER _ITEM

) Views
() Schemas
Tables

() Text list
() Query
() Query File

m
—
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The next screen is where you can set your output options. There are
several different types of file formats supported by Toad for Data

Analysts:

Delimited

Comma Separated (*.CSV), Tab Separated (*.TAB), and Delimited Text
(*.TXT) all offer the same capabilities, just using different column de-
limiters. The Delimited Text option, of course, allows you to choose a
custom delimiter. This is useful when you have special characters in
your data that might otherwise be misinterpreted as a delimited us-

ing the other methods.

Fixed Column Width

This method will not use a de-
limiter; instead, columns will
end after a specified number of
characters, defined in the
“Default fixed width size” field.
For instance, if your default size
is 50, any columns that run be-
yond 50 characters will be trun-
cated; any columns with fewer

XML Data
Data is exported to an XML format of
<Data_Table>
<TABLE_NAME>
<col_name>data</col_name>
<col _name>data</col name>
<col_name>data</col_name>
</TABLE_NAME>
</Data_Table>

HTML Table
Data is exported to a simple HTML table. This is useful when you want
to include your data in a web page or publish straight to a web server.

@ Data Export Wizard

Select Output Options

Select options forformatting the output of exported data.

Qutput Format

[50L Script

Column delimiter: I:I
[]

String quote character:
Use column names for a header row

Always guote strings/char

Schema: | ~
7

SQL Script
=5l Datais exported to a series of

g; SQL INSERT statements. This is

useful when you need to pre-
serve the data type of your data.

CEELE I (Using some other formats, Like
b= | | | Microsoft Excel, will convert your
database types into Microsoft

Excel types.)

Access Database File

than 50 characters will be pad-
ded with spaces to 50 charac-
ters. This is a special output for-
mat that you should only use if
you will be reading the data
from a program that’s designed
to look for new columns based
on the character position in the
file.

[ Fully qualify object name

Default fixed width size: 50 [ include oL

Western European (Wind... |

Read rows increment:

File encoding:

< Back ” Mext = ][ Cancel ]
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This method exports data to a
table in a new Microsoft Access
file (*.MDB or *.ACCDB).

Create as New Table

Similar to the SQL Script method,
this is useful for preserving data
types. The resulting script can be
used as a backup or to create a
copy of your table elsewhere.

Export & Import



Excel

There are quite a few options that you can configure in the Excel ex-
port type.

Begin with selecting to use either a file or an instance. The difference
here is that a file can be anything you’ve saved before or it can be a
totally new file; choosing “Excel Instance” will let you pick between all
of the open Microsoft Excel files. Regardless of which one you
choose, you can choose to use a new worksheet or an existing work-
sheet. If you choose an existing work-

The new Microsoft Excel 2007 file format (*.XLSX) is not supported
yet in Toad for Data Analysts. Therefore, if your data is greater than
64k rows, either use one of the delimited formats or use the “Add
Excel worksheet if row limit reached” option. This will allow your
rows to “spill over” onto new worksheets.
The date/time suffixes supported by Toad . Add Date/Time suffx to flename
for Data Analysts are helpful for keeping [ ||

. . . Date and Time: -MM-dd HH
historical copies of your data as well as not D:E:a&w;m:w(fj‘;‘;" mm-ss)
overwriting files.

sheet, you can also choose to export the
data beginning with a particular cell. This
way, you don’t have to overwrite that
worksheet.

@ Data Export Wizard

Select Excel Output Options
Select options for exporting to Bxcel.

Destination

If you want your column names included ©@ Excel file:

() Excel instance:

On the next page you will
be presented with two
choices: save the tem-
plate and/or go ahead
with the export. If you
plan to do this exact

()

in the export, check the “Use column

|C: \Wsers\Daniel\Desktop\training\ADDRESS . xls

B

same export again in the

names for a header row” checkbox. Be
careful though—if you’re exporting to a
certain row and column, you may not

Use column names for a header row

Header row fill color: [ LightGray n

future, or if you want to
use these export settings
in an Automation script,

[] Add Excel worksheet if row limit reached

=] 33 File: C:\sers'\Daniel\Desktop'training \ADDRE. ..
want a column header. D8] Workbook

B Sheet1
Tip: To build an Excel

report that you can re-
fresh on a regular basis,
use the Excel export
method to place the data

El e et |

Beagin Export At

Column: Row: 1 =

Existing File

you should save the tem-
plate. Optionally, you can
also export the data at
this point.

[ Add Date/Time suffix to filename

Once your export is com-
plete, you will be pre-

into a specific worksheet
and save the settings as a

sented with a confirma-
tion screen with a link to

[ < Back ][ Next > ][ Cancel ]

template. Then you can
add it to automation.

Toad for Data Analysts
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your Microsoft Excel file.
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Import Wizard

You can access the Import Wizard from the Tools menu under the
Import sub-menu. There are three options here: Import Wizard, Open
Import Template and Execute Import Template.

Export 3

Open Import Template...
Execute Import Template..,

Import and Export Tem-
plates are nothing more
that a saved copy of your
Import/Export Wizard
settings. This way, you
can create any number of
templates to cover all of

I

You can add as
many files to this
list as you want,
but you can only
dosooneata
time. This is be-
cause you need to
specify unique set-
tings for each one.
In this way, you
have granular con-
trol over exactly
where and how
your data is im-

your common import &
export scenarios and exe-

ported.

£ Data Import Wizard

Import File

Import objects:

«/ "ADDRESS.xls" into "QUEST _STAGE.ADDRESS"
+/ "CONTACT.xls" into "QUEST_STAGE.CONTACT"

Select thefiles to import. Once you add afile, you are automatically guided through configuration o
the file. Once you complete configuration, you are redirected to this window to add additional files.

Add File...
Edit Import

< Back ][ Next >

[ Cancel

cute them one at
a time with a sin-
gle click. If you

422 Data Import Wizard

File Format
Specify the file format and conversion options for the data.

regularly import or export the same information using the

same settings, this will save you lots of time. In addition to
being able to execute these templates directly from this menu,
you can plug them into Automation to get even greater time-

saving benefits.

Supported Import Files (.csv®: =

Supported Import Files (*.cov™ s ™ fil: ™ by ™ oml; ™ sd)

Comma Separated Values Files (*.csv)
Excel Files (*.xls)

Flat Files (*.fil)

Text files (*.tut)

XML files (*xmil)

AML Scherma Definition Files (*.xsd)
All Files (*.*)

Toad for Data Analysts

Input File Format

File data format:

{Excel File ir

Column delimiter: l:l

String quote character: l:l

[¥] Column names as header row [] Empty fields are null

. First data row: 2 e

The Import Wizard be-
gins with a welcome e encocing:
screen and then a Processing row count:

screen asking you to
provide one or more
files for import. The list
of supported file types
is seen on the left.
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[ < Back ][ Mext > l[ Cancel

)

Once you pick a file,
the next screenis a
confirmation of the
file type and its char-
acteristics. Depending
on the file type, differ-
ent options will be
available. In the case
of Microsoft Excel, as
seen to the left, you
can specify the first
row of data as the
column names,
choose which row to
begin reading data,

treat empty fields as NULL fields, verify or change the file encoding
and choose how many rows to process at a time.

Export & Import




@ Data Import Wizard @
. . select Target o
Once you’re comfortable with these settings, move on to the next Chmeagmdmbasmblefmtheimmedﬂle, ag
screen where you can take a peek at your data. This screen will dis-
play your data in a tabular fashion and allow you to specify a starting "?"‘:'”hg'e SEIEE ‘-"’i”i'le”e“‘ '3"‘7’ |
Cnema: able name:
position for the import. (Whereas the previous screen asked you to ST ST E shemer | |
specify where the data starts, this screen is asking you to define the e
data you actually want to import.) In the case of Microsoft Excel, you ADDRESS o
. ADDRESS_ARCHIVE Column Information
can choose to import data from more than one worksheet or even a CHAR_TEST s ]| e
i i E * [NVARCHA LS
selection of certain worksheets. COURSES _TEL
CUSTOMER.
DELETED_ORDERS
& Data Import Wizard === DELETED_ORDER _ITEMS
= HR._MANAGERS
File Preview R HR_MANAGERS_OLD
Select location from fileto startimport. / ITEM i
Allowed Sources Select Start Position For Each Source ck |
Column: Row: 15
CONTACT_ID CUSTOMER_ID ADDRESS_ID FIRST_MAME LAST_NAME SEX HC ~ I h bI . . d Y . T d
1723 I = T T n some cases, the table you want to import into doesn’t exist. Toa
2381 5 169 Daman  |Ssndstum |F |(3 for Data Analysts can help you there, too. Instead of choosing an ex-
1816 o 27 Angeine _|Festwood |F_|(6° isting table, use the “A single new table” radio-button on the right of
1729 121 105 Rosetta Spriggs M (5 . .
e P P Hatty Chinn M7 the window. Here you can specify the name
1350 “ 27 Hetty Cartwright |M | (% of your new table as well as the schema/user i
1853 11 185 Pai ¥ M 6 . o . . i
= i = e o L that will own the table. This is designed tobe /P . |
2 <] : used for quick and simple imports, so you are Remember, as with every-

limited to a single data type for all columns in thing in Toadvor Data dna:
[ <eeo [Ttz [ concel | the table. If you need to get specific with /VSt,S’ hE e only perform
your data types, you can create the table actions in the database for

The followi is wh ide the destination of with the Create Table dialog, available on the Wh/ch‘yquhave database
e following screen is where you provide the destination of your Object Explorer toolbar. permissions. Ask your DBA

data. If you aren’t already connected to the database that you want for help if you do not have
to import data into, stop here. You must be connected to the destina-
tion database when you begin the Import Wizard. That being said,
you still have the ability to import data into a schema/user other than
the user you’re connected as (depending on your database permis-
sions). To switch schemas/users, simply click on the schema drop-
down. If there are too many schemas/users, you can filter them
there, too.

With your destination defined, the next e

screen will give you a preview of the data

currently in that table. This is useful to con-

firm that the data is going to the right place. In some cases you may
want to clear the table’s contents before inserting new data; use the
“Truncate Table” checkbox to accomplish this.
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After clicking “Next,” you’ll be presented with a summary page, dis-
playing what will be imported. If you’re satisfied with this, move to
the next screen. Here you will be presented with two choices: save
the template and/or go ahead with the import. If you plan to do this
exact same import again in the future, or if you want to use these
import settings in an Automation script, you should save the tem-
plate. Optionally, you can also import the data at this point.

The next screen will show you how the columns in your import file
map to the columns in the database. In this example, the import col-
umns are named the same and are in the same order, so Toad for
Data Analysts was able to map them easily. If the default mapping
isn’t right, you can use one of the two options for automatic map-
ping: by position or by name. If it’s still not right, you can map the
columns manually, one by one.

When the import has completed, you will be presented with a confir-
mation screen, such as this one.

|| Column Mapping : Import Finished v U R W maw e =]
Map thefields from the importfile to atable column in thetarget database. .
= Import data summary results:
Map: By Paosition ] [ By Mame
i File field Table Column Description Read Rows  Imported Rows Status File Mame |~
» CONTACT_ID E‘ CONTACT_ID "ADDRESS.xls™ into "QUEST _... 1 0| Error: Inserting ... | C:\Users\Daniel\Desktoplt... |E|
CUSTOMER_ID CUSTOMER_ID | "CONTACT. ¥ls” into "QUEST... 0 0| Mot Started C:\Users\Daniel\Desktop't...
I ADDRESS_ID ADDRESS_ID i @
I FIRST_NAME FIRST_NAME | i
LAST_NAME LAST_NAME I View Event Log Restart the Import Wizard |
SEX SEX There were errors during the operation.
HOME_PHONE HOME_PHONE I
BUSINESS_PHOMNE BUSIMNESS_PHONE
BIRTH_DATE BIRTH_DATE I 7] Do not prompt me again
EMAIL_ADDRESS EMAIL_ADDRESS

If you’ve done things correctly, you should be finished at this point.
However, in some cases you may encounter an error. In this example,
the import data violated a database constraint. Toad informed me
that a database error had occurred and asked if it should continue or
stop. As you can see from the screen above, the import was canceled
after the first error and stopped the whole operation.

<Back |[;,

Once you have the columns mapped, move to the next screen.

Coincidentally, the next screen is where you first started—you’ve
come full-circle, back to the screen where you can choose another file
to import. If you’re only importing one, click “Next;” if you’re import-

ing another file, click “Add File.” This screen includes quick links to the event log (to better understand

the error), the files you tried to import and a link to restart the wiz-
ard.
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Export & Import Exercises

Exercise 1

Purpose - To demonstrate how to export to new Microsoft Access
Database File.

Scenario - You need to build a Microsoft Access database for publica-
tion to users.

Exercise Steps:

Note: We are using the Toad Sample database to export and import
into. In a real world scenario these tables might be on different data-
bases and the connection would change on the import step.

1) Connect to the Toad Sample database. From the Object Explorer,
select the WAREHOUSE table. Right-click and choose “Send To—
Export Wizard.”

2) This brings up the Export Wizard with the table name and type
already selected and displays the second page of the wizard.

3) Select the Access Database File Output type. Click next to view
the data to be exported. Click “Next” and enter the location and
name of the new Microsoft Access file. When the export is done,
check that the number of rows is 50. Click “OK” to close.

4) To view the new Microsoft Access file, create a new connection.
Click on new connection from the top left toolbar of the Naviga-
tion Manager. Choose the Microsoft Access type and select the
access file created in step 3. Click OK to connect. (No user id or
password are needed)

5) You will see the WAREHOUSE table in the Object Explorer. Right-
click and choose “View Details.” Check the columns and data
content.

Toad for Data Analysts
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Exercise 2

Purpose - To demonstrate how to export and import a new table into
Microsoft Access

Scenario - You need to build a Microsoft Access database for publica-
tion to users.

Exercise Steps:

1) The WAREHOUSE_ITEM table is needed in the new access data-
base. Instead of using the Create New Table as all string/
VARCHAR columns we want the same table definition. To do
this, connect to the Toad Sample database by double clicking in
the Navigation Manager.

2) Select the WAREHOUSE_ITEM table, right-click and choose
“Create Like.” Enter the table name of WAREHOUSE_ITEM. Click
on the SQL Script tab and view the DDL script created for you.
Don’t click “Execute” as you are on the sample database and we
want to create on the new Microsoft Access Database. Instead
use the tool button to send the script to an editor.

3) You are probably already connected to the new database from
Exercise 1. To change the connection, go to the bottom Right of
the application and press the dropdown. The current connec-
tions are listed here. Choose the New Access connection. This
changes the current connection for the application and changes
the connection for the editor.

4) Press F5 to execute. To view the new table press Shft+F5. (This
refreshes all windows.) This creates the table with the correct
columns. Now we need to import the data.

5) Change the connection back to the Toad Sample database using
the connection switcher at the right bottom of the application.
Type “Select * from warehouse_item where warehouse_ID <> 2"
and press F5 to execute.

Export & Import —Exercises



6) In this export, we are going to use the contents of the data grid
to do the export. Right-click on the grid and choose Export |
Export Wizard. Choose CSV as the Output format.

7) Click next through the wizard making sure to enter the file name.
When export is finished and you see the Export Summary Re-
sults, click on the link to the export file. This will show you the
contents of the file. Close the file. (Note: A file can not be used
for import if it is open by another application.)

8) Double-click on the New Access database to change the connec-
tion. From the Tools Menu, choose Import | Import Wizard. Add
the file you just created. Click next. The input format should be
fine. Click to view the content of the file. Click Next. Choose the
warehouse_item table. Click Next. (Note: The content should be
empty as this is a new table.) If there are rows, you are probably
connected to the wrong database. Click next to see that the col-
umn mapping is correct. Click Next through the rest to complete.

9) When successful, you can view the imported rows using the
“View Details” on the Object Explorer.

Exercise 3
Purpose - To demonstrate how to automate an export query.

Scenario - You need to export the results of several queries every
week.

Exercise Steps:

1) From the tools menu, choose Export | Export Wizard. Click Next.
On the “Select Objects” page, chose the Query file type. From
the Stored Query edit box, navigate to the sample.sql file made
in Editor Exercise 2. (If you do not have this file, change the file
type to “Query” and enter the following SQL.)
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2)

3)

4)

5)

6)

7)

8)

Select * from region;
Select * from address;

Click Next. Choose Microsoft Excel as the output format. (Scroll
down to the very bottom.) Click Next, and on the Excel Options
page enter the path and file name.

On the last page, deselect the “Export data” option and select
the “Save as Template” option. Navigate to a directory and sup-
ply a file name. This makes a *.TXP file (Toad Export file) Click to
close the wizard.

Open an Automation window using the Tool menu or Automa-
tion document grouping button. Add an Export activity to the
automation script.

Double-click on the activity to invoke the Activity Editor. Browse
and select the export template you just created. Click OK. If you
want to view the template or make changes, you can choose
“Edit selected template.” You can also build a new template
from this activity by choosing “Build Export Template.”

Test the script by pressing the “Test” button on the Wizard Bar.
Provide a script name when prompted.

When the script is complete, view the steps in the output win-
dow. Click on the link to the exported Microsoft Excel file. Notice
how each query results was exported to a separate sheet.

Click on the Schedule wizard button to schedule this automation
task weekly.

Export & Import —Exercises



Data Compare & Sync

The following screen is where you pick the tables or views that you
wish to compare. The left of the window is a list of all of the tables in
your source database. Click on a cell in the
“Target Object” column to get a list of the
tables and views in the target database to
compare. You can choose to compare one or
two tables or every one of them with the
“Map All” button. If you want Toad for Data
Analysts to find the matching table for you

Data Compare and Sync is a powerful tool for comparing the data in
your tables and then synchronizing it between your source and tar-
get databases. Don’t confuse this with Schema Comparison found in
some of the other Toad products, however. Those tools will compare
objects in the database and generate scripts to create or alter objects
on the target database to match the source. This is beyond the scope
of Data Compare and Sync which, as the name implies, is solely fo-
cused on the data contained within the objects. This section will take

Tip: The “Map Selected”
and “Map All” buttons will
try to match tables or views
by their name. If your tables
or views are named differ-
ently, these buttons may
not be effective.

you through the tool and cover its general usage.

automatically, use the “Map Selected” button.

You can launch the Data Com-
pare and Sync tool from the
Tools menu under TOOLS >
Compare > Data Compare &
Sync.

The first screen will let you de-
fine two database connections.
Your source is your “master,” or
the database you want to com-
pare against; the target is the
database you want to update.

You can compare between sche-
mas within the same database
(i.e.— user_ato user_b), two
databases of the same type (i.e.
—Oracle to Oracle) or even
across database platforms (i.e.—
SQL Server and DB2). With ver-
sion 2.5, you can even compare
between more obscure data-
bases via ODBC connections.

SEX ="M SEX ="M
I Legend |
I Bb - Compatible ﬂb - Incompatible ﬂ}@) - Can be converted '
[oc ) o)
g |

= ™

—% Select columns, at least one should be a key.

Compare  Source Column Target Column Key to Compare *
EMAIL_ADDRESS (String) |aly EMAIL_ADDRESS (String) 0
FIRST_NAME (String) | aky FIRST_NAME (String) [l

i HOME_PHONE (String) | aky HOME_PHONE (String) [l
LAST_MAME (5tring) aky, LAST_NAME (String) [l =
SEX (String) aky, SEX (String) [ |4

Column Properties ﬂ Source it Target

Mame ADDRESS_ID ADDRESS_ID

Allow Nulls Yes Yes

Data Type SQL_INTEGER NUMBER.

Additional

Source Custom Filter Target Custom Filter

Toad for Data Analysts

You can refine your mappings by clicking
the cell in the “Key Columns” column. This
column must have unique values for the
comparison. If the tool cannot determine
the correct column to use for the compari-
son, then clicking here will give you the
ability to change it.

To change the key column, select the col-
umn with unique values in the “Key to
Compare” column. You can also choose not
to compare a column by unchecking it in
the “Compare” column.

The source and target custom filters accept
standard SQL syntax. Use the syntax you
would use if you were writing a WHERE
clause, though omit the word

“where.” (See the example to the left.)

Once your mappings are defined and your

key columns and filters are defined, click
“Next.”

Data Compare and Sync



Data Compare and Sync

The next screen allows you to define particular options for the com- here, that type will not display in the summary later, thus reducing

parison. These options apply to all tables or views in the comparison the amount of information to sift through.

and are separated by options for the comparison and options for the

synchronization. After you click “Next,” the comparison will begin. You will see a
screen with status indicators, showing you what the tool is doing

The comparison options allow you to specify things that you may along the way. Once complete, you should see a summary screen like

want to ignore. For instance, if your MySQL database (source) has a this:

fixed width column of 50 characters but your Oracle database
(target) has a variable width column, then each and every record {2 Dats Compare ""r'za_ L
would appear as different because the MySQL records are padded
with spaces to fill the fixed width column. By unchecking this option,
you can omit the spaces and get an accurate comparison.

Data Compare Wizard Complete

The Data Comparewizard completed with the following results:

. . . Mame 5 = - - ey
The Record Types to Synchronize options allow you to specify o
. .. ey . . . contact - CONTACT 0 o] 73 294|0
whether you want to include missing, additional, different, identical %
d f| t d . th h N t |f h k t £ customer - CUSTOMER 0 0 85 15|00
and conflict records in the synchronization. If you uncheck an option order_tem - ORDER_ITEM 0 o =70 smEm|op

Gomiomeress o T

Select Comparison Options
Select comparison options and types of records that you want to synchronize.

[=l Comparison Options -
Ignore Case in Text Data F
Ignore Whitespaces

Ignore BLOB Columns

Ignore GUID Columns

Ignore Timestamp Columns

Ignore Auto-increment Columns (SQL Server only)
[=I Record Types to Synchronize < Back [ Finish ] |

To close this wizard, click Finish.

m

OE @ EE =

Indude Additional Records
Indude Missing Records
: 7 L .

Indlude Different Records Here you can see how many records are different on both the source

Indude Identical Records R L L. L.

o cdien 5731 2 and target, additional (missing on the target), missing (missing from
Comparison Options the source), equal and in conflict. Conflict records are records that
Options affecting compare process. These options do not affect synchronization, could not be compared because of something like a data type differ-

ence.
Ready to compare. To complete make sure you have enough space for temporary files on you hard drive.

Teis | | canel |

’ < Back
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{) Toad for Data Ana
File Edit View DataCompare Tools
|1 Understand

With the wizard complete, the Data Compare & Sync sum-
mary widow will be displayed. It has quite a bit of informa-

Window Help

12> Query 3> Report

|4 Automate

Data Compare and Sync

- Search Google Code Search .

Tools

tion on it, so we’ll cover it in pieces. — o
5 | & . | 5 [O xe Quest_Stage) - Direct

[*|. & 2 ERDiagrammer 5] Database Explorer .. Query Builder [ Editor i) Automation () Web Browser

Summary View 2 Data Compare Untitled1~ b x
The uppermost section of the window is a summary of = ||[Bismdvonze e Name S Diffrent = Additorsl = Missing = dentical A\ Confict
each table or view that you compared. The checkboxesto = Ll e ARG ST AR CONTAST i i 2 e IR

. . . e | P quest_stage customer - QUEST_STAGE.CUSTOMER 0| 85/ 15 ofo
the left are used to include that comparison in the synchro- : | T |quest stage order_item - QUEST_STAGE.GRDER _ITEM of 0 13730 57338 oo
nization, later. You can see a summary of the differences
between the two objects in the columns to the right.

g =S D sttus: Eaa = A ‘ Where clause filter: 4 Mot specified | | Not specified

Source : gquest_stage.customer

Detail View

Target : QUEST_STAGE.CUSTOMER

>

The next section (in the middle) is where the de-

tails of the comparison in focus is displayed. To ﬂ-

show records here, click on one row in the summary view

above. Here you will see each record displayed with the

source on the left and the target on the right.

7 CUSTOMER_ID CUSTOMER_NAME Status ¢ CUSTOMER_ID CUSTOMER_NAME
- Sps Transaction Services Inc
- | 4|Farbensa DeCv.
- | 5 5as Morge Asa
| - | 6| Surat Canning Public Company Li...
_- ‘ - | 8| Perpetual Uk Smaller Companies ... _
Row Viewer =] I
Source Column Source Data Target Column _Target Data [
» 7 |cusTovER D | |cusTomER 1D 1

& | CUSTOMER NAME |

sjeddiug apon [£] | 585530044 PUNOUEIER E 1| Op T UED 3L, Q“ suoiPaUUeD 414 88 |

| CUSTOMER _MAME : Sps Transaction Services Inc

Row Viewer
The lowest section of the window is where you can view

the differences in a single row. This is particularly useful

Cell Viewer |Rnw Viewer |

when you have a row with many, many columns.
Using this view, you can easily see the differences

el el

Record 1 of 85

U4 New [ Open .ZEdit I AddtoProject EI Synchronize

side by side. W Attty
Cell Viewer 3
Behind the Row Viewer is the Cell Viewer, which gives you an even
more granular view of the differences, cell by cell.
Data Compare & Sync Toolbar 4
1) New Compare: Use this to start @ 5
over with a new comparison. S | ——
L TR o
2) Change Data Wizard: Opens the 2 | - - 6

current comparison wizard so you
can alter the settings

Qe &
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action://ToadAnalyst/ToadAnalystOpenDatabaseBrowserDocument

)

-_ =

)

4 MySQL.quest_stage [ODBC] | [ 127.0.0.1.QUEST_STAGE [racle] Ready

Refresh: If you've saved the comparison, or if significant
time has passed and there may be changes to the data in
your tables, you can refresh the comparison with the cur-
rent settings.

Select All: Select all of the comparison rows for the sync.
Show/Hide Differences: These buttons will show or hide
tables with these differences in your comparison results.
Synchronize: Green is for “GO” - when you’re ready to
synchronize the data, use this button to launch the Syn-
chronization wizard.

Data Compare and Sync



With your comparison complete, the next step is to synchronize the
data. Use the green start button on the toolbar to launch the wizard.

The wizard will take you through the various options to get the data
synchronized. The first question is whether you wish to make the
target like the source (standard) or make the source like the target
(reverse). In most cases you will want to choose the default here and
make the target like the source. You can use the color-coded data-
base icons to help you remember which is which.

@ Synchronization Wizard

=)

g

Select Synchronization Direction
Specify the direction of the synchranization.

Synchronize data in the following direction

@ Synchronization Optiens

[ oropfereate foreign keys
|| rop/create primary keys and unique constraints
[ Disable triggers
D Use transactions
3) Wrap all script
Wrap each table
Wrap each statement

Wrap each statements

. “.’L-I'JA»-._\ MM’A‘M\‘J\‘M—’-A |

The “Options” button at the
bottom of the wizard will
allow you to configure
some advanced options.
While useful (or necessary)
in some cases, they can
affect the integrity of your
data if used improperly.
Make sure you fully under-
stand the implications of
these options before you
use them.

With your options configured, click “Next.” The following screen will
display the progress of the script creation. Once that’s complete, you
will be presented with one final screen of the wizard. This last screen
will show you a summary of the script’s contents and give you three
options: execute it in the Toad SQL Editor, run it immediately or take

@ Make target like source

3+8-080

) Make source like target

O MySGL quest_stage [DDEC]
W 127.0.0.1.QUEST_STAGE [Oracle]

Specify the file for output script:
|C:V..lsers‘-,Danie\\,ﬁppDaiﬁ\Roaming\Quest SoftwareToad for Data Analysts Beta 2.5VPlugins\Data E| [ Browse

Usethe following optionto migrate only a portion of the database context:

[ Generate SQL script only for: | = | |DEI cent from top |

The wizard creates a script which you can optionally choose to exe-
cute at the end of the wizard. If you want to change the default loca-
tion of that script, there’s a place to do that here.

Finally, at the bottom of the window is an option to generate the SQL
script for a certain percentage of the records. You can also choose to
write the script for nrecords or for every nrecords. This gives you the
ability to see a small representative script instead of the full script if
you want to verify things first.

Toad for Data Analysts

no action. If you want to inspect the script or make any changes,
choose to open it in the Toad SQL Editor. Otherwise, if you're ready,

@ Synchronization Wizard

Specify Script Actions
The synchronization script was successfully generated and can now be used.

Select how to use the synchrenization script:
'@ Open the script in the Toad Editor
Script will be loaded into RAM, At least 3 MB of memary will be required.
[ Delete seript file after opening

" Run script immediately
Script wil be executed against database from the wizard.
Delete script file if succeed

" Take no action
|® S0L Script Detals

INSERT statements - 0
UPDATE statements - 13,888
DELETE statements - 0

Script size 1. 13 MB
To open folder containing the script didk here

execute the
script to syn-
chronize your
tables or
views.

==

0

Next, the Data
Compare &
Sync window
will refresh to
verify that the
objects you
compared are
indeed in sync!

< Back H Next > ]| Cancel i
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Data Compare & Sync Exercises

Exercise 1
Purpose - To demonstrate how to compare two tables.

Scenario - You have a transactional database with data that is copied
to the data warehouse each night. You need to verify that the data
was copied properly.

Setup Steps:

We will simulate having two databases in this example. In order to
get the scenario to work you must connect to a database where you
have permission to create a table. Follow these setup steps.

1) Connect to the database.

2) Right-click on a table and click “Create Like”

3) Give the new table a name like “[o/d_name]_COPY”

4) Click “Show Script” and then “Execute”

5) Right-click on the original table and click Send To > Export
Wizard

6) Export the table data to a Microsoft Excel file

7) Open the Microsoft Excel file and remove a few records

8) Right-click on the NEW table and click Send To > Import Wizard

9) Import the exported data into the NEW table

Now you should have two tables in the same database with the same
structure and nearly the same data.

Toad for Data Analysts
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Exercise Steps:

1)

2)

3)

4)

5)

6)

7)

8)

9)

Open the Data Compare & Sync wizard and make connections to
the same database (assuming you followed the directions to set
up the scenario, your two tables are in the same database and
owned by the same user).

On the “Select Objects” screen, find your source table from the
setup steps and select the NEW table on the right.

Click on the “Key Columns” ellipsis [...] to verify that the com-
parison will use a column with unique values. Click “Next.”

(Do not alter the “Select Comparison Options” screen.) Click
“Next.”

When the wizard completes, you should have identical records
and a few missing records (the records you deleted from the
Excel file).

Next, inspect the records that will be synchronized.
Click on the “Synchronize” button on the toolbar or on the wiz-
ard bar at the bottom of the window.

Keep the source to target synchronization in the first screen and
click “Next.”

When the script has been generated, choose the “Run script
immediately” option and click “Next.” (WARN/NG—Ensure that
you are updating the NEW table you created and not a table
with real production datal)

10) When the synchronization is complete, click “OK” when asked if

you want to compare again to display the differences.

11) Verify that the tables are synchronized.

Data Compare and Sync-Exercises



Difference Viewers

Toad for Data Analysts has two main tools for comparing data: Data
Compare & Sync and the Difference viewer. The former is covered in
the previous section. This section will be devoted to the latter which
comes in two forms: the Text Difference Viewer and the Data Differ-
ence Viewer. They are both essentially the same, though each is
dedicated to a specific type of information.

Text Diff Viewer

The Text Viewer can be opened from the Tools
menu under Compare > Text Diff Viewer. Simply
use the ellipsis [...] to browse for a file on each
side. As soon as the second file is opened, the two
files will be compared. You can see the differences

Tip: The Difference
Viewers are just that—
viewers. If you want o
make changes to your
text or data, you need
to edit them outside of

Data Diff Viewer

The Data Diff Viewer is very simi-
lar to the Text Diff Viewer,
though launching it is different.
To get started with the Data Diff
Viewer, you first need a data set.

From within a Query Builder or
SQL Editor window, either create
a new query or open a saved one
and execute it. With data in the
data grid, right-click on the data
and browse to the Compare To

quickly as Toad for Data Analysts highlights each this tool. sub-menu.

one.
% Data Compare Untitled1* ~* ) Diff Viewer 4 X
|C:\J_Isers\,Dan\el\,Deskbop\,DemD\test.sqI | - El 1 ‘C:\J_Isers\,Daniel\,Deskbop\,Demo\best_l.sql | - El

SELECT CONTACT.CCNTACT ID,
CONTACT . LAST NAME,

SELECT CONTACT.LAST NAME,
CONTACT . CONTACT ID,

H

9867 | 5/8/2008 12:00:00 AM

Copy Rows I_D:UD AM
Copy Cells DL
j‘ Print... I_D:DD AM
10:00 AM
Export ¥ 10:00 AM
e Quick Export  » |o0:00 AM
Send To » [00:00 AM
Show » (00:00 AM
Read Lobs Eile [
Read All Rows 00:00 AM

9708|8/23/2003 12:00:00 AM

You can compare the result set to another
Toad Editor file (*.TEF), another result set in
the current file or to the result set of an-

SUM (CRDERS.AMOUNT EILLED),
5UM (CRDER_ITEM.QUANIITY)

FROM QUEST STAGE.ORDERS ORDERS,
QUEST_STAGE.ORDER_ITEM CORDER_ITEM,

5UM (CORDERS.AMCUNT BILLED),
SUM (ORDER_ITEM.QUANTITY)

FRCM QUEST_ STAGE.ORDERS ORDERS,
QUEST_STARGE.CRDER_ITEM CORDER_ITEM,

QUEST STAGE.CONTACT CONTACT

QUEST STAGE .CONTACT CONTACTS

WHERE (CRDERS.CONTACT ID = CONTACT.CONTACT ID)
AND (ORDER_TITEM.ORDER_ID = ORDERS.ORDER_ID)
GROUP BY CONTACT.CONTACT ID, CONTACT.LAST NAME

I e

S}

Toad for Data Analysts

WHERE (ORDERS.CONTACT ID = CONTACT.CONTACT ID)
RND (ORDER ITEM.CRDER_ID = QRDERS.QORDEER_ID)
10 GROUP BY CONTACT.CONTACT ID, CONTACT.LAST NAME

e

5
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other file already open in Toad. This is very
useful when you want to quickly compare
the results of different queries. You can even
use it to see the changes in a query’s result
over time. Save your query in either the
Toad Editor format (*.TEF) or in the Query
Builder format (*.TSM) and choose to save
the results with it when you click “Save.”
This way you can compare the results when
you run it again at a later date.

Diff Viewer



Difference Viewer Exercises

Exercise 1
Purpose - To demonstrate how to compare two data grids.

Scenario - You have a query which returns a specific set of records.
However, your boss tells you that something in the reports you’re
distributing has changed. You need to verify that the data in your
query isn’t changing over time.

Exercise Steps:

1) Connect to your database.

2) Create a simple query (or open a query from disk). Ensure that
the query contains at least one column with unique values.

3) Execute the query to obtain a result set

4) If you're using the Query Builder, save the file as a *.TSM file and
choose to save the results. Alternately, if you're using the SQL
Editor, save the file as a Toad Editor file (*.TEF) and choose to
save the results if prompted.

5) Close & reopen the file. Verify that the data is saved with the
file.

6) With the file open, re-execute the query to obtain a second re-
sult set.

7) Inthe second result set, right-click on the grid and choose Com-
pare To >Set 1

8) Choose the column to “make up the primary key.” This will be
your column with unique values.

9) Scroll through your results to view any differences.

Toad for Data Analysts
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Object Search

Object search can help you quickly locate an object rather than
browsing through a list of objects in the Database Explorer. The Ob-
ject Search window is available from the Tools menu.

Editar

& 9[F

Database Explorer

()
2]

Cuery Builder

2| B oo
*

Object Search

ER Diagrammer

Session Info

@ W .3

DE2 Command Windaw, ..

Object Search searches object
names, table and view column
names, and source code for proce-

dures, functions, triggers, and views.

A string text is searched with your
defined criteria on the schemas se-
lected.

Toad for Data Analysts

Data Analysts - [Object Search’ Untitled1]

File Edit Wiew Tools

Window  Help

To perform a search

Object Search

1. Enter your search text criteria, case sensitivity and location
(starts with, contains, exact match).
2. Select types of objects to search, source code object types and

columns.
3. Highlight the schemas/databases to search in.

4. Press “Search” to do a new search, or “Append” to add to exist-

ing objects.

[T Understand 2> Query  [3> Report

(4, Automate

o

== Ml & | DEBLOS (DEB), HR

. . S0l . = o .
Illl l!i: I-}g ER Dlagrammer o .Q__uerr Builder .E’ag\:htur 4 égt.umatmn

| Aabeueyy) uonebiaen @H dabeuely uorauuos £

Schema

Search Text

rﬁ FTF - v, peabodysi...:21 {peabody) Closed/iﬂ Object Search ]

4 b X

QUESTSOFTW... |

SI_INFORMTM...
5Y5 i
SYSMAN

casesT_

.Ll | Search || Append |

|Starts with il Dcase Sensitive

Search Object Types

v REE
E Yigws
@ Triggers
D Users

|

| Procedures

Cancel

|v| Functions
[v| Packages
[7] 0B Links

\Z| Synonyms

["] Public Synanyms

|v| Waterialized Wisws

| Search Source Code of Object Type

Search Columns

‘ SUBIIEUUET d1- &gﬂ 58558204d punauBaeg E ‘E

|

-

SYSTEM 4 M Tables [ Pracedures || Packages ~
| TEST v_" ||j Triggers D Functions D Materialized Views D Wiews e
| Name Type Parent Schema
. QUEST_TEWP_EXPLAIN el QUEST_sTAGE
| | QUEST_DEMO_PUBLIC PROCEDURE QUEST_STAGE
e ‘QLIEST_OBJECT |FLINCTION QUEST_STAGE
| | QUEST_SL_ALL_IMDEX_COLUMMS iS\"NON\"M QUEST_STAGE
| QUEST_SL_BKGD_10B | SNORYM GLUEST_STAGE
| | QUEST_5L_COLLECTION_DEFINIT... iS\"NON\"M QUEST_STAGE
| QUEST_SL_COLLECTICN_DEF_RE... | SYNONYM GUEST_STAGE
™ QUEST_SL_COLLECTION_REPOSIT... i SYMNONYM QUEST_STAGE
| QUEST_SL_CREATE_RCLE | SNORYM GQUEST_STAGE
| | QUEST_SL_CREATE_SQLTABLE iS\"NON\"M QUEST_STAGE
| QUEST_SL_ERRORS | SNORYM GQUEST_STAGE
| | QUEST_SL_EXPLAIN iS\"NON\"M QUEST_STAGE
f

L_EXPLAIN_FICK

| STHOMNYI

QUEST_STAGE

|E‘1 Cutput ‘

@ AutoCommit =
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Master-Detail Browser

Use the Master Detail Browser to browse data in parent tables and
drill-down to data in related child tables.

Build Master Detail

To build a master detail
result set, add two tables to
the diagram area. You can
drag from the object palette
or right-click and use “Send
To | Master Detail.”

The foreign key joins will be
drawn automatically. Add
joins by dragging one col-
umn to the join column of
the other table. Delete a
join by selecting and press-
ing “Delete.”

Select the columns you
want in your result set. Add
fetch limits or a where con-
dition in the property win-
dow on the right of the win-
dow.

Browsing Data

& Toad for Data Analysts - [Master Detail Untitled1™]

Fie Edt MasterDetal Yiew Tools Window Help

] 5earch Google g

1) Understand 2> Query 3 Report

(4> Automate

Tools

Besaldaif— ]

| Gl 2k i ‘”'g ER Diagrammer 57 Database Explorer " Query Builder | Editor 4| Automation 7| Configuration = il

|+ Oracle

1@BeURy UoBUIT)

[vicITy

[ STATE

[v] COUNTRY

v FOSTAL_CODE
[ REGION_ID

[ ADDRESS_LINE_2

~1}} Master Detail Untitled1™* +dbx
1 P Definition ~ & Properties s
EErE=a EENE]
B REGION — X ==
35 oo Scmple Dote.. EEH e

& [w| REGION_ID
(w| REGION_NAME

ID =REGION_ID

feo!

Limik Fekch 1000

where Condition

subEULE) 14 98 | sassaanig punoibiieg E‘

I
| REGION_ID

| REGION_NAME

wili—

1 MORTHEAST

CONTACT

CUSTOMER
DELETED_ORDER_ITEMS
DELETED_ORDERS

| 2| ADDRESS_ID

J FK_ADDRESS_REGION_ID |

Drag & column header here to group by that column

| ADDRESS

ITEM x|
ORDER_ITEM b

DERS il
REGION -

WAREHOUSE
—| WAREHOUSE_ITEM ‘ ]
I —

| Gelurin Dok o

134 x| 3494 Depart Strest
253 6351 Trafficking Turnpike
269 7169 Ancestry Lane
303 3704 Furrish Drive
265 1019 Carbolic Boulevard
229 2415 Journeyings Strest

£

<

>

REGION_N... CHA.

| Right-click ta add column tatals,

&

W

@ AutoCommit »

Ak e+ =X

Record 1of 5

Table from SQL - Tables can be built from SQL statements.
To add, right-click on diagram and choose “Add table from
Query.” Type or paste in SQL to the editor. Execute if you
want to see the result set prior to adding to the master de-

Add Table fro

Motes...
Remove Notes

Master Detail Browser - Building

Execute the query by pressing the
first tool button. The results is dis-
played in a collapsed result set. To
view child table results, press the
expand button and the child table
can be viewed.

REGION_ID *

1 NORTHEAST
2 S0UTHEAST
3 CEMTRALST
4 WEST

H E3/[E3 I+H

REGION_NAME

REGION NAME

MORTHEAST

FK_ADDRESS_REGICH_ID

;;EIUN D *

o ADDRESSID | ADDRESS | REGION_ID
2 1726 Law Street 1

7664 Harp Cirdle 1

5279 Applause Strest 1

9411 Denatations Strest 1

| Note: When expanding to view the child ta-
ble, a query is executed to retrieve only that
child table. To retrieve all rows at once, press
the second tool button, “Fetch All Data.”

tail. Click “OK” to add. The query will be used as a table. The
diagram will show the columns of the query. The name of
the table is SQL (timestamp).
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Master Detail Report

i

To build a report from a the Master Detail window, press
the “Generate Report” tool button. Choose the columns

and set the grouping levels.

datasetl

“|123] REGION_ID

REGION_MAME
--[Z] Parameters

Adding Detail band

To add a child detail band, right
click and choose “Insert Detail

Report -> %Child Table

Name%.” The Child Table Name
is assigned in the Field list. (See ~
highlighted table name above.)
Add data to this area by drag-
ging in any of the columns from
the child columns in the field

list.

Toad for Data Analysts

Master Detail Fields

All of the data must be retrieved to
design a report, so this may take a little
time. When done, the Toad Data Re-
port Wizard will guide you through the
setup. When the designer is opened,
the field list will display the Master
table, with the child table columns in
line.

Group Summary Band
Add a group summary band by right clicking on the detail band, and
insert group footer. Drag a column to that band and set the summary
function, as well as range of summary. In this case the range is
Group. Summary ranges include page, group and report.

Bl detailrand

Delete

Insert Band

Paste

Master Detail Browser - Building

3

Insert Detai Report  »

Z0arm

3

& Toad for Data Analysts - [Report Untitled*]

Flle Edt Formak Yew Tooks Window Help

|| search Goagle

(1> Understand 2> Query [3) Report | %> Automate

= A= R ||#] Toad sample Database - Fl | 73 ER Disgrammer _*. Query Builder |3 Edtar |1 Automation |
|l | | i | 33 g |[Tmes bew Roman | F
| [ Report Urtitleds* ' [15 Report Untitledd™ - a0 x|k
i,TDu\hux e i i i i e | R "?":é,'-’
G | rendardContrcls |21 ) |5 aponteaderBand [one band per ispor] =) datasett g
S|/ K Pointer +/[E) ACDRESS 5
= qr - e (a]

=/l AtLad - Toad Data Report Shes| Ko z
45 | [ CheckBox . BREBERE LR LR LB habb (=5 F_aDORESS FE... | &
= = (i ADDRESS B

2] Rich Text = = [El pageHesdeBandl [one band per page] | &
L fiz3] ADDRESS B

|l Picture Box

H TopMargin
ReportHeader

PageHeader

Ul

Deetail

GroupHeader

GroupFooker

(T { Oyl

RepartFooter

PageFooker

E

EottomMargin

[

D ADDE J [FK. ADDRESS RRGION TN ADDE S TFK ADDRESS T REGK

bl xrPic...

- | Friday, July 24,2009

-z REgIM D
M o o L = paefon o
Tabl - .
£ Tobie ¥ 2port generated by Toad for Data Analysts o] REGION_NAME
/" Line 77 Parameters
L) shape
1l Bar Code
2
Zip Code:
i3 2 B DetaiFiepat - "REGICH
|Explorer -1 Tnsert Band M |Properties
=8 Toadpatare. . ] —— ” TSI A Urbsind 1 Detail ]
iR reporttie... - o e m =
¥ T 7
5 pagetiea. . R S . L F_ADDRESS_REGION_ID 1
= = Bl pageFooterBiand! [one GandPe page] ance SRE

. srlinel S
= [E] etaire...
=8 [;;ta" o¥] dataset1
s

Ayxe || M Desianesr &) Previsw G HTML View |

2B ramaEan

detaiBand! { Height: | Zaom Factor: 100%

Backgro [ Trans... | 7|
Border C I Contr...
Border W 1

Borders Mane

|+/Font  Times New ...

Faregro. NI Cortr..
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@ AukoCommit
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Master Detail Report Exercise

Purpose - To demonstrate how to build a Master Detail report.

Scenario - Using the Toad Sample database, build a report that shows
the oldest addresses by region and gives the count. The oldest ad-
dresses are the address IDs less than 50.

Exercise Steps:

5)

To connect, double-click on the Toad Sample database .
Select the ADDRESS and REGION table. Right-click and choose
“Send To | Master Detail Browser”

Choose the columns you want included in the report.

Filter the address_id column so you only retrieve IDs less than 50.

To do this, select the ADDRESS table. Then add “address_id < 50”
in the where condition property on the right. (Docked window)

Click the browser button or press F9.

ol Lt el
B Ede panteDetel Yw [k gedom ek -] Smmch Goaxge 3 |
U Understand | 20 Query 30 Report 4 Automate Touls
el | ¢ G | a1 T Sere inthne * @ TAERDigewer . QuerpBukle  FEde || Agenation | Cobgasion v o

S sl | 23 | npaow iy &

Naigation Managar R

4 b X
oo g -3
= ] Access

s oo Soric Dotobine |
O e

# BEGIOH_ID
o RO A

& oEnI0G (e, e v ALCRESS_LINE 2 L. Feteh 1000
5 [
REsion o o pz] ¥ STATE Whers Condiion address_d < 50
o COUMTRY
# POSTAL CC0E
= o REGICN D)
Cfect Exploves | Project Mange:
DiProgran FlesiQuest Softwe 2 0
Fox
T Guory | Dolsbise
x —
! el i ]
Hame e 1 N THERST
] comtact FE_ACCRESS, REGION_ID
customn
DELETED ORDES_ITEMG g ik fmaxder bere o grougs by Lt ockms
- ®
DELETED oDERS & s o 3

1 trem
| RDER_ITEN
CEDERS 4

. L

7 7530 Reinserts Strest

4 VIS4 Extrgute Cocle
A0 11436 Plakters Crrle
52 6L Pervades Strest

Right-cick 0 add cokumn botals.

J @ mom o4 h k= R | of 5 (ool Fer mare)
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5)
6)

7)

8)

9)

10)

11)

12)

Send data to the report designer by pressing on the tool but-
ton, or right click “Send To | Report Designer. “

In the Toad Data Report Wizard, select all of the columns and
choose to group by region name.

Add a child detail band. To do this, right click on the detail band
and choose “Insert Detail Report | FK_ADDRESS_REGION_ID.”
This is the name the designer has assigned to the child table.
The new band will be added in green. (Your table name may be
different.)

From the Field List window, drag the FK_ADDRESS_REGION_ID
table to the new child detail band. It will place all columns in
the band.

Change the spacing of the band by moving the band handle in
the margin. A hand will display when your mouse is over it.

To add a count of how many addresses are in a region, right-
click on the detail band and insert Group Footer band. Add the
address_id column by dragging from the Field List. Click on the
right arrow and click on “Summary.” Using the Summary Editor,
set the function to Count. Change the format string to Number
and check to see that the summary is for the group (not page or
report).

Do the same actions covered in step 10 for the report footer,
except change sum to report total.

Click on the Preview Tab to review your report. Export your
report in PDF format.

Toad Data Report

Report generated by Toad for Data Analysts

Master-Detail Report-Exercise



AppendiX A _ |nSta"ati0n Installation—Using the Installation Wizard

Using the Installation Wizard

Full details of installation are published in the Toad Install Guide. This
guide covers desktop (client), server, Citrix and user requirements.
Toad for Data Analysts can be installed silently or repackaged for

multiple desktop rollout. An individual install is easily done by follow-
ing the Install Wizard.

There are two install types — normal and Read-Only. A Read-Only
install is used to disable features in the application that could change
database objects. Choosing Read-Only will disable all create editors
(table, view, etc), execution of insert, update, and delete state-
ments, importing data, and editing of data in the grids.

i Quest Software Toad fon Data onalysts 2:5 Setup

% Quest Software Toad forData Analystst Sisetap

Welcome to the Quest Software Toad for Data Analysts 2.5

Install Type
Installation Wizard

Select install type.

It iz ztrongly recommended that pou exit all Windows programs before running this setup program.

Click Cancel to quit the setup program, then clogse any programs you have nning. Click Mest to Select Read-only instal if you want to use Toad as a read-only ool for Al
contiue the inztallation.

database connections, which means functionalities such as create, alter,
and drop database objects are all dizabled.
WORNIMG: Thig program is protected by copyright law and international treaties.,

_ A N . Read-only Install
Unauthonized reproduction or distibution of this program, or any partion of it, may result in severe O - ¥
civil and criminal penalties, and will be prozecuted to the maximum extent pozsible under lam.

Wize [nstallation Wizard

I Mest> [ Cancel J

< Back “ et > I [ Cancel
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Most of the features of Toad for Data Analysts allow saving your
work to file. These proprietary files are saved with a defined exten-
sion. During install these file extensions are registered to this newly
installed application. SQL scripts (*.SQL) can also be associated to
open in Toad.

i Quest Software Ioad|for Data Analysts . Sisetip

Register File Extensions
Register the following file extenzions with this application.

Common File Extensions

Toad File Estensions

.taz [Toad Automation Script]
tes [Toad Command S cript]
tdr [Toad Data Report File)

tef [Toad Editar File)

ter [Toad ER Diagram)

tpf [Toad Project Manager File)

[ .51 [SAL File)

Maote: Dauble-clicking any of
the selected file types will open
the filz in this copy of Toad,
regardlezs of other Toad

tip [Toad Schema Repart File) installations.
tam [T oad Query Builder File]
.#pn [Quest S aved Explain Plan)
Wise [nstallation Wizard
[ <Back |I Hewt> | [ Cancel |
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Installation—Using the Installation Wizard

After the files are installed, Toad optimizes the code for faster load
and execution times. Toad is a .NET application and this part of the
install creates native images, which are files containing compiled
processor-specific machine code, and installs them into the native
image cache on the local computer. This process can take several
minutes and is normal.

i Wuest Sottware Toad for Data Analysts 25 setip

Updating System

The features you selected are currently being installed,

Toad is optimizing the code allowing the application to load and execute
fazter. Thiz may take several minutes. Please wait....

Optimizing Toad. exe and dependencies ...

Wize Installation Wizard

Cancel

Installation



Upon launching Toad, you may be asked to provide a license key to
enable the application. The key is provided through email by Quest,
and can be copied and pasted into the edit boxes shown.

Trial versions of the software are installed with a 30-day trial key.
Trial extensions can be requested from the Quest website. After pur-
chasing Toad you can install the commercial version. This is a sepa-
rate install and application from the trial.

Patches of the same major release (IE: 2.0—2.1) uninstall and up-
grade into the same directory. Major releases are installed separately
and can be installed side-by-side. For any installation issues please

contact Quest support.

1 for Data Analysts 2.1

m[g]

C. ALL RIGHTS RESERYED,
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Installation Requirements

Desktop client recommendations are 1 GB RAM, 1 GHZ CPU, and 250
MB disk space. Both admin and power users can run the installer.

Toad for Data Analysts version 2.0 and 2.1 requires the .NET Frame-
work 2.0. Toad for Data Analysts version 2.5 requires .NET Frame-
work version 3.5 SP 1. The installer checks for this dependency and if
not installed, provides the link to the Microsoft install media. (Note:
Windows 2000 does not support .NET 3.5.)

Before you can export to Microsoft Excel, the Primary Interop Assem-
blies (PIAs) for your version of Microsoft Excel need to be installed. If
the PIA is not installed, a message prompts you to download and
install.

Database Client Requirements

Oracle - Toad for Data Analysts can connect to Oracle using TCP/
IP and does not need any client files. However, for best perform-
ance and viewing and handling of advanced data types, an Ora-
cle OCl client needs to be installed. All 9i and later Oracle clients
are supported. (See connection section for further details re-
garding Oracle Instant Client.)

DB2 - Toad for Data Analysts installs its own copy of the DB2
client. This client is compatible with any existing DB2 clients in-
stalled.

SQL Server - No additional files are needed.

MySQL—No additional files are needed.

ODBC - For connecting to any other database an ODBC 3.0 com-
patible driver needs to be installed. Please refer to the database
manufacturer for download and installation.

Installation



Appendix B - Resources

Toad Word

Whether you are new to Toad, or a veteran user, Toad World pro-
vides the latest educational and training materials, including videos,
technical briefs, white papers, expert blogs, podcasts, user forums
and tech tips from Toad-family product experts.

http://www.toadworld.com/

Communities

Inside Toad for Data Analysts is a place where you can communicate
with other users and the Toad for Data Analysts product team. The
site belongs to you - it's where our collective ideas will significantly
influence the direction of Toad for Data Analysts and where you can
get help with issues related to product usage.

http://tda.inside.quest.com
(Link also available from Web Browser in Toad for Data Analysts.)

Quest Software

Find out more about other Quest Products at www.quest.com. To
purchase Toad for Data Analysts, or extend your trial, see the Licens-
ing window from the Help window. Alternatively, you may visit our
eStore:

http://estore.quest.com

Toad for Data Analysts
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Support Bundle

If you find an error in the program or have a question, generate a
support bundle from the Help menu and email it to
support@gquest.com

Settings

The user settings for Toad for Data Analysts can be viewed from the
link in the About box. Click the Application Data Directory for settings
or Application Directory for installed files. The About box is accessi-
ble through the HELP menu.

@ About Toad for Data Analysts X

QUEST e
g SOFTWARE' 4& :

Third Party Licensing Information

Links

g f v, quest, com Application Directory.
http: ffsupport, quest.com Application Data Direckary

[v]

SQL Trace

The SQL generated by the application can be viewed from the output
window when SQL Trace is enabled. To enable use the Tools | SQL
Trace | To Output menu option.

Resources



